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Abstract 

Background: Malaria is an infectious disease with a high mortality rate. One of the complications of malaria is 

blood disorders. Hematological disorders such as anemia and thrombocytopenia are common in malaria 

infection. Resveratrol has been reported to have antimalarial activity. Objective: This study aimed to evaluate 

the effect of resveratrol in reducing the severity of anemia and thrombocytopenia in Plasmodum berghei-infected 

mice. Methods: The study began with parasite inoculation in mice. After the mice were infected, and randomly 

grouped into negative control, chloroquine 20 mg/Kg (positive control), and resveratrol with doses 25, 50, and 

100 mg/Kg. The mice's blood profile was measured on day 0 and day 4 using a hematology analyzer. Results: 

The results showed that after administration of resveratrol at various doses, the number of RBC, hemoglobin, 

hematocrit and platelets was higher than the control. Conclusion: It can be concluded that resveratrol can 

reduce the severity of anemia and thrombocytopenia in mice infected with P. berghei. 
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INTRODUCTION 

The prevalence of malaria continues to increase 

every year. Based on the World Health Organization 

report in 2021, there were 274 million malaria cases in 

the world (World Health Organization, 2022). 

Indonesia is one of the endemic malaria areas, 

especially in the eastern part of Indonesia. Malaria is 

an infectious disease caused by Plasmodium sp. The 

Plasmodium life cycle occurs in mosquitoes and 

humans. The human body is divided into two phases: 

the exoerythrocytic (in the liver) and erythrocytic (in 

the red blood cells). Parasite invasion and 

multiplication in red blood cells (RBC) are responsible 

for the onset of symptoms and pathogenesis of malaria. 

In infected red blood cells (iRBC), modifications occur 

on the surface of the erythrocyte membrane so that 

parasite-infected erythrocytes will be easily attached, 

especially to the surrounding uninfected RBC 

(resetting), platelets and endothelial cells 

(cytoadherence) (Wickramasinghe & Abdalla, 2000). 

As a result of rosetting and cytoadherence, blood clots 

occur in the microvascular, which can cause 

multiorgan disorders such as the liver, spleen, kidney, 

and brain (Bhutani et al., 2020). 

Hematological abnormalities such as anemia and 

thrombocytopenia are common in malaria patients. 

During malaria, infected red blood cells lyse and 

release merozoites to complete their life cycle by 

infecting new red blood cells. This cyclical process 

repeatedly occurs, causing a reduction in red blood 

cells and anemia. Infected red blood cells during lysis 

will release Hb derivative products such as hemin, 

methemoglobin (MetHb), and hemozoin which are 

malaria pigments. The release of these products can 

cause oxidative stress, which triggers oxidative damage 

to RBC (Balaji et al., 2020; Rifkind et al., 2015). The 

pathogenesis of thrombocytopenia is associated with 

blood clotting disorders, sequestration and 

cytoadherence in the spleen, destruction of platelets by 

macrophages, and oxidative stress (Wassmer et al., 

2008). 

Malaria infection needs to be treated quickly to 

prevent complications of severe malaria. Malaria 

treatment faces obstacles, including parasites resistant 

to the available antimalarials (Dondorp et al., 2009; Gil 

& Krishna, 2017). The search for new antimalarial 

compounds has been developed both from natural and 

synthetic origins, and medicinal plants are a potential 

source for investigating and developing new 

antimalarials. 

Resveratrol is a flavonoid compound that is found 

in the skin and seeds of grapes, nuts, jackfruit, and 

mulberries. Resveratrol has biological activities such as 

antioxidant, anti-inflammatory, anticancer, 

neuroprotective, anticancer, and antimalarial (Galiniak 

et al., 2019; Moon & Sim, 2008). Based on the results 

of previous studies, resveratrol was reported to have 

antimalarial activity and can reduce the organ index 

liver, spleen, and kidney indices in mice infected with 

P. berghei, which is an indicator of inflammation 

(Hermanto et al., 2022). Resveratrol's activity as an 

antimalarial can inhibit parasite growth, inhibiting 

parasite invasion of red blood cells, which can cause 

hemolysis. Oxidative stress caused by malaria infection 

can trigger tissue damage, including hemolysis (Gomes 

et al., 2022). Resveratrol has antioxidant activity, 

allowing it to suppress free radicals caused by malaria 

infection to prevent hemolysis. Research on the effect 

of resveratrol on the blood profile of malaria-infected 

mice has not yet been studied. This study aimed to 

evaluate the effect of resveratrol in reducing malaria 

complications such as anemia and thrombocytopenia. 

 

MATERIALS AND METHODS 

Materials 

The materials used in this study were resveratrol 

(Chengdu Biopurify Ltd.), chloroquine (Merck), 

anticoagulant (Inviclot®), Giemsa dye (Merck), 

methanol, carboxymethylcellulose (CMC), immersion 

oil. 

Parasites and mice 

The parasite culture used in this research was P. 

berghei ANKA obtained from the Malaria Laboratory, 

Faculty of Pharmacy, Universitas Jenderal Achmad 

Yani. The test animals used in this study were male 

Swiss Webster mice aged 7-8 weeks with a body 

weight of 20-35 g, obtained from PT Biomedical 

Technology Indonesia, Bogor. This research was 

conducted after receiving prior approval from the 

preclinical ethics committee of the Faculty of 

Pharmacy, Universitas Jenderal Achmad Yani, with 

number 8015/KEP-UNJANI/VI/2022. 

Methods 

The effect of resveratrol on the blood profile of 

mice infected with Plasmodium bergei was tested in 

February-November 2023. All mice were grouped into 

six groups: one normal group (uninfected) and five 

groups P. berghei infected-mice. The mouse was 

inoculated intraperitoneally with P. berghei ANKA as 

much as 200 µL, which contained 1x106 parasites. 

After the mice were infected with a parasitemia level of 
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2%, the mice were randomized and divided into several 

groups (n = 5). Control (Na CMC 0.5%), chloroquine 

20 mg/Kg, resveratrol (25, 50, and 100 mg/Kg). 

Chloroquine and resveratrol are suspended in 0.5% 

sodium carboxy cellulose (Na CMC) and given orally. 

The dose approach used is based on previous research 

that can inhibit the growth of Plasmodium (Hermanto 

et al., 2022). Before being given the treatment (D0), all 

mice were examined for their blood profile 

(erythrocytes, hemoglobin, hematocrit, and platelets) 

by taking 200 µL of blood from the tails, measured 

using a hematology analyzer (Melet Schloesing®). The 

treatment was conducted for four days orally, and on 

the last day (D4), a blood test was carried out again. 

 

RESULTS AND DISCUSSION 

Hematological disorders such as anemia and 

thrombocytopenia are complications that often occur in 

malaria patients. This study evaluated resveratrol in 

reducing hematological disorders in P. berghei ANKA-

infected mice with RBC, hemoglobin, hematocrit, and 

platelets. The findings on the number of RBC, 

hemoglobin, hematocrit, and platelets on day 0 in the 

control, chloroquine, and all resveratrol groups 

decreased compared to normal. This is because the 

mice in this group were infected with the parasite. The 

RBC profile of mice infected with P. berghei (Figure 

1) showed that the control group had the lowest 

number of RBCs on day four compared to all the test 

groups. Meanwhile, the chloroquine and resveratrol 

groups had a higher RBC count than the control group. 

In the resveratrol group, the decrease in the number of 

red blood cells was not dose-dependent, especially at 

doses of 50 and 100 mg/Kg. However, the number of 

red blood cells was still higher than the control group, 

which correlated with the parasite density level. 

Previous research showed that resveratrol was reported 

to have antimalarial activity in P. berghei-infected 

mice with an effective dose 50 (ED50) value of 27.25 

mg/Kg (Hasugian et al., 2014), so resveratrol can 

suppress parasites, preventing invasion and 

multiplication of parasites in RBC cause reducing 

hemolysis.  

The pathogenesis of anemia in malaria infection is 

multifactorial, including destroying iRBC, impaired 

RBC production in the bone marrow, and parasite 

phagocytosis in iRBC (Awoke & Arota, 2019). The 

spleen is an organ that plays a role in cleaning red 

blood cells. In malaria infection, changes in blood 

cleaning are carried out by spleen macrophages. iRBC 

cells will express marker compounds such as rhoptry-

associated protein-2 (RSP-2) and phosphatidylserine 

(PS) on the surface of the RBC membrane, which will 

be recognized by lymph macrophages and will then 

cause phagocytosis. Anemia is caused by the 

significant number of infected red blood cells cleansed 

by the spleen, and the burden on the spleen in cleaning 

parasites is more remarkable, which might interfere 

with the spleen organ. This is in line with previous 

research that P. berghei-infected mice that were not 

given treatment showed an increase in the spleen organ 

index, widening of the white pulp and depletion of the 

red pulp, which are indicators of spleen damage, while 

mice treated with resveratrol showed a decrease in the 

spleen organ index and improvement in histology 

spleen (Hasugian et al., 2014; Intan et al., 2017). 

 

 

Figure 1. RBC profile of mice treated with resveratrol. 

The data shown are mean ± SEM. n= 5. *= p < 0.05 for 

the negative control group. #= P<0.05 for the standard 

group 

 

The hemoglobin profile in P. berghei-infected 

mice after being treated with resveratrol can be seen in 

Figure 2. The hemoglobin level of the control group on 

day 4 showed the lowest compared to the entire test 

group. The chloroquine and resveratrol groups had 

higher hemoglobin than the controls. In the 

erythrocytic cycle, the parasite will use hemoglobin as 

a source of nutrition.  

Hemoglobin will be degraded into heme and then 

biomineralized into hemozoin. Compounds resulting 

from the degradation of hemoglobin, such as heme, 

methemoglobin, and hemozoin, are free radicals that 

can cause damage to the RBC membrane and increase 

the occurrence of hemolysis (Balaji & Trivedi, 2012). 

Resveratrol's antioxidant action is suggested to prevent 

hemolysis. 
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Figure 2. The hemoglobin profile of mice treated with 

resveratrol. The data shown are mean ± SEM. n= 5. *= 

p<0.05 for the negative control group. #= P<0.05 for 

the normal group 

 

Hematocrit is the ratio of the number of red blood 

cells to whole blood. In malaria infection, the 

hematocrit will decrease. Changes in the hematocrit 

profile in P. berghei-infected mice are shown in Figure 

3. In the control group, the number of hematocrites on 

day 4 decreased, while in the chloroquine and 

resveratrol groups, it was higher than the control group 

and not significantly different from the normal group. 

The decrease in the number of hematocrit correlated 

with the level of parasite density. In the erythrocytic 

phase, the parasite will multiply, resulting in many 

ruptured RBCs (Akinosoglou et al., 2012). 

Chloroquine and resveratrol have been shown to inhibit 

parasite growth, reducing the decrease in hematocrit. 

The findings in this study showed that resveratrol could 

reduce malaria complications in the form of anemia 

with higher RBC, hemoglobin, and hematocrit profiles 

than the control group. 

 

Figure 3. The hematocrit profile of mice treated with 

resveratrol. The data shown are mean ± SEM. n= 5. *= 

p<0.05 for the negative control group. #= P<0.05 for 

the normal group 

 

A hematological disorder in severe malaria 

infection is thrombocytopenia, which is found to occur 

in around 50-80% of malaria cases. Figure 4 shows the 

blood profile of mice infected with P. berghei after 

resveratrol administration. The control group on day 4 

showed the lowest platelet count compared to all test 

groups. In the chloroquine and resveratrol group, the 

decrease in platelets was not as common as in the 

control group. Decreased platelets are associated with 

an increase in the number of parasites. High levels of 

parasites can trigger an increase in pro-inflammatory 

cytokines such as TNF-α, INF-γ, and IL12. 

 

Figure 4. Platelet profile of mice treated with 

resveratrol. The data shown are mean ± SEM. n= 5. *= 

p<0.05 for the negative control group. #= P<0.05 for 

the normal group 

 

This increase in pro-inflammatory cytokines 

impacts platelets trapped and used for inflammation in 

blood vessels. Besides that, the immune response 

increases macrophage activity to destroy platelets 

which can cause thrombocytopenia (Hasugian et al., 

2015; Lee et al., 1997). Previous studies reported that 

on day 4, mice infected with P. berghei had lower 

parasitemia values than controls (Hermanto et al., 

2022), and these results were consistent with their 

platelet profiles. In addition, resveratrol is also reported 

to have anti-inflammatory activity by suppressing IL-6, 

TNF-α, and INF-γ (Galiniak et al., 2019). The ability 

of resveratrol to suppress parasite growth and suppress 

pro-inflammatory cytokines proves that resveratrol can 

reduce malaria complications in the form of 

thrombocytopenia.  

All blood parameters in mice infected with P. 

berghei after administration of resveratrol showed 

improvements in several factors that can cause this. 

Firstly, resveratrol can inhibit parasite growth, thereby 

preventing parasite invasion of red blood cells, which 

will cause hemolysis. Secondly, the antioxidant activity 

of resveratrol makes it possible to prevent tissue 

damage due to oxidative stress that occurs during the 

infection process. Thirdly, anti-inflammatory from 

resveratrol can prevent an increase in pro-inflammatory 

cytokines, which is one of the factors that worsens 

malaria. This study has limitations in not evaluating the 

effect of resveratrol on antioxidant activity and pro-

inflammatory cytokines in mice infected with 

Plasmodium. So that in the future, it can be used as 

further research regarding the study of the mechanism 

of action of resveratrol in reducing blood disorders due 

to complications of malaria. 
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CONCLUSION 

This study investigated the effect of resveratrol in 

reducing the severity of anemia and thrombocytopenia. 

The results show that resveratrol can reduce the 

severity of anemia and thrombocytopenia by reducing 

parasitemia levels and antioxidant activity and 

suppressing pro-inflammatory cytokines. However, 

further research is still needed. 
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Abstract 

Background: Mercury, a hazardous heavy metal known for its toxicity to the human body, finds application in 

cosmetics due to its capacity to inhibit melanin formation. Traditional mercury analysis relies on resource-

intensive and time-consuming instrumentation. Objective: This study aims to devise cost-effective and practical 

sensors for mercury detection. Methods: The sensor development process involves immobilizing the sensor onto 

paper, reacting it with mercury, scanning the outcome using a scanner, and subsequently quantifying RGB values 

using the ImageJ software. Results: Optimization of reagent concentrations gave a ratio of methylene blue, AgNO3, 

gallic acid, and ascorbic acid at 0.5:7:1.5:1 generating the best results. Additionally, pH optimization within the 

range of 5 to 9 demonstrates stability without necessitating the inclusion of a buffer solution. Notably, the blue 

variant exhibits superior responsiveness during concentration optimization. Characterization of the sensor reveals 

a response time of 3 minutes and minimal interference of 2.145% from other substances. The sensor exhibits a 

linearity range of 0.5-250 ppm, regression equation y = 8.603x + 21.124, an R-value of 0.994, and an exceedingly 

low p-value of 6.9924589548512 x 10-9. The sensor boasts a limit of detection (LOD) of 0.206 and a limit of 

quantification (LOQ) of 0.265, indicative of its precision. Further assessments reveal a percent relative standard 

deviation (% RSD) precision of 2.017% and a recovery rate of 96.14%. Conclusion: The sensor has exhibited 

stability for over one month under room temperature storage conditions. A comparison between the UV-Vis 

spectrophotometer and the sensor signifies no significant difference between the two methods. 
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INTRODUCTION 

Mercury, a chemical element, finds application in 

facial whitening creams owing to its capacity to impede 

the melanin formation process, known as 

melanogenesis. Melanogenesis represents a 

fundamental physiological pathway responsible for the 

generation of melanin, a pigment that absorbs light and 

plays a pivotal role in determining human skin colour 

and hair pigmentation. The melanin synthesis pathway 

is reliant on the enzymatic activity of tyrosinase, an 

enzyme with a copper-dependent mechanism 

responsible for converting tyrosine into melanin. 

Tyrosinase, being a glycoprotein, undergoes an essential 

N-glycosylation process to attain its active enzymatic 

state. Following cleavage by glucosidase, glycosylated 

tyrosinase assumes a properly folded conformation, 

rendering it amenable to active transport facilitated by 

Cu²+ within the Golgi apparatus before reaching 

melanosomes. Notably, inorganic forms of Mercury 

operate as solid inhibitors of melanin production by 

competing with or displacing copper ions, impairing the 

catalytic activity of the tyrosinase enzyme in melanin 

synthesis.Ultimately, this inhibition leads to the 

achievement of a brighter skin complexion (Haryanti et 

al., 2020). 

Mercury can be analyzed using several instruments, 

including Inductively Coupled Plasma Mass 

Spectrometry (ICP-MS), Inductively Coupled Plasma 

Atomic Emission Spectrometry (ICP-AES), Gas 

Chromatography Coupled to Atomic Absorption 

Spectrometry (GC-AAS), Cold Vapor Atomic 

Absorption Spectrometry (CV-AAS), Atomic 

Fluorescence Spectrometry (AFS), and Anodic 

Stripping Voltammetry (ASV) (Kristianingrum, 2009). 

However, analysis with this technique is costly, and the 

process is quite complicated. Therefore, researchers 

have developed colloidal silver-based chemical sensors. 

Colloidal silver is a nanotechnology-based product that 

is currently being developed and can be applied as a 

catalyst and optical sensor detector. The reaction 

mechanism in colloidal silver is that when Hg+ ions are 

added to the solution, an oxidation-reduction reaction 

will occur between Ag0 and Hg+ ions (Kumar et al., 

2017). In manufacturing colloidal silver-based sensors, 

methylene blue is used as a marker to detect the presence 

of mercury, and gallic acid is used as a capping agent so 

that the particles become more stable by preventing 

aggregation. Based on this, this study developed a 

colloidal silver-based chemical sensor that can detect the 

presence of Mercury in cosmetic products quickly, 

simply, and economically. 

MATERIALS AND METHODS 

Materials 

HgNO3 (Loba Chemie), methylene blue (Merck), 

ascorbic acid (Merck), AgNO3, gallic acid (Merck), 

demineralized water (Hydrobatt), methanol (Merck), 

Whatman paper (paint No.1), phosphate buffer solution 

pH 5-9, dithizone (Merck), sodium hydroxide (Merck), 

hydrochloric acid (Merck), whitening cream samples, 

mica.  

Tools 

UV-Vis spectrophotometer (JASCO V-760), 

cuvette, scanner (canon LiDE 300), analytical balance 

(OHAUS), 50, 100, and 250 mL beakers glass (pyrex), 

5, 10, 50, and 100 mL volumetric flasks (pyrex), 50 mL 

measuring glass (pyrex), ultrasonic (Mosinix USA), pH 

meter (OHAUS), drip plate, micropipette 100-1000 l 

and 1000-5000 l (socorex), dropper pipette, volume 

pipette (pyrex), ball filler, stir bar, tweezers, vial, punch 

hole, hairdryer, stopwatch, scissors. 

Method 

Sensor immobilization 

The immobilization technique used is adsorption, 

which is done by soaking the paper in the reagent for 24 

hours. The sensor paper was dried using a hairdryer. The 

dried paper is stored at room temperature (25℃) to 

maintain its stability. Paper that has been immobilized 

and dried is used for sensor optimization, sensor 

characterization, and testing on samples. 

Strip test fabrication 

The mercury detection strip test in cosmetic 

samples consists of two parts, namely the handle and the 

detection area as shown in Figure 1. The handle of the 

strip test is made of non-absorbent mica with a size of 

7.5 cm x 1 cm. The detection area is made of paper glued 

to the bottom of the handle of the strip test. 

 

 

Figure 1. Strip test design 
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Table 1. Mercury detection reagent formula 

 

Reagent 

Volume (mL) pipetted in 10 mL 

F1  F2 F3 F4 F5 F6 F7 F8 

Methylene Blue (3,127 x 10-3 M) - 0.5 - 0.5 - 0.5 - 0.5 

AgNO3 (5,887 x 10-3 M) 5 5 6 6 7 7 8 8 

Ascorbic Acid (0,1 M) 1 1 1 1 1 1 1 1 

Gallic Acid (0,1 M) 4 3.5 3 2.5 2 1.5 1 0.5 

 

Chemical sensor optimization 

Optimization of reagent concentration 

Optimization of reagent concentration was done by 

making reagents with variations of the formulas made in 

Table 1 using immobilization techniques. Each reagent 

that has been made was immersed in paper for 24 hours. 

After that, the immobilized paper was reacted with 250 

ppm Mercury and then measured.  All of the 

experiments were carried out in triplicate. Then, each 

formula was measured for its RGB value, and the 

highest RGB value was observed using the ImageJ 

program. 

Optimization of pH 

Optimization of pH was done by making a 

phosphate buffer solution with a pH of 5, 6, 7, 8, and 9. 

Furthermore, the sensor paper that had been 

immobilized was added with a buffer solution of various 

pH and drops of Mercury with a concentration of 250 

ppm. Then the RGB value was measured, and the 

highest mean RGB value was observed using the ImageJ 

program (Hermanto et al., 2019). All of the experiments 

were carried out in triplicate. 

Optimization of test concentration 

Optimization of test concentration was carried out 

by making mercury concentrations of 0.5, 1, 5, 10, 50, 

100, and 250 ppm. Tests were carried out using sensor 

paper that had been immobilized and then dripped with 

various concentrations of Mercury that had been 

prepared. Then, the colour intensity was measured at 

each concentration using the ImageJ program to 

determine the RGB mean value and look for the most 

linear colour response. Optimal optimization can be 

done by seeing the colour change and giving the most 

linear colour response value; all the experiments were 

carried out in triplicate (Hidayat et al., 2017). 

Chemical sensor characterization 

Response time 

The timing of the sensor was done by measuring the 

time it takes for the reagent to react with Mercury. The 

response time was determined by dipping the test strip 

that had been immobilized. The measurements were 

carried out every minute for 30 minutes using a 

stopwatch and the RGB values were measured from the 

scan results using the ImageJ program and the mean 

RGB values were obtained. The measurement results 

show that the most optimal time was generated from the 

mean RGB; all of the experiments were carried out in 

triplicate (Hermanto et al., 2019). 

Selectivity 

The determination of selectivity was carried out 

using a mercury standard based on the results of 

optimization that had been added with interfering 

components (nipagin, nipasol, and triethanolamine). 

The selectivity was determined by measuring the Δ 

mean RGB value using the ImageJ program. Selectivity 

is good if it has a value of % interference < 5%. 

Linearity 

Determination of linearity was done by dipping the 

test strip into the reagent with a test concentration range 

of 0.5-250 ppm. After that, a linearity curve was made 

between concentration and Δ mean RGB. From this 

curve, the value of the regression equation was obtained. 

Furthermore, the ANOVA data processing was done 

using Microsoft Excel to determine the p-value 

(Hermanto et al., 2019). 

Limit of detection (LOD) dan limit of quantitation 

(LOQ) 

Determination of LOD and LOQ values was done 

by making several mercury standard solutions with 

concentrations below the smallest concentration of the 

linearity test range. Then, the linearity curve between 

concentration and Δ mean RGB was determined 

(Hermanto et al., 2019).  

Precision 

The precision value can be determined by 

calculating the relative standard deviation (RSD) of 6 

measurements made using different test strips. Interday 

testing (repetition on various days) was performed using 

sample solutions of different concentrations; then, the 

colour change was measured using the ImageJ program 

so that the mean RGB value was obtained (Hermanto et 

al., 2019). 

Accuracy 

Determination of accuracy was carried out by the 

standard addition method, namely by calculating the % 

recovery from three times the addition of analyte of 

30%, 45%, and 60% of the sample concentration from 

the test concentration. Next, the cream sample was 
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prepared, and then the test strip was dipped in the 

solution, and the colour change was observed. The Δ 

mean RGB value of the measurement results is then 

entered into the regression equation to obtain the 

mercury concentration in the sample (Hermanto et al., 

2019). 

Stability 

Determination of stability was done by storing the 

sensor at room temperature (25℃). The sensor response 

was measured every day until it reached a 15% decrease 

from the original sensor response (Hermanto et al., 

2019). 

Mercury testing using a UV-Vis spectrophotometer 

 The standard solution was made by weighing 10 

mg of Mercury in a 10 mL volumetric flask and then 

diluting it to various concentrations. Next, a sample 

solution was made by weighing 100 mg of the cream 

sample and dissolving it in 100 mL of demineralized 

water, which resulted in a sample solution with a 

concentration of 1000 ppm. The sample solution was 

diluted to 10 ppm by means of a 100 µL pipette 

dissolved in a 10 mL volumetric flask. After that, it was 

checked using a UV-Vis spectrophotometer in a way 

that each of the standard solution and sample was 

pipetted as much as 100 µL and added with 100 µL of 

10 ppm dithizone solution (Jamaluddin & Reazul, 

2003). 

Sensor application 

Tests using the test strip method were carried out by 

dipping the test strip in each sample that had been 

prepared by weighing 100 mg of cream and dissolving 

it in 100 mL of water. Then 0.1 mL of the solution was 

taken and dissolved in 10 mL of water. After dipping, 

the results of the color change can be compared with the 

color results of the mercury standard. 

 

RESULTS AND DISCUSSION 

Chemical sensor optimization 

The reagent concentration optimization was carried 

out to obtain reagents that could detect Mercury 

optimally. In optimizing the reagent concentration, 

reagents were made with variations of 8 formulas using 

a combination of methylene blue, AgNO3, ascorbic acid, 

and gallic acid. Determination of the reagent 

concentration was carried out on sensor paper that had 

been immobilized for 24 hours, which was then added 

with 250 ppm mercury. The results of the reagent 

concentration optimization experiment can be seen in 

Figure 2. This optimization experiment was conducted 

through three replication attempts. The results of 

reading the RGB values on ImageJ and observing color 

changes directly by the eye, the optimal reagent 

concentration is formula 6, because it has the highest Δ 

mean blue value. 

 

Figure 2. Comparison of reagent concentration to color 

change 

 

The sensor's pH was optimized to know the optimal 

working pH on this sensor. The immobilized sensor 

paper was added with a buffer solution at pH 5, 6, 7, 8, 

and 9, and then reacted with 250 ppm mercury 

concentration. The results of reading RGB values using 

ImageJ and pH optimization data can be seen in Figure 

3, where these results indicate that this sensor was not 

affected by pH because there was no significant change 

in the five pH values, so this sensor did not need 

additional buffer. 

 

Figure 3. Sensor response at various pH to color 

change 

 

The test concentration was optimized to know the 

most linear colour response produced by the sensor. The 

test concentration was optimized by making a serial 

solution of mercury concentration with levels of 0.5 

ppm, 1 ppm, 5 ppm, 10 ppm, 50 ppm, 100 ppm, and 250 

ppm. After that, the sensor paper that had been 

immobilized was reacted with a solution of various 

levels of Mercury. The results of reading RGB values 

using ImageJ as well as optimization test concentration 

data can be seen in Figure 4, where from these results, it 

can be seen that the blue colour response provides the 

most optimal response compared to other colours, with 

an R-value of 0.9923 so that the value of mean blue is 

used as a characterization reading and sensor testing. 
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Figure 4. Response of color reading to test concentration 

 

Figure 6. Sensor response time to color change (Δ mean blue) 

 

 

Figure 5. Reaction schematic of mercury with 

methylene blue, AgNO3, gallic acid, and ascorbic acid 

 

Sensing mechanism 

In developing a colloidal silver-based mercury 

sensor, a reaction occurs between gallic acid and 

ascorbic acid with AgNO3, which will then reduce 

methylene blue. The reduction of methylene blue is 

influenced by colloidal silver, which is formed as a 

result of the reduction of AgNO3. In the electron transfer 

process, when there is a significant difference in redox 

potential between the acceptor and the donor, then there 

is a possibility of restriction in the electron transfer 

(Clayden & Greeves, 2012). However, electron transfer 

will proceed easily if the effective catalyst has an 

intermediate redox potential between the acceptor and 

donor. In this case, colloidal silver acts as a mediator of 

electron transfer and contributes to methylene blue by 

acting as a redox catalyst. Gallic acid and ascorbic acid 

reduce Ag+ from AgNO3 to Ag0, where colloidal silver 

acts as an electron transfer mediator and donates to 

methylene blue as a redox catalyst, also reducing 

methylene blue to leucomethylene blue (Mona et al., 

2018). This colourless leucomethylene blue, when it 

reacts with Hg+, an oxidation process will occur, which 

releases electrons, and methylene blue will capture 

electrons, thus making the blue colour of methylene blue 

reform, as shown in Figure 5. 

Chemical sensor characterization 

Response time testing was carried out to measure 

the time required for Mercury by optimizing the 

concentration to react with the reagents in the sensor to 

give the most optimal color response results. This 

measurement is carried out every minute for 30 minutes 

where the sensor reacts with a standard Mercury 

solution with a concentration of 250 ppm. The results of 

the response time testing can be seen in Figure 6, where 

the most optimal sensor response time is obtained, 

which is in the 3rd minute. 
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Figure 8. (a)  Linearity test results in logarithmic equations; (b) linearity test results in linear equations 

 

The selectivity test was carried out to determine the 

confounding component's effect. The nuisance 

components used in this test are usually found in 

cosmetics, such as methyl paraben, propylparaben, and 

triethanolamine (TEA). The preparation was done by 

mixing Mercury with the interfering component, in 

which 1:1, 1:10, and 1:100 ratios were used. The results 

of the selectivity test obtained from the presence of 3 

interfering components can be seen in Table 2 and 

Figure 7. The % interference value is 2.145%, where this 

result is by the requirements of the selectivity test, which 

is <5%, so it can be said that the method used is not 

affected by the presence of a nuisance component 

(Nethercote & Ermer, 2012). 

 

Table 2. Results of comparison of interference values 

Comparison Nipagin Nipasol TEA 

1 : 1 3,639 0,706 4,193 

1 : 10 2,899 1,087 3,176 

1 : 100 1,200 1,384 1,017 

 

 

Figure 7. Results % interference selectivity test 

 

 

The linearity test was carried out to determine the 

relationship between the detector response and changes 

in concentration. The concentration in the linearity test 

ranges from 0.5-250 ppm with 10 test points. Tested 

using the scanometry method, then measured RGB 

values in the ImageJ program. From these results, the 

regression equation y = 3.7362ln(x) + 21,124 is obtained 

for the logarithmic curve, as shown in Figure 8(a). The 

regression equation formed becomes y = 8.603x + 

21,124, and the R-value is 0.994, as shown in Figure 

8(b). After that, the ANOVA test was carried out, which 

obtained a p-value of 6.9924589548512 x 10-9. The 

results of the linearity test can be seen in Appendix F, 

where these results have met the requirements of good 

linearity, namely the correlation coefficient (r) 0.999, 

and the p-value of the ANOVA test is less than = 

0.01(Nethercote & Ermer, 2012). 

LOD is determined to know the smallest amount of 

analyte or sample in the sample that still gives a 

significant response to the sensor method. In contrast, 

the determination of LOQ aims to determine the most 

minor level or the smallest concentration of Mercury 

that can still be quantified for precision and accuracy 

determination. The results obtained from the 

determination of  LOD and LOQ values were 0.206 ppm 

and 0.625 ppm, respectively. 

The precision test was carried out to know the 

closeness of a series of measurements obtained from the 

sample. Test precision was determined by calculating 

the relative standard deviation (RSD). This test was 

carried out on 3 consecutive days using the same 

concentration (interday), each with six replications. % 

RSD resulting from the average precision test was 

2.017%, so it can be concluded that this test has met the 
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requirement since the % RSD was less than 7.3 for a 

concentration of 10 ppm sample (Huber, 2007). 

The accuracy test is carried out to determine the 

measurement method's accuracy. The accuracy test was 

carried out using the standard addition method with 

three replications. The value of % recovery obtained 

from the average accuracy test is 96.14%, so it can be 

said that this test meets the requirements % recovery is 

in the range of 80-110% for a concentration of 10 ppm 

sample (Huber, 2007). 

The stability test was carried out to know the time 

at which the sensor gave the same and stable reaction to 

an analyte at the same concentration until the response 

time of the sensor to the analyte decreased drastically 

(usually more than 15% of the initial sensor response) 

(Kuswandi, 2008). The stability test results, which 

lasted for one month, showed a % decrease in the range 

of 0.005-0.061, indicating that the sensor is stable 

because it shows the % decrease, which is still far from 

15%. 

Comparison of mercury testing using a UV-vis 

spectrophotometer and sensor 

A comparison of mercury testing using the UV-Vis 

spectrophotometer and the sensor methods was carried 

out to know if there were significant differences 

between the two methods. The results of testing the two 

methods were analyzed using a T-test Two-Sample 

Assuming Unequal Variances in Microsoft Excel. If the 

value of < 0.05, then H0 is rejected, meaning there is a 

significant effect between one independent variable and 

the dependent variable. Meanwhile, if the value is> 0.05, 

then H0 is accepted, meaning there is no significant 

effect between one independent variable and the 

dependent variable (Miller & Miller, 2010). The results 

obtained from the five samples can be seen in Table 3. 

The results of the p-value between the two methods are 

more than = 0.05, indicating no significant difference 

between the UV-Vis spectrophotometer method and the 

sensor method, so this sensor can be used to detect the 

presence of Mercury. 

Sensor application 

The sensor was applied to the sample directly to 

determine the sensor's direct response in detecting the 

presence or absence of mercury in the sample. The 

results of the application of the sensor on the sample can 

be seen in Figure 9, where from these results, it can be 

seen that the sensor has been optimum in detecting the 

presence of Mercury due to a change in colour according 

to the mercury standard. 

 

Table 3. Comparative test results of uv-vis 

spectrophotometer with sensor 

Sample UV-Vis 

Spectrophotometer 

(ppm) 

Sensor 

(ppm) 

P (T<=t) 

two tail 

1 

 

15,476 15,066 0,692 

 

 

15,830 15,596 

15,013 14,689 

2 

 

13,419 13,092 0,787 

 13,275 13,002 

13,166 13,677 

3 

 

12,507 12,618 0,940 

 12,450 12,560 

14,052 13,772 

4 

 

13,664 12,882 0,112 

 13,886 13,243 

13,865 12,972 

5 15,598 15,453 0,463 

 

 

15,821 15,101 

15,895 15,812 

 

 

 

Figure 9. (a) Sensor before reacting; (b) sensor after 

being reacted with the sample 

 

CONCLUSION 

The optimal condition of the sensor is formula 6 

with a ratio of methylene blue: AgNO3 : gallic acid: 

ascorbic acid =  0.5 : 7 : 1.5 : 1. The addition of buffer 

in this sensor is not required, and blue is the most 

optimum colour in generating sensor responses based on 

test concentrations. The sensor has a response time 

characterization in the 3rd minute, linear in the range of 

0.5-250 ppm, LOD of 0.206 ppm and LOQ of 0.265 

ppm. This sensor provides selective, precise, and 

accurate results. The sensor is stable for more than one 

month on storage at room temperature (25℃). The 

sensor includes measurement results that are not 

statistically significant when compared to the UV-Vis 

spectrophotometer method. 
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Abstract 

Background: Saga leaves are one of the plants that have analgesic activity. Saga leaves contain phenol 

compounds, flavonoids, tannins, alkaloids, and saponins. Phenol has instability with oxygen, light, and high 

temperatures. Therefore, the microencapsulation process is necessary. Microcapsule characterization in this study 

included encapsulation efficiency, particle size, distribution value and morphology. Objective: This research was 

to determine the characterization of microcapsules and the analgesic activity of saga leaf extract microcapsules 

in male mice. Methods: The microencapsulation process conducted in this study was carried out using the spray 

drying method. Saga leaf extract was coated with the coating material in the ratio of 1:20. Several ratios of 

maltodextrin (MD) and soy protein isolate (SPI) (100%:0%); (75%%:25); (50%:50%); (25%:75%) were applied 

as the coating material. The encapsulation efficiency was determined by comparing the total phenol content of the 

extract and microcapsule. Particle size and distribution values were tested using a particle size analyzer. 

Microcapsule morphology was seen using scanning electron microscopy. Analgesic activity test using the tail-flick 

method with mice as test animals. Data analysis in this study used one-way ANOVA. Results: The encapsulation 

efficiency obtained was 31.40-80.29%. The particle size obtained in the microcosm was 17.70-30.90 µm. The 

distribution value obtained was 1.42-2.45. The morphology of the microcapsule obtained was round and had 

wrinkles. The analgesic activity obtained in this study resulted in significantly different pain inhibition values 

before and after microencapsulation. Conclusion: The characteristics of microcapsule preparations are well-

known, and the analgesic activity of various microcapsules was 42.43-57.15%. 
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INTRODUCTION 

The saga plant grows wild in the forest or the yard 

of the house. Saga leaves have a sweet and bitter taste at 

the end when consumed. The bitter taste elicited from 

saga leaves is due to the presence of abrine (Agustina et 

al., 2020). The content found in saga leaves, according 

to Nisak et al. (2021) are flavonoids, tannins, saponins, 

alkaloids and phenols. These phenolic compounds are 

unstable to oxygen, light or high temperatures, so their 

use will be a problem (Yang et al., 2016). Analgesic 

activity in research conducted by Indawati et al. (2020) 

with a dose of 110 mg/20 g BW of mice had a strength 

of 60.81% but was weaker than acetosal. 

In recent years, drug development has been carried 

out in pharmaceutical preparations and technology for 

the manufacture of herbal-based drugs, one of which is 

microencapsulation. Saga leaves are herbal medicines 

that will be developed in microcapsule preparations 

because they have a bitter taste and retain the phenolic 

compounds contained therein (Agustina et al., 2020) 

(Yang et al., 2016). Siregar and Kristanti (2019) stated 

that microcapsules with a core and coating material ratio 

of 1:20 managed to coat the core material well compared 

to a 1:10 ratio. The content of total phenolic compounds 

from microcapsules resulted from a ratio of 1:20, which 

is greater than that of 1:10.  

Maltodextrin is the most commonly used coating 

material in the microencapsulation process. 

Maltodextrin is obtained from hydrolysis of corn starch 

acid has a degree of dextrose equivalence between 10 to 

20. Maltodextrin is also biodegradable and 

biocompatible, increases oxidation and stability, and 

prevents degradation (Wati et al., 2020). In the world of 

food, soybeans are often used in intermediate products, 

namely protein isolates. Soy protein isolate coatings 

were used because the protein was a coating material 

that was capable of carrying active compounds and 

drugs so that it can optimize delivery on target 

(Dewandari et al., 2013). 

Preparation characterization is essential for 

microencapsulation to determine the quality of the 

preparation. Characterization of the microencapsulation 

includes particle size, distribution value (span), 

encapsulation efficiency of phenolic compounds and 

morphology. The particle size in microcapsules has a 

size range of 1-1000 µm. Encapsulation efficiency is a 

comparison between the total contents and the surface 

of the microcapsule. The distribution value (Span) is a 

measure of the width of the particle distribution to the 

microcapsules and aims to determine whether the 

particle distribution is uniform or not. 

  Nevertheless, scientific evidence regarding the 

microencapsulation of saga leaf extract has never been 

carried out. The results of this study will be able to 

provide information about the microencapsulation of 

saga leaf extract in relation to the analgesic activity of 

the ethanol extract of saga leaves. The aims of the study 

were to determine the characterization of microcapsules 

of ethanol extract of saga leaves from a combination of 

maltodextrin and soy protein isolate coatings using the 

spray drying method based on the test parameters of 

particle size, distribution value, encapsulation efficiency 

of phenolic compounds, morphology and to determine 

the analgesic activity in male mice. 

 

MATERIALS AND METHODS 

Materials 

The materials to be used in this study were saga leaf 

Simplicia obtained at B2P2TOOT Tawangmangu, 

maltodextrin DE 10-12 (Chemipan Co., LTD), soy 

protein isolate (SPI), 70% ethanol (Merck), folin-

ciocalteu, ibu profen, Na CMC, sodium acetate (Merck), 

distilled water, concentrated HCl, methanol (Merck), 

magnesium, mayer, wagner, dragendorf, FeCl3 (Merck), 

Na2CO3 (Merck), AlCl3, NaOH. 

Tools 

The tools used in this study were glassware (Pyrex), 

analytical balance (OHAUS Paj 1003), test tubes, rotary 

evaporator (BUCHI Rotavapor R-205, Germany), spray 

dryer (BUCHI B-290, BUCHI Labortechnik AG, 

Switzerland), PSA (Mastersizer 3000), SEM (FEI 

Quanta FEG 200 HR-SEM), UV-Vis Spectophotometry 

(Shimadzu UV-1800), vortex, stopwatch, oral3 syringe 

and tail flick analgesic meter. 

Method 

Extraction of Saga Leaf 

Saga leaves that had been dried in the sun for three 

days (dry) were then crushed using a blender. Then, it 

was filtered using a 40 mesh sieve until powder was 

obtained. Saga leaf powder was macerated using 70% 

ethanol with a ratio of sample and solvent of 1:10 g/v for 

6 hours with occasional stirring. The sample was 

allowed to stand for 18 hours, and then the filtrate was 

filtered. The remaining saga leaf pulp was remacerated 

using half the amount of the first solvent. The sample 

was again filtered using filter paper and evaporatedat a 

temperature of 40-50oC (Indonesian Herbal 

Pharmacopeia, 2017).  

Determination of water content 

Weigh the sample as much as 10 grams and then put 

it into a dry flask. 100 mL of water-saturated Toluen was 

put into the flask, and the tool. Boil using low heat until 
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no water drips; drain the water during the process. ed. 

The results of the water content obtained were recorded 

by looking at the volume on the scale of the tool. 

Moisture content is calculated in %b/v (Indonesian 

Herbal Pharmacopeia, 2017). 

Determination of drying shrinkage 

The determination of drying shrinkage was used 

using a moisture balance tool. We weighed a sample of 

saga leaf simplisia as much as 2 grams above the tool, 

then closed and waited until the % drying shrinkage 

appeared, which was marked by an alarm sound. 

Phytochemical screening 

Flavonoids 

Take 0.1 g of concentrated extract of saga leaves 

into 2-3 mL of ethanol solution, heated, and enough 

magnesium powder and 2 mL of concentrated HCl were 

added. Colour changes to red, yellow, or orange indicate 

the presence of flavonoids (Hanani, 2021). 

Alkaloid 

Identification of alkaloids was carried out by adding 

mayer, dragendorff and wagner reagents.  About 0.5 g 

of concentrated extract was added into 2 mL of 

concentrated HCl, then filtered. The filtrate obtained 

was divided into three parts then added mayer, 

dragendorff and wagner reagents (Hanani, 2021). 

Tannins 

A concentrated extract of 0.1 g was dissolved in 5 

mL of hot water plus 2-3 drops of 5% FeCl solution. The 

presence of tannin content was indicated by a change in 

colour to blue or blackish green (Hanani, 2021). 

Saponin 

A total of 0.5 g of extract dissolved with 70% 

ethanol was added to 10 mL of warm water, and then 

shaken for 1 minute. Added HCl 2N as much as 2-3 

drops. Observed the foam formed for 30 seconds 

(Hanani, 2021). 

Phenol 

Take 0.5 mL of the test solution with a 

concentration of 11 mg/mL and 0.5 mL of a gallic acid 

reference solution with a concentration of 150 µg/mL in 

a test tube, then add 2.5 mL of folin ciocalteu reagent. 

Dilute with distilled water at a ratio of 1/10 v/v in a test 

tube. Let stand for 10 minutes, add 7.5 mL of 1M sodium 

carbonate solution, and observe the colour of the 

solution with the naked eye (Rollando & Monica, 2018). 

Encapsulation of saga leaf extract 

Preparation of microcapsules using the ratio of core 

material: coating material, which is 1:20. Weighed 1 

gram of extract and put it into a glass beaker. 

Maltodextrin, and soy protein isolate were added 

according to the formula weighing, and  79 mL of 

aquabidest  was added, stirred until homogeneous with 

a magnetic stirrer at 700 rpm for 15 minutes. Put the 

preparation into a bottle and label it according to the 

formula. After that, the suspension was sprayed using a 

spray dryer with the temperature according to the 

formula for 1 hour. The microcapsule preparation was 

stored at room temperature for seven days. 

Total phenolic analysis 

The total phenolic content was analyzed with some 

modifications of the method listed in the Indonesian 

Herbal Pharmacopoeia (IHP) (Indonesian Herbal 

Pharmacopoeia, 2017). Make a 400 ppm gallic acid 

standard curve solution and then dilute it with a 

concentration series of 60, 50, 40, 30 and 20 ppm.  

Samples of 0.01 g extract and 0.21 g microcapsules were 

dissolved in 10 mL methanol p.a, homogenized with a 

vortex for 30 minutes and then filtered. Then 1 mL of 

sample was added with 5 mL of 7.5% folin ciocalteu and 

4 mL of 1% sodium hydroxide. The solution was 

homogenized and incubated for 40-51 minutes in a dark 

room. Measurement of total phenolic absorption using a 

wavelength of 764 nm in UV-Vis spectrophotometry.  

Total flavonoid analysis 

The total flavonoid content was analyzed with some 

modifications of the methods listed in the IHP 

(Indonesian Herbal Pharmacopoeia, 2017).  A 400 ppm 

quercetin standard curve solution was prepared and then 

diluted with a concentration series of 60, 50, 40, and 30 

ppm. Samples of 0.02 g extract and 0.42 g 

microcapsules were dissolved in 10 mL ethanol p.a, 

homogenized with a vortex for 30 minutes, and then 

filtered. A sample of 0.5 mL was added to 1.5 mL 

ethanol p.a, 0.1 mL 10% aluminium chloride, 0.1 mL 1 

M sodium acetate and 2.8 mL distilled water. The 

solution was homogenized and incubated for 16-32 

minutes. Total flavonoid absorbance was measured 

using a wavelength of 441 nm in UV-Vis 

spectrophotometry.   

Microencapsulation characterization 

Encapsulation efficiency 

Determination of encapsulation efficiency (%) was 

done according to Isailovic (2012). The encapsulation 

efficiency was calculated by comparing the total phenol 

content in the microcapsules with the extract. 

Encapsulation efficiency

=
total phenolic microcapsule

total phenolic extract
𝑥 100 % 
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Table 1. Saga leaf extract microcapsule preparation formula 

Formula Extract (g) Maltodextrin (g) Soy Protein Isolate (g) Aquabidest (mL) Inlet Temperature (oC) 

F1 1 20 0 79 115 

F2 1 5 15 79 115 

F3 1 10 10 79 120 

F4 1 15 5 79 125 

F5 1 0 20 79 125 

 

Particle size and distribution values 

The particle size of the microcapsules was analyzed 

using a particle size analyzer (PSA) master-sizer 3000 

laser diffraction (Malvern Instrument) carried out by 

dispersing the microcapsules with distilled water as 

much as 10 mL homogenized using a vortex mixer after 

homogeneous the sample was inserted into the cuvette 

in the tool until the appropriate intensity is reached and 

observed the analysis results (Siregar & Kristanti, 2019). 

Determination of the distribution value is obtained using 

the following formula: 

 

Span value =
D(90) − D(10)

D(50)
 

Description:  

D(90) = Particle diameter at 90% 

D(10) = Particle diameter at 10% 

D(50) = Particle diameter at 50% 

 

Morphology 

Morphological analysis of microcapsules was 

determined according to Dewandri et al. (2013). The 

microcapsules obtained were analyzed for morphology 

using Scanning Electron Microscopy (SEM) Samples 

were placed in a sample holder and then coated with 

gold particles using a fine coater. Samples were 

analyzed and viewed morphologically at 1000x intensity 

and magnification. 

Analgesic activity test 

The test animals used were male mice aged 6-8 

weeks, weighing 18-25 g. A total of 40 mice were 

randomly divided into eight treatment groups (each 

group of 5 mice). Group I mice (negative control) were 

treated with 1% CMC Na suspension orally. Group II 

mice (positive control) were given a suspension of 0.54 

mg/20 g BW of ibu profen. Group III was treated with 

saga leaf extract 8 mg/20 g BW. Group IV, V, VI, VII, 

and VIII mice were each treated with saga leaf extract 

microcapsules 160 mg/20 g BW. 

The analgesic test method used in this study was tail 

flick. The tail flicks analgesic meter will induce pain by 

irradiating the mice's tails with infrared at a wavelength 

of 70 foci.  The nociceptive pain response was measured 

at 30, 60, 90 and 120 minutes. 

Data analysis 

The data obtained were analyzed in two ways: 

ANOVA analysis test and LSD analysis. ANOVA 

analysis is expressed as mean ± SD, where the test 

results are significant if p ≤ 0.05. LSD further analysis 

was conducted with a 95% confidence level. 

 

RESULTS AND DISCUSSION 

Characteristics of saga leaf extract 

In this study, saga leaf simplisia had a moisture 

content of 7.33% and a drying shrinkage of 11.67%. The 

water content of the simplisia is said to meet the 

requirements, but the drying shrinkage does not meet the 

criteria because it is more than 10%. This is likely to 

cause enzymatic processes and damage caused by 

microbes. The drying shrinkage of simplisia is more 

significant than the water content because the residual 

substances that evaporate during the shrinkage process 

are not only water but several compounds that can 

disappear at a temperature of 105oC. The research 

results of saga leaf extract are presented in Table 2. 

 

Table 2. Characteristics of saga leaf extract 

Characteristics Value 

Yield (%) 35.79 

Water content (%) 3.33 ± 0.47 

Total phenol (%) 6.70 ± 0.01 

Total flavonoids (%) 3.66 ± 0.00 

Note: average value based on three replications 

 

The yield of ethanol extract of saga leaf obtained 

was 35.79%. The yield in this study is greater than the 

research by Nisak et al. (2021), which obtained a value 

of 31.4%. This is because this study used 70% ethanol 

solvent, which is more polar than 96% ethanol. So that, 

the yield ethanol extract of saga leaf obtained will be and 

more significant because the polar secondary metabolic 

will be more extracted. According to Situmeang (2019), 

the yield of saga leaf extract obtained was 10%. This 

happens because it uses a solvent with a low level of 

polarity so that it cannot attract polar compounds. The 

water content obtained in this study was 3.33% ± 0.470. 

This is in accordance with the requirements in FHI 

(Indonesian Herbal Pharmacopoeia) that the moisture 
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content of a good extract should not be more than 10%. 

The moisture content of saga leaf extract in research by 

Nisak et al. (2021) obtained a % moisture content of 

2.83%. 

Phytochemical screening 

Phytochemical screening was carried out to 

determine the secondary metabolite compounds 

contained in the sample. Several kinds of secondary 

metabolites were tested, namely flavonoids, alkaloids, 

tannins, phenols, and saponins. These results have 

similarities with the results obtained in a study by Nisak 

et al. (2021). The results of the phytochemical screening 

of saga leaf extract are presented in Table 3. The table 

shows that all tests carried out are positive. 

Total phenol and flavonoid content in extracts  

Determination of phenolic content was carried out 

with folin-ciocalteu reagent, which will oxidize the 

hydroxyl group of phenol group compounds to produce 

complex compounds marked by the colour of the yellow 

solution turning blue-green. The process runs slowly in 

an acidic atmosphere, so in the test, sodium hydroxide is 

added, which is alkaline, so as to make the reaction 

faster. The standard solution used was gallic acid, which 

was one of the stable phenolics and was classified as a 

simple phenol group capable of high reactivity to folin-

ciocalteu. The maximum wavelength was obtained at 

764 nm, and the operating time was 40-51 minutes. The 

correlation coefficient value obtained was 0.9977, and 

the linear regression equation for gallic acid absorbance 

obtained y = 0.010x + 0.1143, which was used to 

determine the total phenolic content in extracts and 

microcapsules of saga leaf extract.  

Flavonoids are natural phenol class compounds that 

are distributed in various plants. The determination of 

total flavonoids in extracts and microcapsules of saga 

leaf extract used UV-Vis spectrophotometry with a 

maximum wavelength of 441 nm and an operating time 

of 16-32 minutes. The reagent used in the determination 

of total flavonoids was aluminium chloride, which was 

often referred to as the colourimetric method. This 

method is a very simple method for testing flavonoids of 

essential flavone and flavonol groups so that they react 

with Al (III) to turn the sample into a yellow color. The 

linear regression equation obtained is y = 0.0098 and R² 

value = 0.9954. Table 2 states that the phenol and 

flavonoid content in saga leaf extract is 6.70% and 

3.66%, respectively.  

The high phenol content can be caused by several 

factors, one of which is the use of solvents during the 

extraction process. The solvent used in the extraction is 

ethanol, which has polar properties that can attract polar 

compounds such as phenols, flavonoids, tannins, 

steroids, and alkaloids (Dia et al., 2015). Aside from the 

use of proper solvents, the mature saga leaf sample is 

what causes the high amounts of a sample. As a result, 

the content of secondary metabolites is larger in the 

older ones.  Anwar et al. (2017) discovered that older 

leaves had greater phenolic levels when comparing 

phenolic levels based on leaf age in Aquilaria beccariana 

plants. 

Characterization of saga leaf extract microcapsules 

Total phenol and flavonoid content in microcapsules 

From Table 4, the results of the total phenolic 

content in the extract and microcapsule preparations 

produced higher levels. This could occur due to the 

influence of the temperature used during the 

microencapsulation process using spray drying. In line 

with research by Kistriyani et al. (2020), the total 

phenolic content in microcapsules decreased after 

encapsulation, where the phenolic content in the extract 

was 0.34 g/mL, while in microcapsules, the complete 

phenolic content was 0.09 g/mL. In microcapsules, F1 is 

lower than F2; this is because soy protein isolate has a 

high viscosity, so it allows the homogenization process 

between the extract and the dressing to be uneven. So, 

the sample content taken has a trim level. The 

combination of maltodextrin is essential to homogenize 

the preparation because it has a lower viscosity so the 

highest level is obtained in F2.

Table 3. Phytochemical screening results of saga leaf extract 

Phytochemical Test Reagent Results 

Flavonoid Magnesium dan HCl Concentrated Yellow (+) 

Alkaloid 

 

 

a. Mayer 

b. Wagner 

c. Dragendroff 

 

a. Beige precipitate (+) 

b. Brown precipitate (+) 

c. Orange precipitate (+) 

Tanin  FeCl3 Blackish Green (+) 

Phenol  Folin-ciocalteu dan Na2CO3 Purple-black (+) 

Saponin HCl 2N Foam stabil (+) 
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Table 4. Characterization of saga leaf extract microcapsules 

 

The microcapsule F3 formula obtained a viscosity 

that was not too high, but in this preparation, a 

temperature of 120oC was used to produce a preparation 

that was dry enough. As for microcapsules F4 and F5 

using a temperature of 125oC, this is because the nature 

of maltodextrin has high hygroscopicity, causing the 

ability to bind saga leaf extract to decrease and requires 

a high temperature during the spray drying process to 

produce a preparation that is dry enough. The influence 

of higher temperatures will affect the degradation of 

polyphenols and the release of phenolic components 

such as hydroxyl groups, resulting in a decrease in 

phenolic levels. Phenolic compounds are thermolabile 

and oxidative compounds, so they can influence the in 

the reduction of phenolic levels at high temperatures. 

The temperature in the encapsulation process can 

hydrolyze polyphenolic compounds into simpler 

phenolic compounds (Mahardani and Yuanita, 2021). 

The flavonoid content produced in microcapsules of 

saga leaf extract is 3.20% ± 0.01 - 1.53% ± 0.00. The 

levels obtained are lower than the flavonoid levels in the 

extract. This is in line with the results obtained in the 

measurement of phenolic compounds. Flavonoids 

degrade when the temperature is above 90oC. 

Flavonoids are heat sensitive due to their hydroxyl and 

ketone groups, as well as unsaturated double bonds 

(Qiao et al., 2014). The concentration of phenol and 

flavonoid totals in the F2 formula has the highest level; 

this is in line with research by Sadiah et al. (2022) that 

treatment with a high concentration of soy protein 

isolate produced higher flavonoid levels than the 

treatment with a high concentration of maltodextrin. Soy 

protein isolate has good protection against oxidation. 

However, the use of maltodextrin combined with soy 

protein isolate aims to produce an amorphous glass 

matrix that acts as a barrier to the oxidation process 

during the encapsulation process (Sadiah et al., 2022). 

Total flavonoids of 3.20% and total phenols of 5.38% in 

the F2 formula were the highest values in this study. 

Encapsulation efficiency of total phenol 

The encapsulation efficiency of total phenol was a 

determination that aims to determine how many active 

compounds are trapped in the encapsulation process and 

determine the success rate of the encapsulation process. 

The results of the encapsulation efficiency are in Table 

4. From the analysis, it was found that each group of 

microcapsules had significant differences in 

encapsulation efficiency. The most excellent 

encapsulation efficiency in this study was obtained in 

the F2 microcapsule formula and the most negligible 

efficiency in the F5 formula. Several factors influence 

encapsulation efficiency. Specifically, the coating 

material utilized, as well as the ratio of active ingredient 

and coating material temperature during encapsulation, 

as well as the viscosity drying rate and surface cracks.  

The combination of maltodextrin coating material and 

soy protein isolate was effectively used in research 

conducted by Sadiah et al. (2022) with the encapsulation 

method using a spray dryer. The ratio of the active 

compound and the coating material in this study used a 

ratio of 1:20, which is in line with research conducted 

by Siregar and Kristanti (2019), which states that with 

this ratio, the results obtained are better microcapsule 

characteristics, including encapsulation efficiency and 

total phenol than used comparison with the ratio of the 

active compound and the dressing material 1:10. 

Particle size and distribution value 

The results of the data analysis obtained said that 

there were significant differences in particle size and 

distribution value of each group of microcapsule 

formula. It can be concluded that each combination 

concentration can affect the results of particle size and 

distribution value. The results of the particle size and 

distribution value are in Table 4. The results of the 

particle size obtained: the greater the concentration of 

soy protein isolate the greater the particle size produced. 

This is because the viscosity of the suspension is higher 

than the concentration of soy protein isolate. This is due 

to the higher viscosity of the suspension compared to the 

maltodextrin treatment with more concentration. The 

higher the viscosity, the larger the droplets formed 

during the encapsulation process and the larger the 

particle size. In line with research by Metaviani et al. 

(2013), the particle size obtained gets more extensive if 

the concentration of maltodextrin gets smaller. The 

particle size values obtained in this study ranged from 

Sample 
Total phenol 

(%) 

Total flavonoids 

(%) 

Encapsulation efficiency 

of total phenol (%) 

Particle size 

(µm) 

Distribution 

value 

F1 5.15 ± 0.01 3.20 ± 0.03 76.89 ± 0.26 30.17 ± 0.57 2.36±0.08 

F2 5.38 ± 0.00 3.20 ± 0.01 80.29 ± 0.27 25.23 ± 0.57 1.63±0.02 

F3 4.83 ± 0.02 2.22 ± 0.00 72.16 ± 0.33 23.60 ± 0.37 1.77±0.03 

F4 2.80 ± 0.01 1.70 ± 0.00 41.75 ± 0.14 17.87 ± 0.04 1.42±0.01 

F5 2.10 ± 0.01 1.53 ± 0.00 31.40 ± 0.12 - - 
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17-30 µm. This is in line with what was stated by 

Hidayah (2016) that the particle size produced using a 

spray dryer is in the range of 10-400 µm. 

The distribution value is set to determine the 

distribution of particle sizes produced during the 

encapsulation process. The distribution value is 

obtained from the particle size value at 90% minus the 

particle size value at 10% divided by the particle size 

value at 50%. This happens because there are 

differences in the concentration of the coating material 

or perhaps when the formula loading process is not 

evenly distributed, resulting in a very high distribution 

value. The distribution value of microcapsules with 

concentration F4 was found to be the best value. This 

value indicates that the presence of maltodextrin plays a 

role in the uniformity of particle distribution. This is 

because, theoretically, the smaller the distribution value. 

The better the uniform particle size distribution 

(Krishnaiah et al., 2012). Because the preparation was 

water soluble, the distribution value for microcapsule F5 

could not be read. 

Morphology test 

From the results obtained, it can be seen that the 

shape of the microcapsules is round. There are clumps 

that are not uniform and irregular. This is in line with 

research conducted by Krishnaiah et al. (2012), most 

particles have a round shape and show little 

agglomeration. There are differences in the morphology 

of F1 and F2 microcapsules with other formulas. The 

results of F1 microcapsules have a larger size and are 

more heterogeneous. In the morphology of 

microcapsules with F1 concentration, it can be seen that 

smaller particles are attracted to and attached to larger 

particles around them. This happens because of the 

heterogeneity, which makes the force of attraction and 

clumping between the particles stronger (Sari, 2021). 

From Figure 1, the results obtained show that the 

shape of the microcapsules is round, and some clumps 

are not uniform and irregular. This is in line with 

research conducted by Krishnaiah et al. (2012), most 

particles have a round shape and show little 

agglomeration. There are differences in the morphology 

of F1 and F2 microcapsules with other formulas. The 

results of F1 microcapsules have a larger size and are 

more heterogeneous. In the morphology of 

microcapsules with F1 concentration, it can be seen that 

smaller particles are attracted to and attached to larger 

particles around them. This happens because of the 

heterogeneity of the particles, which makes the force of 

attraction and clumping between the particles stronger 

(Sari, 2021). 

The suspension between the active compound and 

the coating in this study used aquabidest so that the 

interaction between maltodextrin and aquabidest causes 

the hydroxyl groups contained therein to dissolve 

(Yuliawaty & Susanto, 2015). DE describes 

Maltodextrin (dextrose Eqipvalent), where the higher 

the DE value, the higher the water solubility, so this is 

related to the microcapsule morphology. The 

maltodextrin used in this study has a DE value of 10-11, 

which is high, so preparations with high maltodextrin 

concentrations will cause the preparation to be 

hygroscopic. From this, it is important to combine with 

soy protein isolate to produce preparations with good 

morphology.   

 

 

Figure 1. Surface morphology of saga leaf extract microcapsules of all groups with SEM 
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Analgesic activity test 

The tail flick method was used to investigate 

analgesic activity in eight different test groups. This 

study was approved by the ethics commission of health 

research at Dr. Moewardi Hospital with letter number 

1.369/X/HREC/2022. In Figure 2 ∆T1, the results of the 

analysis of the extract group and microcapsule 

preparations showed significant differences with the 

positive control. In the F2 microcapsules group, there 

were significant differences in the negative, positive and 

extract groups. The F4 microcapsule group only had a 

significant difference in the positive and extract groups 

in ∆T2, and in ∆T3 there was only a significant 

difference in the negative and extract groups. In ∆T4 

groups F1, F2, F3, and F4, there were significant 

differences between the negative, positive, and extract 

control groups. Meanwhile, in the F5 microcapsule 

group, there were no significant differences from the 

negative, positive, and extract control groups. In Figure 

2, it was obtained that the positive control group has an 

inhibitory response that is significantly different from 

the negative control group. This happens because 

ibuprofen has not given a maximum response because 

the absorption of ibuprofen in blood plasma takes 30-60 

minutes and will reach onset after one hour, so that the 

response that appears is not significantly different 

compared to saga leaf extract preparations tested. Saga 

leaf extract gives a response that is not significantly 

different from ibuprofen, this is because the ethanol 

extract of saga leaves contains flavonoids, terpenoids 

and other secondary metabolites that function as 

analgetics. However, the microcapsule preparation is 

significantly different from ibuprofen at ∆T2, this is 

because the microcapsule preparation has a coating 

which results in the release time of the active substance 

requiring a longer time. The microcapsule preparation 

reaches the highest pain inhibition time at 90 minutes. 

The microcapsule preparation will pass through the 

human digestive tract so that the outer layer of the 

microcapsule will dissolve in the stomach due to the 

lower pH atmosphere, so that only the core material is 

absorbed in the small intestine. The length of the active 

substance release process is due to the content of the 

coating more than the active substance. The greater the 

active substance content. The process of releasing the 

active substance from microparticles increases more 

(Sinha et al.. 2004). 

The data Increase in pain inhibition was continued 

with the one-way ANOVA test and the results of the 

analysis in the positive control group were significantly 

different compared to the other groups because the sig 

value <0.05. The extract and microcapsule groups all 

have significant differences because they get a sig value 

<0.05. In the F1 microcapsule group, there is no 

significant difference from the F2 and F3 groups 

because it gets a sig value >0.05. In microcapsules F4 

and F5, there is no significant difference in the value of 

increasing pain inhibition. Based on Table 5. the results 

of the acquisition of pain inhibition produced by the 

extract group. F1. F2 and F3 microcapsules are more 

than 50%. according to Puspitasari et al. (2003). it was 

stated that they had analgesic activity. Th,e content of 

secondary metabolite compounds such as flavonoids 

present in the sample can influence this, which are 

thought to have analgesic activity with a mechanism of 

action capable of inhibiting the cyclooxygenase 

pathway that produces pain mediators such as 

prostaglandins, histamine,bradykinin and leukotrien. 

The presence of flavonoids can also affect the metabolic 

activity of arachidonic acid enzymes. The higher the 

flavonoid content, the higher the arachidonic acid 

content that can inhibit cyclooxygenase. resulting in 

high analgesic power.

 

 

Figure 2. Data graph of the average difference in pain inhibition response time 
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Table 5. AUC data and percentage of pain inhibition 

Sample AUC data (Total  ± SD) 
Increase in pain inhibition 

(%) (Mean ± SD) 

Negative Control 242.67 ± 6.05 - 

Positive Control 458.67 ± 11.66 89.01 ± 1.62 

Extract 8mg/20gr 418.92 ± 8.47 72.67 ± 2.82 

F1 160 mg/20gr 376.44 ± 8.51 55.25 ± 5.96 

F2 160 mg/20gr 381.33 ± 10.11 57.15 ± 2.15 

F3 160 mg/20gr  371.52 ± 9.16 53.15 ± 4.12 

F4 160 mg/20gr 352.98 ± 13.04 45.48 ± 4.95 

F5 160 mg/20gr 345.66 ± 15.72 42.43 ± 5.06 

 

CONCLUSION 

The results of microencapsulation characterization 

of saga leaf extract from a combination of maltodextrin 

and soy protein isolate based on particle size parameters, 

distribution values, phenolic compound encapsulation 

efficiency and morphology by spray drying method each 

obtained an average value of 17.70-30.90 µm; 1.42-

2.45; 31.40-80.29% and round shape and has wrinkles, 

respectively. The analgesic activity obtained in this 

study resulted in significantly different pain inhibition 

values before and after microencapsulation. The 

analgesic activity of various microcapsules was 42.43-

57.15%. 

 

SUGGESTION 

The results of the high distribution value in 

microencapsulation of saga leaf extract are too high so 

it needs to be improved in terms of manufacturing and 

the ratio of coating materials for further research. 
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Abstract 

Background: Fibrinolytic enzyme is one of the cardiovascular disease therapies. Rhizopus microsporus var. 

oligosporus is microorganism that has been evaluated to produce fibrinolytic protease by fermentation. This study 

conducted fermentation of helianthi annui semen (sunflower seed) by Rhizopus microsporus var. oligosporus to 

produce fibrinolytic enzyme. Objective: This study aims to determine the effect of Initial pH and incubation 

temperature and its optimization in the production of fibrinolytic protease by Rhizopus microsporus var. 

oligosporus FNCC 6010 in solid-state fermentation on helianthi annui semen (sunflower seed) substrate.  Optimum 

condition was determined by maximum protease and fibrinolytic activity. Method: A crude enzyme of protease 

fibrinolytic was obtained from the supernatant extract of fermented sunflower seed. Protease activity was 

measured by the skimmed milk agar (SMA) plate method, and fibrinolytic activity was determined by the fibrin 

agar plate method. Result: It was found that the starting pH affects both the proteolytic and fibrinolytic activity of 

enzymes that are produced in fermentation. The starting pH of 5.0 showed higher fibrinolytic and proteolytic 

activity values compared to the starting pH of 7.0. The incubation temperature 33±1 °C had the higher activity 

compared to 28±1 °C or 37±1 °C. Conclusion: Initial pH and incubation temperature affect the proteolytic and 

fibrinolytic activity of crude enzyme extracted from fermented sunflower seed by Rhizopus microsporus var. 

oligosporus. The optimum condition for producing fibrinolytic protease in the state fermentation method was an 

initial pH of 5.0 and an incubation temperature of 33±1°C. 
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INTRODUCTION 

Cardiovascular diseases (CVDs) such as stroke, 

high blood pressure, arrhythmia, peripheral vascular 

disease, and valvular heart disease are the leading causes 

of death (Altaf et al., 2021). Thrombosis, or 

accumulation of fibrin clots in blood vessels, is one of 

the risk factors for cardiovascular disease. 

Cardiovascular disease is usually followed by the 

rupture of atherosclerotic plaques and erosion, which 

activates coagulated proteins, leading to thrombus 

formation (Kotb, 2014). 

The fibrinolytic enzyme is one of the thrombosis 

treatments that belong to the group of proteases. It 

catalyses the breakdown of fibrin clots by converting the 

inactive plasminogen to active plasmin or directly lysing 

the fibrin into fibrin degradation products 

(Krishnamurthy et al., 2018). Microorganisms like 

bacteria and fungi are sources of fibrinolytic protease. 

These microorganisms have benefits over plants and 

animals in that they may be grown in huge quantities and 

in a short amount of time using fermentation techniques 

(Miglani et al., 2017).  

Rhizopus microsporus var. oligosporus is a fungus 

commonly used in the manufacture of tempeh (Nout & 

Kiers, 2005). Fermentation by R. oligosporus produces 

a wide variety of enzymes, including proteases (Lim et 

al., 2022). A previous study reported that R. 

microsporus var. oligosporus made fibrinolytic 

enzymes by fermentation (Sarao et al., 2010). Other 

studies have revealed that Rhizopus species can produce 

fibrinolytic proteases, including R. oryzae (Sada et al., 

2021); Rhizopus chinensis 12 (Xiao-Lan et al., 2005); R. 

microsporus var. tuberosus (Zhang et al., 2015); and 

Rhizopus oligosporus (Poernomo et al., 2017). 

The method commonly used to produce fibrinolytic 

enzymes from fungi is solid-state fermentation (SSF). 

Technically, solid-state fermentation (SSF) is used to 

produce microbial metabolites (Sambo et al., 2021). 

This method is preferred rather than submerged 

fermentation (SmF) because the yield of enzymes in 

such cultivation systems increases significantly by 1.5 

times greater (Muhammed et al., 2020; Sharma et al., 

2021).  

The SSF process is carried out on a solid substrate 

with certain environmental conditions. The substrate 

functions as a growth medium, which is a source of 

nutrients, including nitrogen, carbon, and minerals as 

activators and vitamins (Srivastava et al., 2019; Ahamed 

et al., 2022). 

Sunflower seeds are rich in valuable compounds 

that are important as a fermentation media, such as 

protein, carbon, and nitrogen with the percentage of 

21%,  44.23%, and 0.41%, respectively (Grasso et al., 

2020; Hermansyah et al., 2019; Karefyllakis et al., 

2019). In the previous study, sunflower oil cake was 

used as a growth medium of Candida guilliermondii by 

solid state fermentation to produce fibrinolytic enzymes 

(Rashad et al., 2012). Furthermore, another study 

reported that sunflower meal had been reported as a 

substrate for producing protease enzyme from R. 

oligosporus (Rauf et al., 2010). 

Initial pH and incubation temperature are the 

critical factors that affect enzyme production in solid 

state fermentation method (Srivastava et al., 2019). 

Initial pH has an important influence on the production 

of proteolytic enzymes because each microorganism 

grows best at its specific pH that exhibits its maximum 

metabolic activity (Kotb, 2015). The optimal pH of the 

medium helps in maintaining the homeostasis of 

electrical charge in the membrane and proteins in the 

medium by regulating proton pumps and transporting 

nutrients across the membrane (Muhammed et al., 

2020). pH also affects the enzymatic processes and 

transport of various components that support cell growth 

and enzyme formation (Rauf et al., 2010). Buffers are 

commonly employed to maintain pH during microbial 

growth and are added to the media along with the 

nutrients required for growth.(Madigan et al., 2015). 

During the fermentation process, the incubation 

temperature has an impact on the metabolic activity of 

microorganisms and the growth of fungi (Rauf et al., 

2010). Temperature also affects the stability of the 

enzymes produced (Kotb, 2013; Sada et al., 2021). 

Furthermore, an increase of incubation temperature 

causes a rise of enzyme activity up to a certain point, and 

after that, there can be an effect on the growth of 

microorganisms and allow enzyme denaturation to 

occur (Vinuthna & Raju, 2022). It was reported that R. 

oligosporus shows faster growth of mycelium at a 

temperature of 25 – 37 °C (Nout & Kiers, 2005). 

This research aims to develop fermented helianthi 

annui semen by R. microsporus var. oligosporus FNCC 

6010 to produce fibrinolytic enzymes in solid-state 

fermentation.The impact of starting pH and incubation 

temperature on enzyme synthesis will be examined.  The 

proteolytic activity of the crude enzyme was assayed 

using the skimmed milk agar (SMA) plate method, and 

the fibrinolytic activity of the crude enzyme was 

determined using the fibrin plate method. The optimum 

Initial pH and incubation temperature of enzyme 

production will be defined by the higher proteolytic and 

fibrinolytic activity that the crude extract had. 
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MATERIALS AND METHODS 

Materials 

R. microsporus var. oligosporus obtained from 

Food and Nutrition Culture Collection (FNCC) 6010, 

Universitas Gadjah Mada, Helianthi annui semen from 

House of Organix, Kec. Cilincing, Kota Jakarta Utara, 

Daerah Khusus Ibukota Jakarta, Potatoes Dextrose 

Broth (PDB) Himedia®, skimmed milk powder 

Nutrifood Indonesia, Nattokinase Swanson®, fibrin 

bovine Sigma®, agarose AA®, methylene blue Sigma-

Aldrich, distilled water. 

Equipment 

Autoclave electric HL – 340 Series, Vertical Type 

Steam Sterilizer, Memmert Incubator, Genesys-20 

Spectrophotometer, Sartorius Type BP 221S Digital 

Scales, Laminar Air Flow Cabinet, magnetic stirrer, 

Samsung refrigerator, ultracentrifuge HERMLE 

Z36HK, Hettich Zentrifugen EBA 20 centrifuge, Vortex 

Thermolyne Maxi Mix, Fisher Versamix pH-meter, 

micro pipette, Eppendorf, Eppendorf tube rack, Philips 

juicer. 

Methods 

Enrichment of Rhizopus microsporus var. oligosporus 

FNCC 6010 

Enrichment of R. microsporus var. oligosporus was 

done in Potato dextrose agar (PDA) slant media by taken 

1 Ôse from R. microsporus var. oligosporus FNCC 6010 

culture stock, then the Ôse was scrapped into PDA slant 

and incubated in 33 ± 2 °C for 72 hours. 

Rhizopus microsporus var. oligosporus spore 

suspension preparation 

Ten mL of phosphate buffer 0,1M pH 5.00 or pH 

7.00 is added into the culture of R. microsporus var. 

oligosporus on its tube. The tube is vortexed for ± 10 

minutes until the spore of R. microsporus var. 

oligosporus released from the media. The optical 

density of spore suspension was measured to get 

transmittance ± 25% (λ 580) by spectrophotometer. 

Fermentation and optimization process 

Helianthi annui semen was washed three times and 

bubbled in distilled water for 25 minutes. The hull of the 

seeds was removed and doused in distilled water 1:3 

(w/v) for 12 hours. At that point, the seed was re-boiled 

for 15 minutes. After that, the seed that had been boiled 

was cleared out, and dried at room temperature for 2 

hours, and the moisture content test was done. The 

fermentation process was done by weighing 30 g of 

sunflower seed and putting it in a sterile container of 140 

cm2. Added 500 µL of R. microsporus var. oligosporus 

spore suspension in pH 5.0 or pH 7.0, spread on the seed, 

and incubated at various incubation temperatures for 24 

hours. Both parameters such as initial pH, incubation 

temperature in the state fermentation method, were 

optimized in one variable-at-a-time strategy. 

The extraction process obtained protease fibrinolytic 

crude enzyme 

Fermented sunflower seed was weighed at 20 g, and 

50 mL phosphate buffer 0.1M pH 7.00 was added. It was 

blended for 2 minutes and centrifuged for 30 minutes at 

6000 rpm. The supernatant was used as the crude 

enzyme. 

Proteolytic activity assay 

The proteolytic activity assay was done using the 

skimmed milk agar (SMA) method. Skimmed milk agar 

media was prepared by dissolving 3 g skim milk in 30 

mL distilled water and 3 g agar in 100 mL distilled 

water. Pour skim milk solution into agar solution and 

heat it. Put 20 mL media into each tube, then sterilize at 

121 °C for 15 minutes. Pour skim milk agar media into 

a sterile petri dish. Proteolytic activity assay was done 

by pipetting a 40µl sample or control to each hole of 

skim milk agar plate and incubating the plate at 33±2°C 

for 20 hours. Nattokinase (100g/10mL) was used as the 

positive control, and phosphate buffer 0.1M pH 7.00 

was used as the negative control (Poernomo et al., 

2017). The proteolytic index was calculated by the 

equation below. 

Proteolytic index

=
average clear zone diameter (mm)

media hole diameter (mm)
 

Fibrinolytic activity assay 

A fibrinolytic activity assay was done by the fibrin 

plate method. The fibrin plate media was prepared by 

dissolving 1.5 g agar in 60 mL heated distilled water, 

and 0.5 g fibrin was added to the agar solution. Put one 

droplet pipette of methylene blue into fibrin media. The 

fibrin media was pasteurized for 3 minutes at 80±2 °C. 

About 20 mL of fibrin media was poured into a sterile 

petri dish method modified (Poernomo et al., 2021). 

Fibrinolytic activity assay was done by pipetting a 40µl 

sample or control to each hole of fibrin media on a petri 

dish. Incubated at 37±2°C for 24 hours. Nattokinase 

(100 g/10 mL) was used as the positive control, and 

phosphate buffer 0.1M pH 7.00 was used as negative 

control. The fibrinolytic index was calculated using the 

equation below. 

Fibrinolytic index

=
average clear zone diameter (mm)

media hole diameter (mm)
 

Statistical analysis 

Microsoft Excel (Office 2013, Microsoft) was used 

to calculate the average and standard deviation of both 
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the proteolytic index and fibrinolytic index. The 

proteolytic index and fibrinolytic index from the data 

were analyzed using SPSS statistical software (SPSS 

version 25.0, SPSSInc., Chicago, IL, USA). Each data 

was performed by one-way ANOVA (analysis of 

variance) at a 5% confidence level to know if there was 

a significant difference from the index value. If there 

was significance, Tukey test was performed at 5% 

probability. 

 

RESULTS AND DISCUSSION 

The result of R. microsporus var. oligosporus 

enrichment on PDA media for 72 hours at a temperature 

of 33 ± 1 ° C is shown in Figure 1. PDA media is used 

because it was better compared to saborouds dextrose 

agar (SDA) based on the number of colonies grown in 

agar media (Poernomo et al., 2017). The culture 

enrichment result on the PDA slant showed the forming 

of white hyphae with a black surface. Culture storage of 

R. microsporus var. oligosporus was at 4 °C, and it was 

rejuvenated every four weeks on a new PDA during 

research use, referring to previous studies (Vinuthna & 

Raju, 2022). 

 

 

Figure 1. Rhizopus microsporus var. oligosporus 

FNCC 6010 culture on PDA slant with incubation time 

72 hours and incubation temperature 33±2°C 

 

R. microsporus var. oligosporus spore suspension 

was prepared by adding a phosphate buffer with a pH of 

5.0 or pH 7.0 to the tube of culture until transmittance of 

T 25% at λ 580 nm was obtained. Percent transmittance 

was measured at λ580 because in the λ range, 400 – 600 

nm is the appropriate wavelength for observing 

microbial cell turbidity, which is a method for 

measuring spore suspension (Madigan et al., 2015). The 

cell suspension looks cloudy because the cells scatter 

light that passes through the suspension. Since cell mass 

is proportional to the number of cells, turbidity can be 

used to estimate cell count and the technique is widely 

used in microbiology (Madigan et al., 2015). In this 

study, the transmittance value of each suspension of R. 

microsporus var. oligosporus was set to T 25% for each 

fermentation process to be reproducible. The number of 

cells used in the fermentation process was set to             

107 CFU/mL (Poernomo et al., 2017) because a lower 

number of cells can lead to longer incubation times and 

potential bacterial contamination. Furthermore, a higher 

number of cells may result in an excessive increase in 

temperature in the process and premature death of the 

fungus (Nout & Kiers, 2005). 

 

Figure 2. Fermentation product of sunflower seed by 

Rhizopus microsporus var. oligosporus FNCC 6010 

with (a) initial pH 5.0 and (b)pH 7.0; incubation time 

of 24 hours and incubation temperature 33 ± 2°C 

 

Visually, Figure 2 and Figure 3 showed that the 

fermentation products after 24 hours were white and had 

a specific odour.  The white colour of the fermentation 

product is caused by the growth of mycelia in the growth 

medium (Hariyono et al., 2021). At variable pH of 5.0 

and 7.0 and incubation temperature 33 ± 1°C and 24 h 

incubation time, the fermented product physically 

looked similar. In temperature variations, the 

differences could be observed at temperatures 28 ± 1 °C 

where the mycelia grew less frequently than at 

temperatures of 33 ± 1 °C and 37 ± 1 °C.  Previous 

research explained that at a temperature of 25 °C or 

below, the rate of the fermentation process decreases so 

that it takes a longer time to achieve results equivalent 

to fermentation at a temperature of 30 °C or higher 

(Nout & Kiers, 2005). In addition, at low temperatures, 

there is a possibility that bacterial contamination grows 

faster than the growth rate of Rhizopus sp. (Dwiatmaka 

et al., 2022). 

 

Figure 3. Fermentation product of sunflower seed by 

Rhizopus microsporus var. oligosporus FNCC 6010 

with variations incubation temperature (a) 28±1°C; (b) 

33±1°C; (c) 37±1°C; incubation time of 24 hours; 

initial pH fermentation of 5.0 

 

The fermentation results were then extracted to 

obtain crude enzymes. In the solid-state fermentation 

method for enzyme production, fermentation results can 



Jurnal Farmasi dan Ilmu Kefarmasian Indonesia Vol. 10 No. 3 December 2023      294 

 

 

P-ISSN: 2406-9388   ©2023 Jurnal Farmasi dan Ilmu Kefarmasian Indonesia 

E-ISSN: 2580-8303  Open access article under the CC BY-NC-SA license 

be used directly as a source of crude enzyme and easily 

harvested from the media (Sambo et al., 2021). In this 

study, the crude enzyme was defined as an enzyme 

obtained from the fermentation of sunflower seed by 

Rhizopus microsporus var. oligosporus FNCC 6010, 

which was extracted with a phosphate buffer solvent at 

pH 7.0 and took the supernatant. Extraction was carried 

out with a pH of 7.0 because previous studies have 

revealed that the activity and stability of fibrinolytic 

enzymes produced by Rhizopus microsporus var. 

tuberosus are optimal at pH 7.0 (Zhang et al., 2015). An 

essential step in enzyme downstream processing is the 

removal of the cells, solids, and colloids from the 

fermentation media which commonly using the 

ultracentrifugation process (Raju & Divakar, 2014). 

Enzymes were stored at < 5°C to prevent microbial 

contamination and maintain enzyme activity and 

stability. 

 

Figure 4.  Proteolytic activity of crude enzyme from 

fermented sunflower seed with fermentation condition 

variation in initial pH 5.0 (S5 R1, S5 R2, S5 R3) and 

initial pH 7.0 (S7 R1, S7 R2, S7 R3). 

 

It was found that crude enzymes from fermented 

sunflower seeds showed a clear zone around the hole 

media in skim milk agar (SMA) plates. Nattokinase as 

positive control also demonstrated a clear zone, while 

phosphate buffer 0.1M pH 7 as negative control did not 

appear in a clear zone, according to Figure 4. The clear 

zone showed the proteolytic activity by hydrolysis of the 

peptide bonds in casein that link amino acids together in 

the polypeptide chain in skimmed milk agar (Susanti et 

al., 2019). The rising of protease activity is 

demonstrated by the higher clear zone in SMA media 

(Ahamed et al., 2022) 

In this study, the influence of the starting pH during 

the fermentation process was investigated at pH 5.0 and 

pH 7.0, incubation temperature of 33 1 °C, and an 

incubation period of 24 hours. The results showed that 

the value of the proteolytic index at pH 5.0 was higher 

than at pH 7.0, according to Table 1. Statistical analysis 

showed that there was a significant difference in 

proteolytic activity at initial pH 5.0 and pH 7.0 with Sig. 

0.005 (< 0.05). Similar research showed that the 

protease production method in submerged fermentation 

by Rhizopus microsporus var. oligosporus is optimal at 

pH 5.5 (Sarao et al., 2010). Previous research has 

revealed that the optimum pH of the media for protease 

synthesis from Rhizopus oligosporus IHS13 in 

sunflower meal, wheat bran, and rice bran is at pH 5.0. 

At pH above and below 5.0, there is a decrease in 

enzyme production and so below that pH (Haq & 

Mukhtar, 2004). Another study used pH 5.5 to produce 

proteases from Rhizopus oryzae in bread media 

(Benabda et al., 2019). 

The results of fibrinolytic activity are described in 

Figure 5. showed that at the initial pH condition of 

fermentation, 5.0 obtained a fibrinolytic index greater 

than at pH 7.0, according to Table 2. That was a 

statistical difference from value Sig. 0.030 (< 0.05). It 

was indicated by a clear zone around the hole in fibrin 

agar media. Other studies have shown that the 

fibrinolytic activity of enzymes produced by Serratia 

rubidaea KUAS001 at the initial pH of enzyme 

production 5.0 is better than at pH 7.0, and decreases 

with increasing pH (Anusree et al., 2020). Each 

microorganism grows best at its specific pH, where it 

exhibits maximum metabolic activity, the fungus 

showed optimal metabolic activity in the pH range of 4 

to 5 (Srivastava et al., 2019). 

 

 

Figure 5. Fibrinolytic activity of crude enzyme from fermented sunflower seed with fermentation condition variation 

initial pH 5.0 (S5 R1, S5 R2, S5 R3) and initial pH 7.0 (S7 R1, S7 R2, S7 R3) 

S7 R1 

S7 R2 

S7 R3 

S5 R1 

S5 R2 

S5 R3 

K+ 

K- 
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Table 1.  Proteolytic index of crude enzyme from fermented sunflower seed incubation time 24 hours at 33 ± 1°C initial 

pH variation 

Sample/Control 
Clear zone 

diameter (mm) 

Mean clear zone 

diameter (mm) ± SD 

Proteolytic 

index 

Mean Proteolytic 

index ± SD 

K+ 14.03 14.03 2.00 2.00 

K- 0.00 0.00 0.00 0.00 

S5 R1  18.45 

18.40 ± 0.19 

2.64 

2.63 ± 0.03 S5 R2 18.60 2.66 

S5 R3 18.15 2.59 

S7 R1 17.10 

16.63 ± 0.41 

2.44 

2.38 ± 0.06 S7 R2 16.10 2.30 

S7 R3 16.10 2.39 

Note: K+ = positive control; K– = negative control; S5 R1, S5 R2, S5 R3 = crude enzyme from 

fermented sunflower seed in each pH 5 replication 1, 2 and 3; S7 R1, S7 R2, S7 R3 = crude 

enzyme from fermented sunflower seed in initial pH 7 replication 1, 2 and 3 

 

Table 2. Fibrinolytic index of crude enzyme from fermented sunflower seed in initial pH variation 

Sample/Control 
Clear zone 

diameter (mm) 

Mean clear zone 

diameter(mm)± SD 

Fibrinolytic 

index 

Mean Fibrinolytic 

index ± SD 

K+ 15.13 15.13 2.16  2.16 

K- 0.00 0.00 0.00 0.00 

S5 R1  15.13 

15.29 ± 0.12 

2.16 

2.18 ± 0.02 S5 R2 15.30 2.19 

S5 R3 15.43 2.20 

S7 R1 14.70 

13.82 ± 0.28 

2.10 

2.01 ± 0.07 S7 R2 13.43 1.92 

S7 R3 14.00 2.00 

Note: K+ = positive control; K– = negative control; S5 R1, S5 R2, S5 R3 = crude enzyme from 

fermented sunflower seed in initial pH of 5.0 replication 1, 2 and 3; S7 R1, S7 R2, S7 R3 = crude 

enzyme from fermented sunflower seed in initial pH 7.0 replication 1, 2 and 3 

 

Further research was carried out on the variability 

of incubation temperature parameters of 28±1, 33±1, 

and 37±1 °C, initial pH 5.0, and incubation time of 24 

hours. Based on the results of the proteolytic activity 

assay, shown in (Figure 6). it was found that the 

proteolytic index of the crude enzyme at an incubation 

temperature of 33±1 °C produced a larger value 

compared to temperatures of 28±1 °C and 37±1 °C 

according to Table 3. It was statistically different with 

the value Sig. 0.000 (<0.05). In enzyme production by 

microorganisms, an increase in the temperature of 

fermentation causes a rise in enzyme activity up to a 

certain point, and after that, there can be a decrease 

(Ahamed et al., 2022; Boratyński et al., 2018) in line 

with previous studies that revealed that there was an 

increase in protease activity produced by Rhizopus 

oligosporus IHS13 with substrates of wheat bran and 

rice bran at an incubation temperature of 25 °C to 30 °C 

then after that decreased at a temperature of 35 °C which 

showed that the organism was mesophyll (Haq & 

Mukhtar, 2004). Similar research on protease 

production by Rhizopus oligosporus shows that the 

optimal fermentation temperature is 30 °C, which then 

decreases to 35 °C (Rauf et al., 2010). 

 

 

Figure 6. Proteolytic activity assay result of crude 

enzyme fermented sunflower seed with fermentation 

condition incubation temperature 28 ±1 °C (S28 R1, 

S28 R2, S28 R3); 33 ±1 °C (S33 R1, S33 R2, S33 R3); 

37 ±1 °C (S37 R1, S37 R2, S37 R3) 
 

 



Jurnal Farmasi dan Ilmu Kefarmasian Indonesia Vol. 10 No. 3 December 2023      296 

 

 
P-ISSN: 2406-9388   ©2023 Jurnal Farmasi dan Ilmu Kefarmasian Indonesia 

E-ISSN: 2580-8303  Open access article under the CC BY-NC-SA license 

Table 3.  Proteolytic index of crude enzyme from fermented sunflower seed in various incubation temperature 

Sample/Control 
Clear zone diameter 

(mm) 

Mean clear zone 

diameter (mm) ± SD 

Proteolytic 

index 

Mean Proteolytic 

index ± SD 

K+ 18.37 18.37 2.62 ± 0.02 2.62 

K- 0.00 0.00 0.00 ± 0.00 0.00 

S28 R1 14.00 

14.53 ± 0.40 

2.00 

2.08 ± 0.06 S28 R2 14.63 2.09 

S28 R3 14.97 2.14 

S33 R1 16.93 

17.01 ± 0.11 

2.42 

2.43 ± 0.02 S33 R2 16.93 2.42 

S33 R3 17.17 2.45 

S37 R1 15.77 

15.74 ± 0.11 

2.25 

2.25 ± 0.02 S37 R2 15.60 2.23 

S37 R3 15.87 2.27 

Note: K+ = positive control; K– = negative control; S28 R1, S28 R2, S28 R3 = crude enzyme fermented 

sunflower seed with fermentation condition incubation temperature 28 ±1 °C; S33 R1, S33 R2, S33 R3= 

crude enzyme fermented sunflower seed with fermentation condition incubation temperature 33 ±1 °C; 

S37 R1, S37 R2, S37 R3= crude enzyme fermented sunflower seed with fermentation condition 

incubation temperature 37±1 °C 

 

Table 4.  Fibrinolytic index of the crude enzyme from fermented sunflower seed in various incubation temperature 

Sample/Control 
Clear zone 

diameter (mm) 

Mean clear zone 

diameter (mm) ± SD 

Fibrinolytic 

index 

Mean Fibrinolytic 

index ± SD 

K+ 14.70 14.70 2.10  2.10 ± 0.05 

K- 0.00 0.00 0.00 0.00 ± 0.00 

S28 R1 13.23 

12.78 ± 0.37 

1.89 

1.83 ± 0.05 S28 R2 12.77 1.82 

S28 R3 12.33 1.76 

S33 R1 15.90 

15.67 ± 0.22 

2.27 

2.24 ± 0.03 S33 R2 15.73 2.25 

S33 R3 15.37 2.20 

S37 R1 14.13 

14.33 ± 0.14 

2.02 

2.05 ± 0.02 S37 R2 14.40 2.06 

S37 R3 14.47 2.07 

Note: K+ = positive control; K– = negative control; S28 R1, S28 R2, S28 R3 = crude enzyme 

fermented sunflower seed with fermentation condition incubation temperature 28 ±1 °C; S33 R1, 

S33 R2, S33 R3= crude enzyme fermented sunflower seed with fermentation condition incubation 

temperature 33 ±1 °C; S37 R1, S37 R2, S37 R3= crude enzyme fermented Helianthus annus L. 

semen with fermentation condition incubation temperature 37±1 °C 

 

Fibrinolytic activity assay results shown in (Figure 

7) demonstrate that there was an increase in fibrinolytic 

activity in enzyme production with an incubation 

temperature from 28 ±1 °C up to 33 ±1 °C.  Then, at the 

incubation temperature of 37 ±1 °C, the fibrinolytic 

activity of the crude enzyme was decreased, according 

to (Table 4) The results statistically showed a significant 

difference between temperature variations at the value 

Sig. 0.000 (< 0.05). Similar research results revealed 

that Rhizopus oryzae FNCC 6078 for fibrinolytic 

enzyme production increased with increasing incubation 

temperature, and the optimum temperature was reached 

at 35 °C (Sada et al., 2021). Environmental temperature 

is one of the factors that greatly affect the growth and 

metabolism of organisms (Srivastava et al., 2019). At 

low temperatures, rising temperatures increase the 

growth rate of organisms because the speed of reactions 

catalyzed by enzymes increases, so metabolism 

increases, resulting in ,more significant growth and 

production of enzymes by microorganisms. But the 

increase will reach a certain point until after that, too 

high temperatures can damage microorganisms by 

denaturation, transporters, other proteins, and plasma 

membranes. Temperatures too high for microorganisms 

promote stretching and eventual breakdown of weak 

hydrogen bonds in the enzyme, particularly in the 
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protease enzyme generated during the fermentation 

process. (Haq & Mukhtar, 2004). 

 

 

Figure 7. Fibrinolytic activity assay result of crude 

enzyme fermented sunflower seed with fermentation 

condition incubation temperature 28 ±1 °C (S28 R1, 

S28 R2, S28 R3); 33 ±1 °C (S33 R1, S33 R2, S33 R3); 

37 ±1 °C (S37 R1, S37 R2, S37 R3) 

 

CONCLUSION 

The initial pH and incubation temperature for 

producing fibrinolytic protease from Rhizopus 

microsporus var. oligosporus FNCC 6010 on helianthi 

annui semen (sunflower seed) substrate in solid state 

fermentation affects both the proteolytic and fibrinolytic 

activity. The initial pH of 5.0 had higher activity than 

the initial pH of 7.0. The incubation temperature 

33±1 °C had the higher activity compared to 28±1 °C or 

37±1 °C so the optimum condition was an initial pH of 

5.0 and incubation temperature of 33±1°C. 
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Abstract 

Background: Sambiloto leaves (Andrographis paniculata (Burm.f.) Nees) contain andrographolide (diterpene 

lactone), flavonoids, quinic acid, steroids, saponins, alkaloids, and tannins, which act as anti-inflammatory, 

antioxidant, antibacterial, and wound healing. Objective: This study optimizes the gelling ingredient in Sambiloto 

extract gel preparations (Andrographis paniculata (Burm.f.) Ness) as a wound healer in male Wistar rats. The 

gelling agent is an important component that can affect active substance release. Methods: Formula optimization 

was developed using the Regular Two-Level 22 Factorial Design method in Design-Expert 12 software. This study 

used 0.5%-1% carbopol 940 and 1%-5% sodium alginate. Carbopol 940 and Sodium Alginate have different 

characteristics, so they need to be optimized to produce a gel with good characteristics. Results: Physical property 

evaluation using factorial design revealed the optimal formula at 0.5% carbopol and 5% sodium alginate, with 

average pH, viscosity, and adhesion values of 5.17 ± 0.04; 2934.452±286.871 cPs; and 194.236±3.684 s. 

Centrifugation and cycling tests indicated no organoleptic changes, phase separation, or significant changes in 

pH. ANOVA analysis showed that the gel with 10% Sambiloto leaf extract had similar burn healing activity to the 

positive control, with a recovery rate of 99.72 ± 0.47% in 20 days. Scabs formed on the 8th day and peeled off on 

the 12th day. Conclusion: Sambiloto extract gel in the optimum formula has the potential to be developed as a 

burn wound-healing drug. 
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INTRODUCTION 

Skin is the human body's main protector from 

foreign objects considered dangerous. One of the 

triggers for diseases that can appear on the skin is the 

presence of open wounds. An open wound is damage to 

a unit or tissue component where specifically there is a 

damaged or missing tissue substance (Wijaya & Putri, 

2013). Open wounds can be caused by burns by 

exposure to heat sources such as air, fire, chemicals, 

electricity, and radiation. Burns damage the skin and 

affect all body systems (Jeschke et al., 2020; Tiwari, 

2012). 

The depth of tissue damage due to burns depends on 

the degree of heat from the source of the burn, the cause 

of the burn and the duration of contact with the body 

(Noer, 2006). According to the American Burn 

Association, second-degree burns (partial thickness 

burns) are burns whose depth of tissue can reach the 

dermis, usually found to be painful, pale when pressed, 

and marked by bullae filled with exudate fluid that come 

out of the blood vessels due to increased permeability of 

the walls (Shetty et al., 2021). 

Sambiloto (Andrographis paniculata (Burm.f.) 

Nees) is one of the Indonesian plants that have the 

potential to heal burns due to the content of secondary 

metabolites such as andrographolide (diterpene lactone), 

flavonoids, quinic acid, steroids, saponins, alkaloids and 

tannins (Mussard et al., 2020). Sambiloto has many 

pharmacological activities, such as antibacterial, 

antioxidant, antiviral, antifungal, and anti-inflammatory 

properties, and it enhances the immune system (Rajanna 

et al., 2021). Antibacterial, anti-inflammatory and 

antioxidant activities are closely related to the healing 

process of burns because they can accelerate 

epithelization and repair and strengthen skin cells. 

Based on research by Al-Bayaty et al. (2011), 

histologically, burn wounds treated with 10% bitter 

extract showed good healing. Research from Selvaraj et 

al. (2022) proves that bitter extract has an anti-

inflammatory valuable mechanism in wound healing. 

The recent research from Ariawan et al. (2023) 

demonstrated that Andrographis paniculata extract 

affected wound healing, such as the rate of re-

epithelialization, collagen density, angiogenesis, and 

wound length. 

Burns can be treated with topical, oral, and other 

treatments. However, topical treatment is more 

comfortable for burn sufferers. A gel preparation is one 

of the preparations that are suitable for treating burns. 

Gel preparations have a cooling effect because they 

contain a lot of water, so substances penetrate tissues 

better and accelerate wound healing (Rinaldi et al., 

2019). An essential component in the manufacture of gel 

is the gelling agent. 

Carbopol is a gel base that has a clear appearance, 

good spreading power on the skin, and a cooling effect; 

it does not clog skin pores and is easily washed off with 

water (Niyaz et al., 2011). The concentration of 

carbopol 940 as a gelling agent ranges from 0.5 – 2.0% 

(Rowe et al., 2009). Sodium alginate is produced from 

brown algae with a mucilage content of up to 40%. Gel 

containing sodium alginate shows excellent distribution; 

besides that, sodium alginate has slippery properties, is 

not sticky, does not feel when used and shows emollient 

properties (moisturizes the skin) (Agoes, 2012). The 

concentration of sodium alginate as a gelling agent 

ranges from 1 – 5% (Rowe et al., 2009). Singh et al. 

(2013) made diclofenac gel using gelling agents such as 

Carbopol 940, HPMC, gelatin, sodium alginate and Na 

CMC. The results of this study prove that the use of 

sodium alginate can increase the spreadability of the gel 

compared to other gelling agents, while the use of 

carbopol 940 can increase the release of the active 

substance compared to other gelling agents. Liu et al. 

(2008) also proved that the use of carbopol 940 was able 

to increase drug penetration and preparation stability. 

The combination of Carbopol 940 and sodium alginate 

in this study is expected to improve the characteristics 

of the gel.   

Based on the description above, it is necessary to 

conduct research in the form of "Optimization of Gelling 

Agent in Sambiloto Extract Gel (Andrographis 

paniculata (Burm.f.) Ness) as Wound Healer in Wistar 

Strain Male Rats". The ethanol extract of Sambiloto 

leaves (Andrographis paniculata (Burm.f.) Ness) was 

prepared using the maceration method with a 96% 

ethanol solvent. Formula optimization was developed 

using the Regular Two-Level Factorial Design method 

in Design-Expert 12 software. This study used two 

factors, namely factor A as carbopol-940 and factor B as 

sodium alginate. Sambiloto extract gel (Andrographis 

paniculata (Burm.f.) Ness) was evaluated to obtain the 

optimum formula and then tested for burn healing 

activity for 20 days. 

 

MATERIALS AND METHODS 

Materials 

The materials used in this study were Sambiloto 

leaves (Andrographis paniculate (Burm.f.) Ness from 

Lampung, Indonesia), Filter Paper (Whatman®, 

Indonesia), Distilled Water (Bratachem®, Indonesia), 

96% ethanol (Bratachem®, Indonesia), Sodium Alginate 
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(Techno Phramchem®, Indonesia), Carbopol 940 

(Bratachem®, Indonesia), Propylene glycol 

(Bratachem®, Indonesia), Methyl Paraben (Bratachem®, 

Indonesia), Propyl Paraben (Bratachem®, Indonesia), 

Triethanolamine (Bratachem®, Indonesia), Alcohol 70% 

(Bratachem®, Indonesia), Lidocaine 2%®, Veet ®, 

Binagel®.  

Tools 

The tools used in this study included analytical 

balances 0.001 g and 0.0001 g (Ohaus®), oven 

(IMU55L®), pH meter (Lutron® pH Electrode PE-03), 

rotary evaporator (Biobase®), blender (Philips®), UV-

Vis (Biobase®), magnetic stirrer (IKA C-MAG HS4®), 

spin bar, viscometer (Grace Instrument M3400®), 

micropipette (Dragon Lab®), glassware (Pyrex®), iron 

plate, stopwatch, mouse cage, drinking bottle, 

refrigerator (LG®). 

Method 

Preparation of sambiloto extract 

The sambiloto plant used was identified at the 

Laboratorium Karakterisasi Kebun Raya Eka Karya 

Bali, BRIN with ID Number 53688. The simplicia 

powder of Sambiloto leaves was macerated using 96% 

ethanol with a ratio of 1:10 for 72 hours while stirring 

once every 6 hours in a dark place. The resulting filtrate 

was concentrated in a rotary evaporator at 50°C until an 

ethanol extract of Sambiloto leaves was obtained. The 

resulting extract was stored in a refrigerator at 4°C 

(Fardiyah et al., 2020). The percent yield of the extract 

is calculated using the equation: 

% Extract yield =  
Extract weigth 

Simplicia weight
 x 100  

Phytochemical screening 

The phytochemical screening method is qualitative 

by looking at the occurring colour reactions. The test 

parameters that were carried out included the 

identification of flavonoids, saponins, tannins, 

alkaloids, steroids, and triterpenoids. Alkaloid testing 

was carried out using Dragendorf and Wagner reagents. 

If the reaction is positive for alkaloids, a red precipitate 

is formed using the Dragendorf reagent, and a brown 

precipitate is formed using Wagner's reagent. Flavonoid 

testing was done by adding magnesium and 

hydrochloric acid to the extract. Yellow, red, or orange 

solutions indicate the presence of flavonoids. Saponin 

testing is done by observing the foam formed from an 

extract and water mixture. The formation of persistent 

foam for 10 minutes indicates the presence of saponin. 

Tannin testing is carried out with FeCl3 reagent. The 

blackish-green colour indicates the presence of tannin. 

Testing for steroids and triterpenoids was performed 

using glacial acetic acid and concentrated sulfuric acid 

reagents. A solution that is blue or green indicates the 

presence of steroids, while red or purple suggests the 

presence of triterpenoids (Depkes RI, 2017). 

Formulation of gel containing sambiloto extract 

The gel formula design was determined using 

Design-Expert series 12 software. Formula optimization 

was developed using the Regular Two-Level Factorial 

Design method in Design-Expert 12 software. The 

formulas used in this study were four formulas using two 

factors, namely carbopol-940 and sodium alginate, at 

two successive levels of 0.5-1% and 1-5% (Table 1). 

 

Table 1. Formula of gel containing sambiloto extract 

Material 
Concentration (%) 

F1 F2 F3 F4 

Extract 10 10 10 10 

Carbopol-940 1 0.5 1 0.5 

Sodium 

Alginate 

1 1 5 5 

Triethanolamine 1 1 1 1 

Propylene glycol 15 15 15 15 

Methyl Paraben 0.18 0.18 0.18 0.18 

Propyl Paraben 0.02 0.02 0.02 0.02 

Distilled Water 
Ad 100 

mL 

Ad 100 

mL 

Ad 100 

mL 

Ad 100 

mL 

 

The process begins with weighing the ingredients 

and continues with the preparation of the gel base. 

Sodium alginate developed with aquadest. Carbopol-

940 was dispersed in distilled water and added with 

triethanolamine until a gel base was formed. The 

dispersed sodium alginate and carbopol mass are put 

into a mortar and ground until homogeneous. Methyl 

paraben and propyl paraben were dissolved in propylene 

glycol, added to the gel mass, and stirred until 

homogeneous. The ethanol extract of Sambiloto was 

added little by little to the gel mass, and 100 mL of 

distilled water was added and then stored in a tightly 

closed container (Mardiyanto et al., 2022). 

Evaluation of gel containing sambiloto extract 

Organoleptic 

Organoleptic tests were carried out by directly 

observing the shape of the gel prepared, its color, and its 

smell (Titaley, 2014). 

Homogeneity 

Preparations were taken at three different sampling 

points and smeared on transparent glass. The test 

preparation is declared homogeneous if there are no 

coarse grains (Nikam, 2017).  

pH   

The pH test is carried out by turning on the pH 

meter and then dipping the pH meter electrode into the 
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gel formula, which has been dissolved with distilled 

water. Topical preparations must match the skin's pH, 

namely 4.5-6.5 (Tranggono, 2007). 

Viscosity  

Viscosity was done using a viscometer. The speed 

is set at 60 rpm, and then the pointer on the tool is 

observed for the number on the viscosity scale. The gel 

has viscosity values ranging from 2000-4000 cps (Garg 

et al., 2002). 

Spreadability 

The gel preparation was placed between two glass 

plates with weights on glass plates with a mass of 125 g. 

The diameter formed after 1 minute was measured. The 

specification for the diameter of the spread is 5-7 cm 

(Garg et al., 2002). 

Adhesion 

The gel was placed between two glass objects and 

then pressed with a 1 Kg load for 5 minutes. The load is 

lifted from the object glass, and then the object glass is 

mounted on the test equipment with a load of 80 g. Good 

adhesion requires more than 4 seconds (Mukhlishah et 

al., 2016). 

Determine the optimum formula 

Optimum formula selection was made using Design 

Expert 12 software based on desirability values close to 

1 with response parameters pH, viscosity, spreadability, 

and adhesion. The closer the desirability value is to 1, 

the more perfect the desired formula is in the program 

(Raissi & Farsani, 2009). 

Stability test 

The physical stability test of the preparations was 

carried out using the centrifugation method and the 

cycling test. The centrifugation test was carried out at 

3800 rpm for 5 hours, while the cycling test was carried 

out at 4°C and 40°C for 24 hours for six cycles. 

Parameters observed were organoleptic changes in the 

preparation, pH, and phase separation in gel 

preparations (Apriani et al., 2018; Mardiyanto et al., 

2022). 

Burn wound-healing activity test 

Testing on animals has received ethical approval 

from Ahmad Dahlan University, number 02210066. The 

test animals were male white rats of the Wistar strain, 

aged 2-3 months, weighing 180-250g, and acclimatized 

for one week. The test animals were anesthetized first 

using lidocaine at a dose of 0.4 mL/KgBW 

subcutaneously. The rat's back was shaved about 3 cm 

below the ear using Veet® and a razor, marked with a 

rectangular shape with a size of 3 x 2 cm. An iron plate 

with a diameter of 1 cm was previously heated in boiling 

water for 5 minutes to achieve sterile conditions and 

then induced on the rats' backs for 10 seconds 

(Akhoondinasab et al., 2014). 

The gel was administered by applying it to the 

wound on the rat twice a day, i.e., in the morning and 

evening, for 20 days after the burn induction. Wound 

healing parameters were determined from the area of 

wound healing, wound healing time, and the time the 

scab fell off. 

 

Table 2. Treatment group of burn wound-healing 

activity test 

Group Note 

Negative Control Gel base 

Positive Control Binagel 

Sample Optimum formula for 

sambiloto extract gel 

 

Observations on the healing of burns were carried 

out from days 0, 4, 8, 12, 16, and 20. Measurements of 

the wound area were carried out at intervals of 4 days. 

Binagel® was chosen as the positive control because it is 

a marketed burn preparation containing plant extracts. 

Data analysis  

    Data analysis on the evaluation of gel 

preparations was carried out by calculating the factorial 

design using the Design Expert 12 Program. Data 

analysis was carried out by calculating the coefficient 

values of each factor, namely carbopol-940 and sodium 

alginate, to obtain an equation for the relationship 

between factors and responses. Data analysis on burn 

wound healing used the SPSS® application with a data 

normality test performed with Shapiro-Wilk to see the 

normality of data distribution. It continued with One-

Way ANOVA, and then a Post Hoc Duncan Test was 

conducted if the p-value <0.05. 

 

RESULTS AND DISCUSSION 

The sambiloto extract produced in this study is dark 

green, has a distinctive smell, and is thick, with a yield 

percentage of 20.20%. The results of the phytochemical 

screening showed that Sambiloto extract contains 

flavonoids, saponins, tannins, steroids, triterpenoids, 

and alkaloids (Table 3). The results of this study are in 

line with the research by Hita et al. (2022), where the 

96% ethanol extract of Sambiloto leaves was proven 

positive for containing flavonoids, alkaloids, tannins, 

triterpenoids, and saponins. 
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Table 4. Results of evaluation of gel containing sambiloto extract 

Parameter  Formula 

F1 F2 F3 F4 

Organoleptic Dark green, 

distinctive smell 

and thick 

Dark green, 

distinctive smell 

and thick 

Dark green, 

distinctive smell 

and thick 

Dark green, 

distinctive smell 

and thick 

Homogeneity Homogeneous Homogeneous Homogeneous Homogeneous 

pH 5.25±0.03 5.56±0.01 5.38±0.03 5.17±0.04 

Viscosity (cPs) 2391.66± 

135.94 

2079.66± 

93.11 

3732.33± 

173.07 

2822.66± 

370.93 

Spreadability (cm) 5.93±0.12 6.53±0.50 5.63±0.40 5.73±0.47 

Adhesion (s) 90.67±2.08 39±1.00 195±5.00 162.67±2.52 

 

Table 5. Results of model analysis  

Parameter Parameter 

R2 Adjusted R2 Predicted R2 Adequateprecision p-value 

 

pH 0.9651 0.9521 0.9216 19.6780 <0.0001 

Viscosity 0.9226 0.8936 0.8259 12.9745 <0.0001 

Spreadability 0.7287 0.6270 0.3896 6.4286 0.0018 

Adhesion 0.9984 0.9977 0.9963 89.2441 <0.0001 

Table 3. Result of phytochemical screening 

Secondary Metabolites Result 

Flavonoid + 

Saponin + 

Tanin + 

Alkaloid + 

Steroid & Triterpenoid + 

Note : + indicates metabolites are present 

 

Sambiloto extract is used as an active ingredient in 

making gel. In the manufacture of gels, the gelling agent 

is an essential factor in determining the results of the 

characterization of the resulting preparations. In this 

study, variations in the concentration of the gelling 

agent, namely carbopol-940 and sodium alginate, were 

carried out to produce four formulas. The gel 

preparations made in this study can be seen in Figure 1. 

The results of the evaluation of the preparations from the 

four formulas can be seen in Table 4. 

 

 

Figure 1. Gel containing sambiloto extract 

 

Based on Table 4, it is known that the four formulas 

have met the evaluation requirements for gel 

preparations, namely pH ranging between 4.5-6.5, 

viscosity with a value range of 2000-4000 cPs, 

spreadability ranging from 5-7 cm and adhesion is in the 

range of 2-3000 seconds (Garg et al., 2002). Measured 

parameters such as pH, viscosity, spreadability, and 

adhesion were continued for the optimization process by 

factorial design analysis using the Design-Expert 12® 

program. Data analysis was carried out broadly divided 

into two, namely model analysis and response analysis. 

The model analysis determines which parameters 

can be used to determine the optimum formula. A model 

can be good if the p-value is less than 0.05 with an R2 

value greater than 0.7, the difference between adjusted 

R2 and predicted R2 is not more than 0.2, and the 

adequate precision value is more than 4 (Apriani et al., 

2023). The model analysis results of measured 

parameters such as pH, viscosity, spreadability, and 

adhesion can be seen in Table 5. 

The R2 value is used to see how much the data 

population influences the factors used. For example, the 

value of R2 at a pH of 0.9651 means that 96.51% of the 

data population is influenced by carbopol-940, sodium 

alginate, and the interaction between the two. The 

difference value of adjusted R2 and predicted R2 

describes the difference between the system's predicted 

value and the (actual) measured value. The smaller than 

0.2, the closer the similarity of the resulting values is. 

The adequate precision value indicates the robustness of 

the model, while the p-value indicates the significance 

of the effect. Based on Table 5, the pH, viscosity, and 

adhesion parameters show good model results. In 

contrast, the spreadability parameter shows poor model 

analysis results where the difference between adjusted 



Jurnal Farmasi dan Ilmu Kefarmasian Indonesia Vol. 10 No. 3 December 2023      305 

 

 

P-ISSN: 2406-9388   ©2023 Jurnal Farmasi dan Ilmu Kefarmasian Indonesia 

E-ISSN: 2580-8303  Open access article under the CC BY-NC-SA license 

R2 and predicted R2 is more than 0.2. Based on these 

results, the parameters that can be continued to 

determine the optimum formula are pH, viscosity, and 

adhesion. 

The following analysis performed was response 

analysis. Response analysis was carried out to see the 

effect of the carbopol-940, sodium alginate, and the 

interaction of the two factors on the parameters of pH, 

viscosity, and adhesion. The response analysis results 

can be seen in Table 6 and Figure 2. 

 

 

Table 6. Results of response analysis 

Parameter Intercept 
A 

(Carbopol 940) 

B 

(Sodium Alginate) 

AB 

(Interaction) 

pH Coefficient 5.346 -0.024 -0.064 0.129 

p-value  0.0393* 0.0002* <0.0001* 

% contribution  2.635  18.582  73.297  

Response 

Equation 

y = 5.346 – 0.024 A – 0.064 B + 0.129 AB 

Viscosity Coefficient 2756.580 305.417 520.917   149.417 

p-value  0.0014* <0.0001*   0.0470* 

% contribution  22.241 64.699 5.323 

Response 

Equation 

y = 2756.58 + 305.417 A + 520.917 B + 149.417 AB 

Adhesion Coefficient 121.833 4.833 57.000 -27.000 

p-value  0.0006* <0.0001* <0.0001* 

% contribution  0.628 87.351 11.857 

Response 

Equation 

121.833 + 4.833 A + 57.000 B – 27.000 AB 

 

 

Figure 3. Graph of normal plot, interaction and contour plot of the parameters pH (A), Viscosity (B) and adhesion (C) 
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Based on Table 6, the concentrations of carbopol-

940 and sodium alginate and their interactions 

significantly affect pH, viscosity, and adhesion 

parameters with a p-value <0.05. These results can also 

be supported by Figure 3, which is related to the normal 

plot graph where the factor points are outside the straight 

line, which indicates that the factor has an influence, 

both positive and negative. This positive and negative 

influence can be observed from where the point is in the 

negative or positive area. Besides that, it can also be 

seen from the notation of the coefficients whether there 

is a negative sign or not. The concentration of each 

carbopol-940 and sodium alginate has a negative effect 

on the pH value, where the higher the concentration 

used, the lower the pH value of the resulting gel 

preparation, while the interaction of the two factors has 

a negative effect on adhesion. The relationship between 

the interactions of carbopol-940 and sodium alginate can 

also be illustrated by the interaction graph in Figure 3. 

The pH parameter has a line crossing on the interaction 

graph, indicating a strong interaction between carbopol-

940 and sodium alginate. These results can also be 

supported by the percent contribution from AB to a large 

pH of 73.297%. There is no line crossing when observed 

from the interaction graph on the parameters of viscosity 

and adhesion. However, the angle of inclination between 

the two lines is different, so interaction can occur even 

though it is small and is also supported by the percentage 

contribution of AB to the viscosity and adhesion of 

5.323% and 11.857%. 

The interaction between carbopol-940 and sodium 

alginate strongly influences the pH. The higher the 

interaction of the two factors, the higher the pH of the 

preparation. The increased concentration of carbopol-

940 will lead to the concentration use of triethanolamine 

as a base agent to help develop carbopol 940. In 

addition, sodium alginate has a pH range of 6-8. This 

statement is the reason why the pH value of the gel 

preparation will increase when carbopol-940 and 

sodium alginate are used in high concentrations. The 

viscosity factor strongly influences the viscosity factor, 

where the percent contribution reaches 64,699%. 

Sodium alginate has more effect on viscosity than 

carbopol-940 because the concentration of sodium 

alginate used is more remarkable than carbopol-940. 

In addition, carbopol-940 has a ,significant ability 

to absorb water so that the amount of free water 

contained in the gel also increases, causing the texture 

of the gel to get softer (Nurman et al., 2019). The 

viscosity of sodium alginate is affected by temperature, 

solution level, and degree of polymerization. The main 

property of sodium alginate is its ability to form gels in 

the presence of divalent cations (Cardenas et al., 2003). 

If a lot of Ca2+ ions are released into the gel-making 

process, more cross-links that can be formed between 

alginate molecules are obtained from the increasing 

concentration of CaCO3 (Remaggi et al., 2022). Sodium 

alginate also influences the adhesion parameter, namely 

87.351%. This result is related to the high viscosity of 

sodium alginate. The higher the viscosity, the higher the 

adhesive power of the preparation will be. Gel adhesion 

can affect the therapeutic effect. The longer the gel is 

attached to the skin, the more active substances will be 

absorbed by the skin so that the gel can provide a more 

prolonged therapeutic effect, and its use becomes more 

effective (Loyald et al., 2014). 

After analyzing the response, then proceed with 

determining the optimum formula. The optimum 

formula was determined using the Design Expert tool 

version 12. The optimum formula suggested by the 

system was a formula with a carbopol-940 concentration 

of 0.5% and a sodium alginate concentration of 5% with 

a desirability value of 0.997%. The results of 

confirmation of the characteristics of the optimum 

formula can be seen in Table 7. The optimum formula 

shows values between 95% PI low and 95% PI high. The 

optimum formula was further tested: stability test and 

burn healing activity test. The results of the stability test 

can be seen in Table 8. 

 

Table 7. The result of the optimum formula 

confirmation analysis 

Parameter 95% PI 

Low 

95% PI 

High 

Result 

pH 4.990 5.363 5.17±0.04 

Viscosity 

(cPs) 

1613.445 4031.895 2934.452±286.871 

Adhesion 

(sec) 

178.406 211.594 194.236±3.684 

 

Table 8. The result of optimum formula stability 

Parameter Observation result 

Before After 

Organoleptic Dark green, extract 

smell and thick 

Dark green, 

extract smell 

and thick 

pH 5.17±0.04 4.94±0.02 

Syneresis None None 

 

Based on Table 8, the optimum gel preparation 

formula did not experience organoleptic changes or 

syneresis, but there was a decrease in pH. The optimum 

formula in this study did not experience syneresis due to 
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the ability of the gelling agent combination between 

carbopol-940 and sodium alginate to maintain the bond 

strength of the gel matrix so that the solvent contained 

therein was not separated and came out onto the surface 

of the gel. The optimum formula experienced a decrease 

in pH of 0.23. The results of the paired-sample test 

analysis show that there is a significant difference where 

the significance value obtained is 0.02. A reduction in 

pH can occur due to the influence of speed and 

temperature, which causes the preparation to experience 

cation hydrolysis from TEA as a weak base to produce 

H+ ions (Lewis & Zhao, 2006). 

Testing the burn healing activity of Sambiloto 

extract gel preparation in this study was carried out 

experimentally on Wistar male white rats with 3 test 

groups: the positive, negative, and optimum formula 

groups. The positive group was given Binagel® gel, the 

negative group was given a gel base, and the optimum 

formula group was given the optimum sambiloto extract 

gel preparation. Binagel® was chosen as a positive 

control because the preparation contains binahong 

extract derived from natural ingredients. 

The primary goal of wound healing involves timely 

wound closure, prompt pain relief, and an aesthetically 

acceptable scar. The results of % Recovery can be seen 

in Table 9 and Figure 4. 

Based on the % recovery data, which can be seen in 

Table 9 and Figure 4, it can be seen that there was a 

significant increase in the positive group and the 

optimum formula from day 0 to 20. This result is 

inversely proportional to the negative group, which has 

a slower % recovery. The positive group had a healing 

percentage of up to 100% on day 20 and was not 

significantly different from the optimum formula based 

on post-hoc Duncan analysis. The percentage of wound 

healing on the fourth day in the positive, negative, and 

optimum formula groups was low. This result happened 

because, on day four, the wound healing process was 

still at the inflammatory stage. The inflammatory stage 

can be seen from the observation that there are signs of 

redness, inflammation occurs, it feels hot and painful, 

and it can even cause swelling in the wound. The 

inflammatory process allows white blood cells and 

platelets to limit more severe damage and accelerate 

wound healing (Gonzalez et al., 2016). Furthermore, a 

scab will form after the inflammatory process occurs. 

Observations on the formation and release of scabs can 

be seen in Table 10.

Table 9. Result of % recovery 

Group Average %Recovery of Each Group ± SD 

Day 

0 4 8 12 16 20 

Negative 0.00±0.00a -13.32±6.97b 11.53±5.42a 14.21±6.82b 33.33±9.35b 52.49±3.86b 

Positive 0.00±0.00a 10.10±5.86a 6.91±2.55a 50.92±14.52a 97.37±1.21a 100.00±0a 

Optimum Formula 0.00±0.00a 7.53±3.12a 7.71±2.69a 35.38±11.34ab 92.08±5.99a 99.72±0.48a 

Note: Values followed by lowercase letters (a/b) in the row indicate significant differences between groups in Duncan's 

post hoc test 

 

 

Figure 4. Graph of the percentage of burn healing for each group 

-20,000

0,000

20,000

40,000

60,000

80,000

100,000

120,000

0 4 8 12 16 20

 Positive  Optimum  Formula  Negative



Jurnal Farmasi dan Ilmu Kefarmasian Indonesia Vol. 10 No. 3 December 2023      308 

 

 
P-ISSN: 2406-9388   ©2023 Jurnal Farmasi dan Ilmu Kefarmasian Indonesia 

E-ISSN: 2580-8303  Open access article under the CC BY-NC-SA license 

Table 10. Scab observation results 

Group Average Day 

Scab Formation Scab Removal 

Negative 12 16 

Positive 8 12 

Optimum 

Formula 

8 12 

 

Based on the above observations, it can be seen that 

the positive group and the optimum formula showed 

faster scab formation on the 8th day and faster scab 

removal on the 12th day and were significantly different 

when compared to the negative group. The formation of 

a scab indicates the initial proliferation process in 

wound healing. The proliferative stage is marked by the 

formation of granulations in the wound, namely 

fibroblasts and inflammatory cells. This phase occurs 

from day 4 to day 14. The scab that forms on the wound's 

surface can help hemostasis and prevent wound 

contamination due to microorganisms. Scabs are formed 

due to the denaturation of the skin layer proteins in the 

coagulation zone (Markiewicz-Gospodarek et al., 

2022).  

On the 20th day, the percentage of wound healing 

in the positive group and the optimum formula reached 

100 ± 0.00% and 99.72 ± 0.48%. This result can happen 

because the wound has entered the remodelling phase. 

The remodelling phase occurs after the wound has been 

filled with granulation tissue and the re-epithelialization 

process is over. This phase aims to maximize the 

strength and structural integrity of new tissue, filling the 

wound, epithelial growth, and scar tissue formation 

(Velnar et al., 2009). The negative group on the 20th day 

had not entered the remodelling stage because the 

percentage of wound healing was still minor, namely 

52.49 ± 3.86%. 

The optimum formula of Sambiloto extract gel is 

proven to have wound-healing activity because it 

contains flavonoids, saponins, tannins, alkaloids, 

steroids, and triterpenoids, which help accelerate wound 

healing. Phytochemical compounds such as flavonoids 

have various biological activities such as antibacterial, 

anti-inflammatory, and antioxidant effects and are 

believed to benefit wound healing (Acar et al., 2002). 

Tannin compounds support wound healing with their 

astringent and antimicrobial properties. Saponins 

function as cleansers and antiseptics to prevent the 

growth of microorganisms in wounds so that the wound 

does not experience severe infection and stimulates the 

formation of collagen I, a protein that plays a role in 

wound healing (Dong, 2020). Triterpenoids can 

strengthen skin cells and improve repair, stimulate blood 

cells and the immune system, and can be natural 

antibiotics (Sutardi, 2016).  

Sambiloto extract has been widely studied to 

contain the main component, andrographolide, a 

triterpenoid group (Valdiani et al., 2012). In addition, 

Sambiloto extract also includes the most dominant 

flavonoid, quercetin (Fardiyah et al., 2020). 

Antioxidants from quercetin compounds can trigger 

collagen production and increase Vascular Endothelial 

Growth Factor (VEGF), which is anti-inflammatory and 

antibacterial. Based on research by Yang et al. (2020), 

quercetin compounds have an anti-inflammatory effect 

by inhibiting the cyclooxygenase (COX) enzyme, which 

induces the formation of prostaglandins as inflammatory 

mediators, while antibacterial activity inhibits bacterial 

growth through inhibition of bacterial hydrolytic 

enzymes. Andrographolide compounds have activity as 

anti-inflammatory and antioxidant (Lin et al., 2009). 

Andrographolide works as an anti-inflammatory agent 

by suppressing the production of the protein inducible 

nitric oxide synthase in RAW 264.7 cells (iNOS) (Chiou 

et al., 2000). The unsaturated α,β-lactone structure (α,β-

unsaturated lactone) part of the andrographolide 

molecular structure can neutralize the superoxide anion 

so that andrographolide acts as an antioxidant (Yan et 

al., 2018). 

 

CONCLUSION 

Carbopol-940 and sodium alginate concentrations 

influence the evaluation of gel preparations, namely pH, 

viscosity, and adhesion. The higher the carbopol-940 

and sodium alginate concentration will increase the 

viscosity and adhesiveness values, but lower the pH 

value. The optimum formula based on the optimization 

of the factorial design analysis on the evaluation 

response of the preparation was obtained at a 

concentration of 0.5% carbopol-940 and 5% sodium 

alginate with the average characteristics of pH, 

viscosity, and adhesion, respectively 5.17 ± 0.04; 

2934.452±286.871 cPs; and 194.236±3.684 s. The 

optimum formula shows values between 95% PI low 

and 95% PI high. The optimum gel preparation of 

Sambiloto extract has fairly good physical stability. The 

optimum gel preparation of Sambiloto extract was also 

shown to have a good effect on healing burns with 

a %recovery of 99.72%, on the 20th day, and based on 

the results of ANOVA, there was no significant 

difference to the positive control. 
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Abstract 

Background: Ciprofloxacin HCl is a broad-spectrum fluoroquinolone antibiotic that has the lowest MIC against 

Mycobacterium tuberculosis but has limitations in oral use, so inhalation microspheres are made. Objective: This 

study aimed to investigate the effect of CaCl2 crosslinker concentration on the characteristics, release and stability 

of ciprofloxacin-alginate-carrageenan microspheres. Methods: Microspheres were prepared by ionotropic 

gelation using aerosolization with calcium chloride 0.5M (F1), 1.0M (F2), 1.5M (F3), 2.0M (F4) as crosslinker 

and then dried using freeze dryer. Results: Ciprofloxacin-alginate-carrageenan microspheres formed of yellowish-

white powder, smooth morphology and excellent flow properties with the particle size of less than 5µm, drug 

loading and entrapment efficiency were between    2.05% - 2.42% and 75.34% - 98.09%, yield was between 84.69% 

- 97.57%, moisture content of less than 10%. Ciprofloxacin-alginate-carrageenan microspheres with 1.5M 

crosslinker (F3) was the optimal formula. For 12 hours, ciprofloxacin released was 49.89% - 63.78% at pH 7.4, 

and the kinetics of drug release showed that of Korsmeyer-peppas with a mechanism based on fickian diffusion. 

The microspheres were discovered to be stable for up to 28 days of storage. Conclusion: The increased 

concentration of the CaCl2 crosslinker from 0.5M to 2.0M decreased the particle size and drug release but 

increased the yield, drug loading and entrapment efficiency. 
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INTRODUCTION 

Ciprofloxacin HCl is a broad-spectrum 

fluoroquinolone antibiotic that inhibits the bacterial 

DNA replication enzymes DNA-gyrase and 

topoisomerase IV (Thai et al., 2022). Ciprofloxacin has 

the lowest minimum inhibitory concentration (MIC) 

against Mycobacterium tuberculosis, which ranges from 

0.125 to 2.0 µg/mL (Heifetst & Lindholm-levy, 1987). 

Ciprofloxacin for oral use has a short half-life of 3-5 

hours (Katzung et al., 2012). Around 70% of the 

Ciprofloxacin HCl is absorbed after oral administration. 

Ciprofloxacin is then metabolized in the liver by 15% 

and then excreted by 40-50% of the oral dose (Bayer 

Health Care Pharmaceuticals Inc, 2021). Thus, the 

delivery system needs to change the route or modify the 

release to increase the efficacy of ciprofloxacin. 

Inhalation delivery systems to target the lungs have 

advantages such as the ability to target alveolar 

macrophages containing TB bacilli, high drug 

concentrations in lung tissue maintained, avoidance 

first-pass metabolism, faster onset of action and smaller 

doses compared to intravenous and oral administration 

and ensure limited systemic side effects (Misra et al., 

2011). Inhalation delivery systems to target the lungs 

can be achieved by microencapsulation methods that can 

achieve targets and control drug release (Santa-maria et 

al., 2012). The dosage form with microspheres is needed 

for delivery of the lungs so that the drug design is 

encapsulated with microparticle technology (Lengyel et 

al., 2019). 

Microspheres have a small diameter of 1 µm to 

1000 µm with spherical particles consisting of drugs, 

proteins or synthetic polymers (Kadam & Suvarna, 

2015). For the inhalation route, the particle size ranges 

from 1 µm to 5 µm for lung deposition (Gaber et al., 

2021). One of the things that affect the effectiveness of 

microspheres as a drug delivery system is the selection 

of polymers and crosslinkers used as matrices and 

crosslinking of microspheres (Lee et al., 2012). The type 

of polymer used can be derived from nature or synthetic, 

but natural polymers have the advantages of being 

cheap, readily to use, biocompatible, biodegradable and 

able to do a multitude of chemical modifications 

(Rajeswari et al., 2017). A combination of alginate and 

carrageenan polymer was selected in this research 

because it is a natural polymer that is biodegradable, 

economical, widely used for encapsulation (Hariyadi et 

al., 2019) not accumulating in organs and not toxic in its 

administration (Hariyadi et al., 2019). Alginate is a 

naturally occurring polysaccharide polymer that is 

generally found in the cell walls of brown algae 

(Phaeophyceae) species (Lee & Mooney, 2012). 

Alginate provides the highest mucoadhesive ability 

compared to other polymers (Adrian et al., 2019). 

However, alginate has poor mechanical properties and a 

porous structure, which causes the microspheres to burst 

release, so it needs to be combined with carrageenan, 

which is capable of providing sustained release 

(Abdelghany et al., 2017). Carrageenans is a natural 

polysaccharide polymer found in the family 

Rhodophyceae of marine red algae, and kappa 

carrageenan is one of the carrageenan types which has 

many advantages (Tecante & Núñez, 2012).  

Crosslinkers in biodegradable polymers are very 

important in controlling the swelling and degradation 

rate of the microspheres. Ca2+ ions are most preferred 

for developing microparticles compared to Rb+, Cs+, K+, 

Na+, Li+, Ba2+, Sr2+, and Mg2+, because Ca2+ is the safest 

for the body (Tecante & Núñez, 2012). The use of CaCl2 

crosslinker in alginate and carrageenan polymers is used 

because sodium alginate has a high carboxyl group 

content and a high affinity for bivalent cations such as 

Ca2+ ions, whereas kappa carrageenan and Ca2+ form 

crosslinks due to electrostatic attraction forces. 

Concurrently, neighbouring Ca2+ and OSO3 generate a 

network of crosslinks between macromolecular 

networks (Yu et al., 2019). The combination of alginate 

and carrageenan polymer with a ratio of 1:1 with CaCl2 

crosslinkers has an increased swelling degree at neutral 

pH. It shows the most optimal encapsulation efficiency 

with a release degree of 92% so this ratio was chosen to 

provide a maximum therapeutic effect (Kolesnyk & 

Burban, 2015). The combination of alginate and 

carrageenan polymer as a microsphere matrix with a 

ratio (1:1) at a concentration of 0.9% and a 0.5M CaCl2 

crosslinker obtained optimum microsphere 

characteristics but still had low drug loading and 

encapsulation efficiency and an increase in polymer 

concentration above a concentration of 0.9% was 

thought to be cannot be stirred and forms a matrix of 

microspheres, so it is suggested to increase drug loading 

and encapsulation efficiency of these microspheres 

(Wijaksana, 2022). Microspheres produced with 

increased crosslinking concentrations resulted in small 

particle size, high entrapment efficiency, and drug 

loading (Hariyadi et al., 2014). 

Several methods can prepare microspheres utilising 

a combination of alginate and carrageenan polymer with 

calcium chloride crosslinker. This study used the 

ionotropic gelation method with aerosolization 

technique because this method produces microspheres 

chemically based on the ability of polyelectrolytes to 
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cross over the ion counter to form a gel (Hariyadi et al., 

2019). The advantages of this method that it is easy, fast, 

relatively inexpensive, does not use organic solvents, 

and uses low temperature, thereby reducing drug 

damage (Pasquale et al., 2021), and aerosolization 

techniques can produce small and uniform particle sizes 

(Hariyadi et al., 2018). In the process of making 

microspheres, drying is required, paying attention to the 

stability of the active pharmaceutical ingredients. 

Drying is carried out using the freeze-drying technique 

and needs to be added with lyoprotectant (Laura et al., 

2010). The lyoprotectant used in this study was 

maltodextrin (Hariyadi et al., 2016). This study will 

produce ciprofloxacin HCl-alginate-carrageenan 

microspheres with various concentrations of CaCl2 

crosslinker, which are made using ionotropic gelation 

technique by aerosolization method to investigate the 

effect of CaCl2 crosslinker concentration on the 

characteristics, release and stability of ciprofloxacin-

alginate-carrageenan microspheres. Physical 

characteristics include organoleptic, morphology, 

particle sizes, drug loading, entrapment efficiency, 

yield, moisture content and flow properties.  

 

MATERIALS AND METHODS 

Materials 

Ciprofloxacin HCl (Zhejiang Ltd., China), Sodium 

Alginate (Sigma Aldrich, USA), Kappa-Carrageenan 

(KCN, Pasuruan, Indonesia), CaCl2.2H2O (PT.Sumber 

Utama Kimia Murni, Indonesia), Maltodextrin 

(Bratachem Chemistry, Indonesia), Aquadestillata 

(PT.Sumber Utama Kimia Murni, Indonesia), Phosphate 

Buffered Saline Tablet (Oxoid, England). NaH2PO4 

(CV. CIMS, Indonesia), KH2PO4 (CV. CIMS, 

Indonesia), NaCl (CV. CIMS, Indonesia), KCl (CV. 

CIMS, Indonesia). All composition and reagent use 

pharmaceutical grade.  

Tools 

UV-Vis spectrophotometer (Shimadzu UV 1800 

spectrophotometer, Japan), FT-IR spectrophotometer 

(Perkin Elmer Instrument, USA), Differential Scanning 

Calorimeter/DSC (Mettler Toledo FT 900 Thermal 

System, USA), Analytical balance (Chyo Balance 

corporation Kyoto, Japan), Spray aerosol, Freeze dryer 

(Eyela FD-81, Japan), optical microscope (PS AIR FI 

31-032, China), stirring plate (Dragon Lab MSPro, 

China), centrifuge (Rotofix 32, Germany), Scanning 

Electronic Microscope (JEOL, Japan), Climatic 

chamber, Moisture analyzer (Mettler Toledo HB43-S, 

USA) and Thermoshakers (Gerhardt, Germany).  

Method 

Preparation of ciprofloxacin-alginate-carrageenan 

microspheres 

Microspheres were made by applying the ionotropic 

gelation method with aerosolization techniques, with a 

0.2% drug concentration. The drug was dissolved into a 

combination of alginate carrageenan polymer solution 

with a ratio of 1:1 (w/w) at a concentration of 0.9% of 

each polymer. The ciprofloxacin-alginate-carrageenan 

solution was sprayed into various CaCl2 cross-agent 

solutions with different concentrations, namely 0.5M, 

1.0M, 1.5M, 2.0M at 40 psi and stirred continuously for 

2 hours at a speed of 1000 rpm. The microsphere was 

collected by centrifugation at 2500 rpm for 6 minutes, 

followed by two washes with distilled water. The 

microspheres was resuspended in 5% maltodextrin 

solution and then dried with a freeze dryer at -80oC until 

the humidity met the requirements (Hariyadi et al., 

2022). Furthermore, ciprofloxacin-alginate-carrageenan 

microspheres that form were evaluated. The formula of 

microspheres can be seen in Table 1. 

FTIR spectroscopic analysis 

FTIR spectroscopy is a crucial analytical method 

that identifies several distinctive functional groups in 

molecules of any substance. FTIR spectra of all raw 

materials and microsphere formulations were obtained 

using an FT-IR (Perkin Elmer Instrument) 

spectrophotometer. The FTIR band spectra were 

examined to investigate the structural integrity in the 

different formulations after scanning at wavenumbers 

4000 - 500 cm−1. 

DSC analysis 

The thermal properties of all raw materials were 

determined using a DSC TGA (Mettler Toledo FP 900). 

Samples of about 5mg of all formulas were scanned 

(from 30°C to 250°C) at a heating rate of 10°C/min. The 

characteristic of the prominent DSC peak, which 

represents the endothermic peak shown by temperature, 

was determined. 

Table 1. Formula of ciprofloxacin-alginate-carrageenan microspheres 

Materials Functions F1 F2 F3 F4 

Ciprofloxacin HCl API 0.2% 0.2% 0.2% 0.2% 

Sodium alginate Polymer 0.9% 0.9% 0.9% 0.9% 

Kappa carrageenn Polymer 0.9% 0.9% 0.9% 0.9% 

Calcium chloride Crosslinker 0.5M 1.0M 1.5M 2.0M 

    *drying with freeze dry added with 5% maltodextrin
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Physical characterization of microspheres 

Organoleptics 

All formulas of ciprofloxacin-alginate-carrageenan 

microsphere were observed for their organoleptic 

appearance, including shape and colour. 

Morphology 

Morphology was evaluated using Scanning 

Electron Microscopy (SEM). The gold-coated samples 

were mounted for 120 seconds and were then examined 

with an SEM microscope (JEOL) at a working distance 

of 10 mm and 15mm, with 15 kV beam energy. 

Particle size 

Microspheres of 300 particles were determined 

using an optical microscope (PS AIR FI 31-032) and 

Image Raster Software. The average diameter was 

calculated using the equation: 

𝐷𝑖𝑎𝑚𝑒𝑡𝑒𝑟 𝑎𝑣𝑒𝑟𝑎𝑔𝑒 =
∑𝑛𝑑

∑𝑛
 

n = a number of microspheres observed 

d = size of the microspheres (Dhakar et al., 2010). 

Drug loading and entrapment efficiency 

50 mg of microsphere was added to Citrate Buffer, 

which has a pH of 4.4 and was stirred for 7 hours at 

1000rpm. The solution was filtered, and then a UV-Vis 

spectrophotometer was used to measure the absorbance 

of the solution at a wavelength of 275 nm (taken from 

in-house validation). The amount of the drug was 

determined using a validated in-house standard 

calibrated plot. The drug loading and entrapment 

efficiency was calculated using the equation (Balagani 

et al., 2011): 

𝐷𝑟𝑢𝑔 𝑙𝑜𝑎𝑑𝑖𝑛𝑔 =
𝑊𝑒𝑖𝑔ℎ𝑡 𝑜𝑓 𝑑𝑟𝑢𝑔

𝑊𝑒𝑖𝑔ℎ𝑡 𝑜𝑓 𝑚𝑖𝑐𝑟𝑜𝑠𝑝ℎ𝑒𝑟𝑒𝑠
 𝑥 100% 

𝐸𝐸 =
𝐷𝑟𝑢𝑔 𝑐𝑜𝑛𝑡𝑒𝑛𝑡 𝑖𝑛 𝑚𝑖𝑐𝑟𝑜𝑠𝑝ℎ𝑒𝑟𝑒𝑠

𝑇ℎ𝑒𝑜𝑟𝑖𝑡𝑖𝑐𝑎𝑙 𝑑𝑟𝑢𝑔 𝑐𝑜𝑛𝑡𝑒𝑛𝑡 𝑖𝑛 𝑓𝑜𝑟𝑚𝑢𝑙𝑎
𝑥100% 

Yield 

The yield was calculated according to the total 

recoverable final weight of microparticles to evaluate 

efficiency in producing microspheres. The yield was 

calculated using the equation (Balagani et al., 2011): 

𝑌𝑖𝑒𝑙𝑑 =
𝑊𝑒𝑖𝑔ℎ𝑡 𝑜𝑓 𝑑𝑟𝑦 𝑚𝑖𝑐𝑟𝑜𝑠𝑝ℎ𝑒𝑟𝑒𝑠

𝑇𝑜𝑡𝑎𝑙 𝑤𝑒𝑖𝑔ℎ𝑡 𝑚𝑎𝑡𝑒𝑟𝑖𝑎𝑙𝑠
 𝑥 100% 

Moisture content 

Moisture content was measured using the Moisture 

Analyzer (Mettler Toledo HB43-S). The microspheres 

are weighed with a minimum weight of 500 mg then 

distributed evenly in the pan and the sample is burned 

and the moisture content is measured in the range of 

100-140°C (Hariyadi et al., 2019). 

Flow properties 

A graduated cylinder of 10 mL was used to measure 

bulk and tapped densities. The sample was mechanically 

tapped 500 times after being put into a cylinder. The 

tapped volume was recorded, and the bulk density and 

tapped density were calculated (Lane 2016). 

Bulk density 

The ratio of powder weight bulk density compared 

to the initial volume of the untapped powder, as below 

equation (Lane 2016): 

𝜌 𝑏𝑢𝑙𝑘 =
𝑃𝑜𝑤𝑑𝑒𝑟 𝑤𝑒𝑖𝑔ℎ𝑡 (𝑔)

𝐼𝑛𝑖𝑡𝑖𝑎𝑙 𝑣𝑜𝑙𝑢𝑚𝑒 𝑜𝑓 𝑝𝑜𝑤𝑑𝑒𝑟 (𝑚𝑙)
 

Tapped density 

Tapped density was determined by the ratio of 

powder weight compared to final volume of the tapped 

powder as below equation (Lane 2016): 

𝜌 𝑡𝑎𝑝𝑝 =
𝑃𝑜𝑤𝑑𝑒𝑟 𝑤𝑒𝑖𝑔ℎ𝑡 (𝑔)

𝑉𝑜𝑙𝑢𝑚𝑒 𝑜𝑓 𝑝𝑜𝑤𝑑𝑒𝑟 𝑎𝑓𝑡𝑒𝑟 𝑡𝑎𝑝𝑝𝑖𝑛𝑔 (𝑚𝑙)
 

𝐶𝑎𝑟𝑟′𝑠 𝑖𝑛𝑑𝑒𝑥 =  
𝜌 𝑡𝑎𝑝𝑝𝑒𝑑 − 𝜌 𝑏𝑢𝑙𝑘

𝜌 𝑏𝑢𝑙𝑘
 𝑥 100% 

𝐻𝑎𝑢𝑠𝑛𝑒𝑟 𝑟𝑎𝑡𝑖𝑜 =  
𝑇𝑎𝑝𝑝𝑒𝑑 𝑑𝑒𝑛𝑠𝑖𝑡𝑦

𝐵𝑢𝑙𝑘 𝑑𝑒𝑛𝑠𝑖𝑡𝑦
 

Parameters of Carr’s index and Hausner's ratio are 

shown in Table 2. 

 

Table 2. Carr’s index and Hausner ratio of powder 

flow 

Flow character Carr’s index (%) Hausner ratio 

Excellent <10 1.00-1.11 

Good 11-15 1.12-1.18 

Fair 16-20 1.19-1.25 

Passable 21-25 1.26-1.34 

Poor 26-31 1.35-1.45 

Very poor 32-37 1.46-1.59 

Very, very poor >38 >1.60 

 

In vitro release study 

Ciprofloxacin release from the microspheres was 

tested in phosphate-buffered saline (PBS) at a pH level 

of 7.4 (Karimi et al., 2016). The released test was carried 

out using a Thermoshaker (Gerhardt) at 37ºC with 100 

rpm. 500 mg of microspheres were added to 100 mL 

PBS solution (pH 7.4) on a Thermoshaker at 37 ± 0.5°C 

and stirred at 100 rpm. A snippet of samples (5.0 mL) 

was taken at the minutes of 0, 15, 30, 60, 90, 120, 180, 

240, 360, 480, 600 and 720 minutes. In each snippet of 

samples, the same volume of release media was 

replaced, and the snippet of samples was filtered using 

millipore filter paper 0.45 µm. The sample absorbance 

was observed with a UV-Vis spectrophotometer 

(Shimadzu UV-1800) at the wavelength of 268 nm 

(Hariyadi et al., 2019). 

Drug release kinetics 

The drug release kinetics were investigated to 

describe the drug release pattern. The mechanism of 
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drug release from microspheres was examined using 

various kinetic equations, such as zero-order kinetic, 

first-order kinetic, Korsmeyer-peppas and Higuchi 

(Bruschi, 2015). The release kinetics of a drug can be 

determined from the price of R2 from the linear 

regression equation obtained from each formula. If R2 

approached one, it could be assumed that the kinetic 

followed the release of the regression equation from the 

corresponding kinetics model. 

Stability test 

Ciprofloxacin-alginate-carrageenan microspheres 

were tested for accelerated stability. The microspheres 

were placed into a vial and stored for 28 days at room 

25 ± 2˚C and 40 ± 2˚C, RH 75 ± 5%. The stability of the 

prepared formulations was tested by organoleptic 

property, moisture content and drug loading (Hariyadi 

& Hendradi, 2020). 

Data analysis 

All data are presented in mean ± SD. For physical 

characteristics and drug release, the statistical data was 

analyzed using one-way analysis of variance with a 

confidence degree of 95% (α = 0.05). For stability test, 

the statistical data was analyzed using two-way analysis 

of variance with a confidence degree of 95% (α = 0.05). 

 

RESULTS AND DISCUSSION 

Characterization of microspheres 

This study investigated the effect of CaCl2 

crosslinker concentration on the formation and physical 

characterization of ciprofloxacin microspheres using a 

combination of alginate and carrageenan polymers 

produced by ionotropic gelation methods using 

aerosolization techniques. Result of characterization by 

FTIR spectra and analysis of F1 to F4 were presented in 

Table 3. The functional groups of ciprofloxacin HCl, 

sodium alginate, kappa carrageenan, all microsphere 

formulas, and the possibility of wavenumber presence 

or shifting were investigated.. Referring to the 

ciprofloxacin, the wavenumber of the characteristic 

peak of quinolone N-H bending, OH stretching, C=O 

stretching, C-H stretching and C-F stretching was 

present in all formulas of microspheres indicated the 

stability of ciprofloxacin in the microspheres. For 

formulations F1 to F4, the shift of the wavenumber of 

quinolone N-H band of ciprofloxacin HCl was from 

1612.62 cm-1 to between 1602.23 cm-1 and 1661.17 cm-

1; the OH group from 3516.74 cm-1 to between 3529.87 

cm-1 and 3558.08 cm-1; the CH group from 2914.76 cm-

1 to between 2915.03 cm-1 and 2937.59 cm-1; the C=O 

group from 1699.31 cm-1 to between 1724.68 cm-1 to 

1731.16 cm-1; the C-F group from 1043.55 cm-1 to 

between 1005.25 cm-1 and 1013.94 cm-1. The wave shift 

in sodium alginate occurred in the C-C group from 

1080.87 cm-1 to between 1075.11 cm-1 and             

1113.43 cm-1; the guluronic group from 884.91 cm-1 to 

between 925.44 cm-1 and 930.61 cm-1; the mannuronic 

group from 810.48 cm-1 to between 844.94 cm-1 and 

849.63 cm-1. The wave shift in kappa-carrageenan 

occurred in the S=O from 1223.52 cm-1 to between 

1224.16 cm-1 and 1247.41 cm-1; the galactose sulfat 

from 841.94 cm-1 to between 844.96 cm-1 and 849.63 

cm-1 and the loss of the C-O-C group. These indicated 

that there were chemical interactions between the 

combination of alginate-carrageenan polymer and 

CaCl2 crosslinker to form microspheres. Chemical 

interactions between groups that occurs predict that the 

alginate polymer has carboxyl groups on two opposite G 

blockchains. In contrast, the kappa carrageenan polymer 

has a sulphate group in its structure (Yu et al. 2019). The 

combination of alginate-carrageenan polymer with the 

CaCl2 crosslinker causes the interaction of the carboxyl 

guluronic group from the alginate polymer and the 

sulphate group from carrageenan polymer to bind to 

Ca2+ ions to form a network or matrix to entrapped the 

drug (Wathoniyyah 2016). 

Table 3. FTIR of all microspheres formula 

Functional 

group 

Wave Number (cm-1) 

Ciprofloxacin 

HCL 

Sodium 

Alginate 

Kappa 

carrageenan 
F1 F2 F3 F4 

OH stretch 3516.74 3310.90 3352.32 3532.21 3556.43 3558.08 3529.87 

CH stretch 2914.76 2895.76 2892.99 2923.13 2918.83 2915.03 2937.59 

C=O stretch 1699.31 1592.77  1729.30 1724.68 1731.16 1728.55 

Quinolone N-H bending 1612.62   1604.16 1661.17 1602.23 1602.90 

OH bending 1263.03   1245.69 1247.41 1224.16 1239.42 

C-F stretch 1043.55   1013.94 1011.97 1005.25 1011.50 

C-C stretch  1080.87  1076.84 1075.92 1113.43 1075.11 

Guluronic finger  884.91  926.71 925.44 926.29 930.61 

Mannuronic finger  810.48  847.20 849.63 848.99 844.96 

S=O   1223.52 1245.69 1247.41 1224.16 1239.42 

Galactose sulphate   841.94 847.20 849.63 848.99 844.96 
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DSC result of all materials showed that the 

endothermic peak of ciprofloxacin HCL at 153.3oC, 

sodium alginate endothermic peak at 127.8oC, kappa-

carrageenan showed a prominent characteristic 

endothermic peak at 124.8oC, calcium chloride 

dihydrate endothermic peak at 175.6 oC and 

maltodextrin endothermic peak at 139.4oC. All of these 

DSC peaks indicate the raw material is up to standard.  

Organoleptics of microspheres 

The organoleptic results of ciprofloxacin-alginate-

carrageenan microspheres made by ionic gelation 

method with aerosolization technique and then dried by 

freeze drying showed that all microspheres formulas F1 

to F4 were in the form of yellowish-white powder and 

did not agglomerate.  

Morphology of microspheres 

The morphology of the ciprofloxacin-alginate-

carrageenan microspheres using SEM can be seen in 

Figure 1 and Figure 2. All the microsphere formulas F1 

to F4 are spherical with smooth surfaces. The 

microspheres have a smooth texture because the 

viscosity of the polymer is sufficient to form cross-links 

with the crosslinker (Hariyadi et al., 2019).  

Physical characteristics of microspheres 

Physical characteristics of ciprofloxacin-alginate-

carrageenan microspheres can be seen in Table 4. 

Particle size 

The result showed that ciprofloxacin-alginate-

carrageenan microspheres resulted in particle size 

between 2.17 ± 0.03 µm and 2.50 ± 0.03 µm (Table 4). 

The results of the particle size of all formulas are less 

than 5 µm suitable for the inhalation route so that 

microspheres can be deposited in the alveoli (Gaber et 

al., 2021). If the particle size of the microsphere is and 

more significant than 5 µm, the particles will only reach 

the oropharynx, whereas if it is less than 1 µm, the 

particles will be expelled with the expired air (Ashish et 

al., 2012). Based on statistical analysis (p<0.05), the 

increase of CaCl2 crosslinker concentration from 0.5M 

to 2.0M reduced the particle size of the microspheres 

(Hariyadi et al., 2018). According to some reports, 

gelation occurs immediately when a drop of polymer 

solution comes into contact with calcium ions. When 

Ca2+ ions penetrate to the inside of the polymer solution 

droplets, water is forced out of the droplets, which 

causes the microspheres to contract and resulting in 

smaller particle sizes being formed until saturation 

occurs so that the particle size does not shrink again 

(Manjanna et al., 2010; Ra et al., 2014). and a PDI of 

0.0033, which was <0.30. This indicates a narrow size 

distribution, and the particle size of the microspheres is 

homogeneously dispersed (Li et al., 2014). 

 

 
F1 (CaCl2 0.5M) 

 
F2 (CaCl2 1.0M) 

 
F3 (CaCl2 1.5M) 

 
F4 (CaCl2 2.0M) 

Figure 1. Morphological examination of ciprofloxacin-alginate-carrageenan microspheres formula using SEM 

at 10000x magnification 
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F1 (CaCl2 0.5M) 

 
F2 (CaCl2 1.0M) 

F3 (CaCl2 1.5M) F4 (CaCl2 2.0M) 

Figure 2. Morphological examination of ciprofloxacin-alginate-carrageenan microspheres formula using SEM 

at 15000x magnification 

 

Table 4. Physical characteristics of ciprofloxacin-alginate-carrageenan microspheres 

Formula 
Particle size 

(µm) 

Drug 

loading 

(%) 

Efficiency 

entrapment 

(%) 

Yield (%) 

Moisture 

content 

(%) 

Carr’s index 

(%) 

Hausner 

ratio 

F1 2.50 ± 0.03 2.05 ± 0.02 75.34 ± 1.46 84.69 ± 0.88 2.59 ± 0.36 5.27 ± 1.11 1.05 ± 0.01 

F2 2.29 ± 0.03 2.32 ± 0.01 86.61 ± 2.52 87.07 ± 1.85 2.75 ± 0.75 6.76 ± 0.66 1.07 ± 0.01 

F3 2.21 ± 0.02 2.42 ± 0.02 98.09 ± 0.67 93.71 ± 1.09 2.84 ± 0.69 10.32 ± 1.87 1.10 ± 0.02 

F4 2.17 ± 0.03 2.37 ± 0.07 96.81 ± 2.19 97.57 ± 0.50 3.16 ± 0.65 14.52 ± 1.53 1.15 ± 0.02 

Drug loading and entrapment efficiency 

For drug loading and entrapment efficiency, the 

results are consistent by showing the same pattern of 

increasing the crosslinker concentration of CaCl2 from 

0.5M to 1.5M increased ciprofloxacin-alginate-

carrageenan microsphere drug loading and entrapment 

efficiency (Table 4). Based on statistical analysis, a 

significant difference was found between the effect of 

crosslinker concentration on increasing drug loading 

and entrapment efficiency (p<0.05). Drug loading 

increased from 2.05% ± 0.02 to 2.42% ± 0.02 and a 

similar result of entrapment efficiency was also found to 

increase from 75.34% ± 1.46 to 98.09% ± 0.67. The 

highest drug loading and entrapment efficiency was 

found in the microsphere formulation with a CaCl2 

crosslinker concentration of 1.5M and decreased at a 

concentration of 2.0M, but the decrease was not 

significant (p>0.05). The increase in drug loading and 

encapsulation efficiency of ciprofloxacin-alginate-

carrageenan microspheres occurs because the higher 

crosslinker concentration causes more availability of 

Ca2+ ions, which crosslinked with carboxyl guluronic 

groups from alginate and sulphate groups from 

carrageenan and forms a network or matrix so that drug 

loading and entrapment efficiency becomes higher until 

there is a saturation of the crosslinker and polymer 

bonds so that drug loading and encapsulation efficiency 

do not increase anymore (Hariyadi et al., 2014).  

Yield 

The yield of ciprofloxacin-alginate-carrageenan 

microspheres is seen in Table 4. Yield value showed the 

smallest value that was for F1 (CaCl2 0.5M) at 84.69% 

± 0.88, and the highest was F4 (CaCl2 2.0M) at 97.57% 

± 0.50. These results indicated that the ionotropic 

gelation method with aerosolization techniques was a 

potential method for producing ciprofloxacin-alginate-
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carrageenan microspheres (Hariyadi et al., 2022). Based 

on statistical analysis (p<0.05), this means that  there is 

a significant difference. The increase of CaCl2 

crosslinker concentration from 0.5M to 2.0M increased 

the yield of the microspheres. The high yield value at 

greater crosslinker concentrations may be due to all the 

available polymer gelating with the crosslinker (Gedam 

et al., 2018). 

Moisture content 

The examination of moisture content was done to 

determine moisture content in the microspheres after the 

drying process. The moisture content of ciprofloxacin-

alginate-carrageenan microspheres showed at about 

2.59% ± 0.36 to 3.16% ± 0.65 (Table 4). The moisture 

content is less than 5%, so it is preferred for better 

aerosol performance (Saha et al., 2022). Microsphere 

particles with high moisture content can cause 

degradation of the microspheres and reduce their 

stability (Varela et al., 2022; Shan et al., 2016). The 

statistical analysis found no significant difference 

between the increase in CaCl2 crosslinker concentration 

and the resultant moisture content (p>0.05).  

Flow properties 

Carr's index and Hausner ratio measurements were 

used to determine the flow properties of ciprofloxacin-

alginate-carrageenan microspheres. Carr’s index ranged 

from 5.27% ± 1.11 to 14.52% ± 1.53, and the hausner 

ratio from 1.05 ± 0.01 to 1.15 ± 0.02 (Table 4). 

According to the values of Carr's index and the Hausner 

ratio, F1, F2, and F3 have excellent flow properties, 

while F4 has good flow properties so that it is 

microspheres are suitable for inhalation routes targeting 

the lungs. Based on statistical analysis (p<0.05), this 

means that there is a significant difference. The increase 

of CaCl2 crosslinker concentration from 0.5M to 2.0M 

increased Carr's index and Hausner's ratio of 

ciprofloxacin-alginate-carrageenan microspheres. The 

increase in the Carr's index and Hausner ratio occurs 

because the higher concentration of CaCl2 crosslinker in 

the microspheres will affect the compaction of the 

microspheres, which results in cohesive-adhesive forces 

of the particles so that agglomeration tends to occur and 

causes a significant decrease in volume which is 

observed with an increase in the density of microsphere 

particles (Lane, 2016). 

In vitro release study 

Ciprofloxacin HCl was released from microspheres 

in all formulas for 12 hours in phosphate buffer media 

at pH 7.4 ± 0.05 can be seen in Figure 3. For 12 hours, 

the cumulative percentage of ciprofloxacin HCl released 

from microspheres F1 (63.78 % ± 1.67), F2 (56.86 % ± 

2.39), F3 (50.29 % ± 1.74) and F4 (49.89 % ± 0.85). 

Increasing the concentration of the CaCl2 crosslinker 

from 0.5M to 2.0M causes a decrease in the release of 

ciprofloxacin-alginate-carrageenan microspheres. A 

significant reduction in release (p<0.05) occurred; 

however, at an increase in the concentration of CaCl2 

from 1.5M to 2.0M, there was a decrease in the release 

rate, although there was no significant difference 

including (p>0.05). The observed reduction in drug 

release with increased calcium chloride is related to the 

formation of tight junctions between uronic acid 

residues from alginate and sulphate from carrageenan 

with calcium ions (Wathoniyyah 2016). The greater the 

concentration of the CaCl2 crosslinker in the 

microspheres, the greater the strength of the ionic bonds 

and cross-links so that the network or bonds that are 

formed are more stable, stiff and compact and cause the 

degree of swelling and sensitivity of the matrix to 

decrease. It causes a decrease in drug release (Berger et 

al., 2004; Ra et al., 2014). According to some reports, 

drug release is also correlated with microsphere 

characteristics such as particle size and entrapment 

efficiency (Freiberg & Zhu, 2004; Lin et al., 2018). The 

smaller particle size of the microspheres indicates that 

the microspheres are rigid and have low matrix porosity 

so that drug release is slower compared to larger 

microsphere particle size (Lin et al., 2018), and drugs 

encapsulated in a matrix provide the opportunity for a 

slower release effect so that low of entrapment 

efficiency caused a faster of drug release (Freiberg & 

Zhu, 2004; Jerome et al., 2020).  

Drug release kinetics 

Release kinetics model showed that kinetics follows 

the korsmeyer-peppas kinetic model with the highest R2 

value and close to 1 for each formula              F1 = 

0.9942, F2 = 0.9962, F3 = 0.9902, F4 = 0.9915 (Table 

5). The release exponent (n) of all formulations showed 

that it was n<0.43, and then the drug release was based 

on fickian diffusion, which describes the drug controlled 

by diffusion mechanism (Bruschi, 2015). In diffusion-

controlled systems, the polymeric chains, either by 

inherent semipermeability or by swelling form pores 

into which the drug can diffuse and be released into the 

media (Jerome et al., 2020). 
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Figure 3. Release profile of ciprofloxacin HCl-alginate-carrageenan microspheres from all formulas 

 

Table 5. Release kinetics with release exponent (n) of ciprofloxacin-alginate-carrageenan microspheres 

Formula Zero order First order Higuchi Korsmeyer-Peppas 

F1 R2 = 0.7084 R2 = 0.8469 R2 = 0.8923 R2 = 0.9942 n = 0.2272 

F2 R2 = 0.6714 R2 = 0.7930 R2 = 0.8699 R2 = 0.9962 n = 0.2184 

F3 R2 = 0.6941 R2 = 0.7950 R2 = 0.8835 R2 = 0.9902 n = 0.2215 

F4 R2 = 0.7103 R2 = 0.8096 R2 = 0.8928 R2 = 0.9915 n = 0.2254 

 

Table 6. Moisture content and drug loading in stability test at 0 days and 28 days 

Sample Day Moisture content (%) Drug loading (%) 

25oC 40oC 25oC 40oC 

F1 0 2.59 ± 0.36 2.59 ± 0.36 2.05±0.02 2.05±0.02 

 28 2.95 ± 0.36 3.00 ± 0.21 2.03±0.07 2.02±0.04 

F2 0 2.75 ± 0.75 2.75 ± 0.75 2.32±0.01 2.32±0.01 

 28 2.83 ± 0.65 2.84 ± 0.58 2.29±0.15 2.28±0.06 

F3 0 2.84 ± 0.69 2.84 ± 0.69 2.42±0.02 2.42±0.02 

 28 3.05 ± 0.70 2.99 ± 0.63 2.39±0.14 2.38±0.05 

F4 0 3.16 ± 0.65 3.16 ± 0.65 2.38±0.07 2.38±0.07 

 28 3.42 ± 0.59 3.44 ± 0.66 2.34±0.08 2.33±0.16 

 

Stability test 

Results of stability testing after 28 days of storage 

at 25oC and 40oC can be seen in Table 6. Organoleptic 

observation of all formulas of ciprofloxacin-alginate-

carrageenan microspheres did not show any changes; the 

colour was still yellowish-white and did not 

agglomerate. In terms of moisture content and drug 

loading at 25oC and 40oC compared from 0-day to 28 

days of storage, it was found that there was no 

significant difference between the effects of temperature 

and time on increasing moisture content and decreasing 

drug loading (p>0.05), which indicated that the 

ciprofloxacin-alginate-carrageenan microspheres 

remained stable (Kalalo et al., 2022). To determine the 

possibility of microsphere instability, more time and 

high temperature are required to see a substantial 

difference in the physical stability of ciprofloxacin-

alginate-carrageenan microspheres. 

 

CONCLUSION 

Ciprofloxacin-alginate-carrageenan microspheres 

were successfully formed using the ionotropic gelation 

with aerosolization technique. Yellowish-white 

microspheres with small particle size and smooth 

morphology were obtained from the system. Increasing 

the concentration of the CaCl2 crosslinker from 0.5M to 

2.0M decreased the particle size, drug release and 

increased the drug loading, entrapment efficiency and 

yield. The microspheres containing 1.5M CaCl2 

crosslinker had the maximum drug loading and 

entrapment efficiency with excellent flow properties and 

were stable for 28 days. 
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Abstract 

Background: Patient satisfaction stands as a metric for evaluating the quality of pharmaceutical services. The 

presence of community requests for high-quality pharmaceutical services has driven pharmacy personnel to 

enhance these services, aiming to establish patient satisfaction. Objective: The objective of this research is to 

assess the degree of patient satisfaction with pharmaceutical services in the outpatient pharmacy and to explore 

how this satisfaction is linked to the patients’ sociodemographics. Methods: Conducted at Padang Panjang 

Hospital's Outpatient Pharmacy in West Sumatra, Indonesia, this descriptive research employed a questionnaire 

administered directly to patients. The method used involves a questionnaire consisting of 20 questions divided into 

two dimensions: Friendly Explanation (containing 11 questions) and Managing Therapy (containing nine 

questions). The questionnaire's validity (r > 0.632) and reliability (0.97). Data analysis was performed utilizing 

the Likert scale. Results: There were a total of respondents in this study (365 patients). Most of them (64.4%) were 

female, in the pre-elderly age group (45.2%), had completed high school (41.1%), and were housewives (31.8%). 

In general, the level of patient satisfaction is categorized as satisfied, with an average score of 3.49. Specifically, 

the "Friendly Explanation" got a score of 3.69, and the "Management of Therapy" got a score of 3.25. The study 

indicated notable statistical disparities in patient satisfaction levels based on age, education, and occupation 

(p<0.05), but gender did not have a significant impact (p>0.05). Conclusion: In summation, the study found that 

patients were satisfied with the pharmaceutical services at Padang Panjang Hospital's Outpatient Pharmacy. 

 

Keywords: friendly explanation, managing therapy, outpatient pharmacy, patient satisfaction, pharmaceutical 

services 
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INTRODUCTION 

Health efforts are integrated and sustainable 

activities to enhance community health through 

prevention, health promotion, curative and disease 

rehabilitation (Ministry of Health Republic of 

Indonesia, 2018). Pharmaceutical services not only 

include trading and preparation of drugs but also 

providing information about them. In addition, it ensures 

medication safety, rational medication, and improved 

quality of life (Bratkowska et al., 2020). Patient 

satisfaction reflects pharmaceutical services in the 

interaction of medical services with patients and the 

health care system. Promptness in pharmaceutical 

service delivery coupled with effective communication 

between pharmacy personnel and patients increases 

patient satisfaction with pharmaceutical services 

(Ostrowska et al., 2022). Evaluating patient satisfaction 

is a complex and multi-dimensional challenge. Various 

aspects can affect its value. However, some key points 

were highlighted, such as the availability of prescribed 

drugs, service delays, and drug counselling services 

(Nigussie & Edessa, 2018).  

The Indonesian government still has many 

weaknesses in public services. This is proven by the 

existence of public complaints through online media or 

by reading letters about service procedures, service 

facilities, and infrastructure (Fadila et al., 2022). Most 

hospitals in Indonesia have not carried out the expected 

pharmaceutical service activities (Larasanty et al., 

2019). This is caused by several constraints, such as the 

capacity of pharmacists, the limited capacity of hospital 

management to the hospital pharmacy function, hospital 

management policies, and little knowledge of 

pharmacists in hospitals (Fadila et al., 2022). Because of 

circumstances like this, hospital pharmacy services are 

limited to a single commodity, namely the provision and 

distribution of pharmaceuticals. 

The Padang Panjang Hospital is a referral hospital 

that provides public services. Based on data on patient 

visits to the outpatient Pharmacy at Padang Panjang 

Hospital, there has been an increase in visits from 2020, 

as many as 43,083 to 2021, which is 48,568. The quality 

of pharmaceutical services at the hospital may be 

affected as the number of patients looking for medical 

treatment rises. A surge in daily prescription numbers 

will result in a greater need for prompt and precise 

services. Patients are impatient and decide to take 

medicine the next day. This becomes a problem because 

the prescriptions on the following day will accumulate 

and affect the quality of service at that time. Hospitals 

that collaborate with BPJS sometimes have issues with 

the BPJS service network. The high number of 

prescriptions served by pharmacies results in decreased 

prescription service speed and will lead to demands or 

criticism from patients who redeem drugs. This is one of 

the indicators of pharmaceutical services that can be 

measured by satisfaction. 

Numerous studies have been conducted to assess 

the extent of patient satisfaction concerning 

pharmaceutical services within hospital settings. Certain 

patients express dissatisfaction with the pharmaceutical 

services rendered in hospitals, attributing this to a 

deficiency in the knowledge of pharmacy personnel. As 

per the viewpoints expressed by respondents, 

inadequate availability of prescribed medications in 

pharmacies is also a contributing factor (Nigussie & 

Edessa, 2018). However, some patients are satisfied 

because the pharmacist explains the information on drug 

use in an easy-to-understand manner (Bratkowska et al., 

2020). There are differences in the level of satisfaction. 

This research has never been done at the Padang Panjang 

Hospital. The primary goal of this study is to evaluate 

the levels of patient satisfaction regarding 

pharmaceutical services provided at the Outpatient 

Pharmacy within Padang Panjang Hospital. This 

assessment aims to provide insights into the calibre of 

healthcare services experienced by patients. 

 

MATERIALS AND METHODS 

Study design 

This study employs an observational descriptive 

design utilizing a cross-sectional methodology through 

a prospective questionnaire-based survey. The criteria 

for inclusion encompassed individuals aged 18 years or 

older who acquired medications from an outpatient 

pharmacy, those who had undergone multiple 

treatments at the polyclinic and subsequently obtained 

medications from the outpatient pharmacy, and 

individuals who demonstrated their willingness to 

participate by completing an informed consent form. 

This study was not conducted on patients who did not 

redeem the drug on the same day as the treatment 

schedule. 

Instrument 

The instrument development was based on the 

instrument previously developed by Larson et al. 

(2002). Subsequently, Dedy Almasdy conducted the 

instrument development process, starting with the 

translation of the instrument into the Indonesian 

language. This was followed by the assessment of 

agreement levels among experts (ĸ = 0.53), validity 

testing (r > 0,632), and reliability testing (Cronbach 
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alpha = 0.97) (Almasdy & Deria, 2015). This 

questionnaire consists of 20 questions divided into two 

dimensions: Friendly Explanation (containing 11 

questions) and Managing Therapy (containing nine 

questions). The Friendly Explanation dimension 

includes questions about service friendliness, the 

professionalism of pharmacy staff, timeliness of service, 

and how well pharmacists respond to patient questions. 

Meanwhile, the Managing Therapy dimension includes 

questions about the pharmacist's efforts to ensure proper 

medication functioning, improve patient health, and 

address medication-related issues. 

Data analysis 

Because of circumstances like this, hospital 

pharmacy services are limited to a single commodity, 

namely the provision and distribution of 

pharmaceuticals. (Table 1). 

 

Table 1. Interpretation of satisfaction level values 

(Larson et al., 2002) 

No Range Value 

1 1 - 1,8 Dissatisfied 

2 >1,8 - 2,6 Less satisfied 

3 >2,6 - 3,4 Quite satisfied 

4 >3,4 - 4,2 Satisfied  

5 >4,2 – 5 Very satisfied 

The Spearman test approach was employed to 

establish the correlation between patient characteristics 

and patient satisfaction, age and education factors. 

Meanwhile, in the case of the gender variable, the Mann-

Whitney test was employed to ascertain the connection 

between patient characteristics and patient satisfaction. 

Furthermore, the Kruskal Wallis test, facilitated through 

the SPSS tool, was utilized to discern the relationship 

between patient characteristics and patient satisfaction, 

particularly concerning the work variable. 

Ethical approval 

Ethical clearance for this research was granted by 

the Research Ethics Committee of the Faculty of 

Medicine, Universitas Andalas, Indonesia (Approval 

No. 692/UN.16.2/KEP-FK/2022). The participants were 

requested to complete informed consent forms to 

demonstrate their voluntary participation. 

 

RESULTS AND DISCUSSION 

A collective of 365 patients was included in the 

study, and the predominant characteristics of 

respondents, as delineated in Table 2, encompassed 

being female (64.4%), belonging to the pre-elderly age 

group (45.2%), having attained a high school education 

(41.1%), and being housewives (31.8%). 

Our research marks the inaugural attempt to assess 

the degree of patient satisfaction with pharmaceutical 

services within Padang Panjang Hospital's outpatient 

pharmacy. This evaluation is seen from 2 dimensions: 

the Friendly Explanation and the Managing Therapy 

dimension. The study used a questionnaire consisting of 

2 dimensions: questions 1 to 11 (the friendly explanation 

dimension) and questions 12 to 20 (the managing 

therapy dimension) (Table 3). 

 

 

Table 2. Sociodemographic characteristics of patients (n = 365) 

Demographic characteristics Frequency Percentage 

Gender   

Male 130 35.9 

Female 235 64.4 

Age (years)   

Adult (18-44) 94 25.8 

Pre-elderly (45-59) 165 45.2 

Elderly ( 60) 106 29.0 

Last education   

Primary school 57 15.6 

Junior high school 82 22.5 

Senior high school 150 41.1 

Diploma 22 6.0 

Bachelor 54 14.8 

Profession   

Student  18 4.9 

Public/Private Servants 55 15.1 

Self-employed 73 20.0 

Retired 38 10.4 

Housewives 116 31.8 

Other  65 17.8 
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In the Friendly Explanation dimension, the highest 

percentage of dissatisfied patients was on the question 

item on the speed of the pharmacy serving prescriptions. 

This is due to the high level of pharmacy service, which 

causes the long waiting time. In addition, to redeem 

BPJS patients' drugs, they must first enter their data into 

the BPJS service application. However, pharmacies 

have problems with the complex BPJS service network, 

so pharmacists need to do it manually by looking at the 

history of previous patients, especially if there are many 

patient visits on that day so that the speed of prescription 

service decreases. A similar incident can be seen in the 

study of Mohamed (2022); he stated that the reported 

average dispensing time (ADT) is longer than in other 

studies. This may be because pharmacists spend a long 

time explaining to patients insured and uninsured drugs 

in prescription according to the applicable BPJS (Osman 

et al., 2022). This is identical to the results of the Lee et 

al. study (Lee et al., 2015). 

Conversely, the dimension of "friendly 

explanation" witnessed the most substantial percentage 

of respondents expressing a state of very satisfaction, 

specifically in relation to the query about the clarity of 

information provided by the pharmacist concerning the 

medication received and its usage. Patients are satisfied 

because when the drug is received, the pharmacist 

always tells them the name of the drug and its use. 

Patients conveyed satisfaction with the practice of 

pharmacists promptly informing them about the 

medication's identity and purpose upon dispensing. 

Coinciding with these findings, a study conducted in 

Ethiopia demonstrated comparable patient satisfaction 

levels concerning critical medication guidelines, 

including administration instructions (83.2%), 

recommended timing (76.4%), and label 

comprehensibility (67.6%). At the same time, in line a 

study in Ethiopia showed the highest patient satisfaction 

level towards some of the vital medication instructions 

such as the administration instructions (83.2%), the 

advising time (76.4%) and the label clarity (67.6%) 

(Semegn & Alemkere, 2019). 

Within the context of the therapy management 

aspect, the highest percentage of dissatisfied patients is 

the question item on the consultation time questionnaire 

provided by the pharmacist for the patient. The Padang 

Panjang Hospital pharmacy has a counselling room. 

However, in recent years, counselling activities have not 

been carried out. This is due to the COVID-19 

pandemic, so counselling activities are limited and 

rarely carried out. Most patients said they were 

dissatisfied because they had never done counselling at 

the pharmacy. This unsatisfactory occurrence finds 

support in a study undertaken by Larasanty et al. (2019), 

where it was unveiled that patients expressed a desire for 

pharmacists to allocate more time to addressing their 

medical inquiries and furnishing supplementary details 

about their prescribed medications (Larasanty et al., 

2019). 

Meanwhile, the very satisfying level in the 

Managing therapy dimension is the question of the 

pharmacist's information about how many times and 

how long the drug should be taken. Patients expressed 

satisfaction with the information delivered by the 

pharmacist during the medication dispensing process. 

When discharged, successful patient counselling and 

proper drug education will improve patient adherence 

and treatment satisfaction, improving their clinical 

outcomes (Sanii et al., 2016). 

Table 4 shows the patient satisfaction levels in 

pharmaceutical services. In general, patient satisfaction 

with pharmaceutical services in the "friendly 

explanation" aspect was rated as content, attaining an 

average score of 3.69. On the other hand, the "managing 

therapy" dimension exhibited a reasonably satisfactory 

level, achieving an average score of 3.25. Furthermore, 

our results showed a statistically significant difference 

in age, education, and profession toward patient 

satisfaction level, but not gender (Table 5). 

In this research, the overall patient satisfaction 

score averaged 3.49, falling within the satisfied range 

(between 3.4 and 4.2). This finding mirrors outcomes 

from a study in Sudan (with a mean satisfaction score of 

approximately 3.11) and surpasses the results from a 

2018 study in Pakistan (about 2.78) (Aziz et al., 2018; 

Osman et al., 2022). Analyzing the responses provided 

by patients in the questionnaire, it is evident that a 

connection exists between the highest satisfaction levels 

within two dimensions. Specifically, patients expressed 

satisfaction with the pharmaceutical services concerning 

information about prescribed medications and their 

usage. Furthermore, patients also indicated satisfaction 

with detailed guidance regarding the timing, duration, 

and method of medication administration. 

 

Table 3. Patient satisfaction level 

 Average Interpretation 

Overall 3.49 Satisfied 

Friendly 

explanation 

dimension 

3.69 Satisfied 

Managing therapy 

dimension 

3.25 Quite satisfied 
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Table 4. Patient satisfaction level in pharmaceutical services 

No Questionnaire Items 
Patient satisfaction level (%) 

1 2 3 4 5 

1 
The appearance of the pharmacy is attractive and follows its 

function 
0.00 3.29 17.53 57.26 21.92 

2 Pharmacists' answers to your questions 1.92 4.93 27.95 50.41 14.79 

3 Smooth communication between you and the pharmacist 0.27 8.49 31.78 49.59 9.86 

4 
The pharmacist's ability to explain problems related to your 

medicine 
0.00 5.75 28.22 52.88 13.42 

5 Speed Pharmacies serve your recipe 5.21 33.70 25.75 28.49 6.85 

6 The ability of pharmacists to provide services 0.00 4.66 33.15 48.22 13.97 

7 
Clarity of information the pharmacist provides regarding 

the drugs you receive and their uses. 
0.00 3.01 29.59 45.21 22.19 

8 
The directions are given by the pharmacist on how to use 

your medicine 
0.00 4.11 45.21 36.99 13.70 

9 Services provided by the pharmacy as a whole 0.00 3.56 21.10 53.42 21.92 

10 Pharmacists answer your questions well 0.82 4.38 38.36 49.59 6.85 

11 
Hospitality and courtesy of Pharmacy officers in carrying 

out their duties 
0.82 3.84 23.01 52.88 19.45 

12 Pharmacists show concern for your health condition 1.10 6.58 37.26 50.41 4.66 

13 Pharmacists explain how to store drugs properly 6.85 18.63 37.26 31.78 5.48 

14 
Pharmacist involvement in solving problems related to your 

medication 
1.37 8.49 36.71 47.67 5.75 

15 
The pharmacist gives information about how many times 

and how long the drug should be taken 
0.27 3.84 27.67 45.48 23.01 

16 Pharmacists advise you to maintain or improve your health. 1.92 15.07 27.40 48.49 7.12 

17 
Confidentiality of the personal information you share with 

the pharmacist 
0.27 6.03 35.34 49.86 8.22 

18 
Pharmacists' explanation of things to avoid while taking 

your medicine 
10.41 21.64 32.05 31.23 4.66 

19 
The explanation is given by the pharmacist about the 

possible adverse drug side effects 
12.60 22.19 33.15 29.59 2.47 

20 Consultation time provided by the pharmacist for you 31.78 22.19 25.75 18.63 1.64 

Average 3.78 10.23 30.71 43.90 11.40 

 

In addition to explaining the patient satisfaction 

level based on these dimensions, this study also 

examines the association between sociodemographic 

characteristics and patient satisfaction level. Our results 

described a statistically significant difference for age, 

education, and profession toward patient satisfaction 

level, but not gender. Similar to the study done in 

northwestern Ethiopia, these areas of sociodemographic 

characteristics significantly differ in patient satisfaction 

levels (Surur et al., 2015). Similar to that is the analysis 

performed by Alrasheedi et al. in 2019, which is done in 

the Kingdom of Saudi Arabia (Alrasheedi et al., 2019). 

These aspects influence their understanding and reaction 

to the health services they receive. In contrast, in two 

studies in Pakistan (Aziz et al., 2018) and Ethiopia 

(Molla et al., 2022), no significant difference was 

observed in patient satisfaction concerning their 

demographic characteristics. 

 

 

Table 5. The correlation between sociodemographic 

characteristics and the degree of patient satisfaction 

among the patient population (n = 365) 

Demographic 

characteristics 

Toward Patient 

Satisfaction (p-value) 

Gender 0.065 

Age (years) 0.039(*) 

Last education 0.000(*) 

Profession 0.000(*) 

* = a significant relationship 

Note: Gender using the Mann-Whitney test; age and last 

education using the Spearman Rank test; and profession 

using the Kruskal Wallis test 

 

We acknowledge the constraints within our study. 

Initially, this research was undertaken solely within a 

single hospital in West Sumatra, Indonesia, implying 

that conclusions may not comprehensively mirror 

patients' experiences across Indonesia. Furthermore, the 

study comprised a relatively modest participant pool, 

and the duration of the study itself was limited, which 
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might restrict its ability to represent the broader 

spectrum of hospital patients accurately. All these 

limitations will affect the final result, including the need 

and quality of pharmaceutical services. However, this is 

the first study of this type in West Sumatra. Further 

studies involving a more general and more diverse 

patient population are needed. 

 

CONCLUSION 

Patients' satisfaction levels regarding 

pharmaceutical services within the Outpatient Pharmacy 

at Padang Panjang Hospital are generally deemed 

satisfactory, registering an average score of 3.49. The 

"Friendly Explanation" dimension scored 3.69, while 

the "Managing Therapy" dimension scored 3.25. 

Moreover, our findings indicated a notable and 

statistically significant variation concerning patient 

satisfaction based on age, education, and profession. 

Conversely, gender appears to have no discernible 

impact on patient satisfaction. 

 

ACKNOWLEDGMENT 

The authors extend their gratitude to individuals 

who contributed substantially to this study. 

 

AUTHOR CONTRIBUTIONS 

Conceptualization, D. P., D. A. J., N. Q. D.; 

Methodology, D. P., D. A. J.; Software, D. P., N. Q. D.; 

Validation, D. P., D. A. J.; Formal Analysis, D. P., D. A. 

J., N. Q. D.; Investigation, D. P., N. Q. D.; Resources, 

D. P., N. Q. D.; Data Curation, D. P., D. A. J., N. Q. D.; 

Writing - Original Draft, D. P., D. A. J., N. Q. D.; 

Writing - Review & Editing, D. P., D. A. J.; 

Visualization, D. P., D. A. J., N. Q. D.; Supervision, D. 

P., D. A. J.; Project Administration, D. P., D. A. J.; 

Funding Acquisition, D. P., D. A. J. 

 

FUNDING STATEMENT 

This research did not receive any specific grant 

from funding agencies in the public, commercial, or not 

for profit sectors. 

 

CONFLICT OF INTEREST 

The authors declared no conflict of interest. 

 

REFERENCES 

Almasdy, D. & Deria, P. D. (2015). Pengembangan 

Instrumen Penilaian Kepuasan Pasien Terhadap 

Pelayanan Kefarmasian di Rumah Sakit 

(Development of the Instrument Patient 

Satisfaction for Pharmaceutical Services in 

Hospital). Jurnal Sains Farmasi & Klinis; 1; 170–

175. doi: 10.29208/jsfk.2015.1.2.32. 

Alrasheedi, K. F., AL-Mohaithef, M., Edrees, H. H., & 

Chandramohan, S. (2019). The Association 

Between Wait Times and Patient Satisfaction: 

Findings from Primary Health Centers in the 

Kingdom of Saudi Arabia. Health Services 

Research and Managerial Epidemiology; 6; 

233339281986124. doi: 

10.1177/2333392819861246. 

Aziz, M. M., Ji, W., Masood, I., Farooq, M., Malik, M. 

Z., Chang, J., Jiang, M., Atif, N., & Fang, Y. 

(2018). Patient Satisfaction with Community 

Pharmacies Services: A Cross-sectional Survey 

from Punjab; Pakistan. International Journal of 

Environmental Research and Public Health; 15; 

1-14. doi: 10.3390/ijerph15122914. 

Bratkowska, K., Religioni, U., Krysiński, J., & Merks, 

P. (2020). Quality of Pharmaceutical Services in 

Independent Pharmacies and Pharmacy Chains in 

Poland from the Patient Perspective. Patient 

Preference and Adherence; 14; 2459–2467. doi: 

10.2147/PPA.S284014. 

Fadila, A. N., Hidayati, I. R., Yunita, S. L., Titani, M., 

& Atmadani, R. N. (2022). Patient Satisfaction of 

Pharmaceutical Services During the Covid-19 

Pandemic in the Public Healthcare Center of 

Singosari, Malang. KnE Medicine; 2; 1–14. doi: 

10.18502/kme.v2i3.11846. 

Larasanty, L. P. F., Cahyadi, M. F., Sudarni, N. M. R., 

& Wirasuta, I. M. A. G. (2019). Patient 

Satisfaction with Pharmaceutical Care Services 

Provided at Primary-level and Secondary-level 

Health Facilities in Indonesia's Health Coverage 

System. Journal of Health Research; 33(1); 80–

88. doi: 10.1108/JHR-06-2018-0033. 

Lee, S., Godwin, O. P., Kim, K. & Lee, E. (2015). 

Predictive Factors of Patient Satisfaction with 

Pharmacy Services in South Korea: A Cross-

sectional Study of National Level Data. PLoS 

One; 10; 1-9. doi: 10.1371/journal.pone.0142269. 

Larson, L. N., Rovers, J. P. & MacKeigan, L. D. (2002). 

Patient Satisfaction with Pharmaceutical Care: 

Update of a Validated Instrument. Journal of the 

American Pharmacists Association; 42; 44–50. 

Ministry of Health Republic of Indonesia. (2018). 

Peraturan Menteri Kesehatan Republik Indonesia 

Nomor 10 Tahun 2018 (Regulation of the Minister 

of Health of the Republic of Indonesia Nomor 10 

of 2018 concerning Supervision in the Health 



Jurnal Farmasi dan Ilmu Kefarmasian Indonesia Vol. 10 No. 3 December 2023      330 

 

 
P-ISSN: 2406-9388   ©2023 Jurnal Farmasi dan Ilmu Kefarmasian Indonesia 

E-ISSN: 2580-8303  Open access article under the CC BY-NC-SA license 

Sector). Jakarta: Ministry of Health Republic of 

Indonesia. 

Molla, M., Sisay, W., Andargie, Y., Kefale, B. & Singh, 

P. (2022). Patients' Satisfaction with Outpatient 

Pharmacy Services and Associated Factors in 

Debre Tabor Comprehensive Specialized 

Hospital, Northwest Ethiopia: A Cross-sectional 

Study. PLoS One; 17; 1-13. doi: 

10.1371/journal.pone.0262300. 

Nigussie, S. & Edessa, D. (2018). The Extent and 

Reasons for Dissatisfaction from Outpatients 

Provided with Pharmacy Services at Two Public 

Hospitals in Eastern Ethiopia. Frontiers in 

Pharmacology; 9; 1-8. doi: 

10.3389/fphar.2018.01132. 

Osman, M. A., Hussain, S. A., & Omar, A. M. (2022). 

Assessment of Patient Satisfaction Toward 

Pharmaceutical Benefit Package Provided by a 

Health Insurance Corporation of Khartoum State. 

F1000Research; 11; 204. doi: 

10.12688/f1000research.108760.1. 

Ostrowska, M., Drozd, M., Patryn, R. & Zagaja, A. 

(2022). Prescriptions as Quality Indicators of 

Pharmaceutical Services in Polish Community 

Pharmacies. BMC Health Services Research; 22; 

1-8. doi: 10.1186/s12913-022-07772-2. 

Sanii, Y., Torkamandi, H., Gholami, K., Hadavand, N., 

& Javadi, M. (2016). Role of Pharmacist 

Counseling in Pharmacotherapy Quality 

Improvement. Journal of Research in Pharmacy 

Practice; 5; 132. doi: 10.4103/2279-042x.179580. 

Semegn, S. & Alemkere, G. (2019). Assessment of 

Client Satisfaction with Pharmacist Services at 

Outpatient Pharmacy of Tikur Anbessa 

Specialized Hospital. PLoS One; 14; 1-10. doi: 

10.1371/journal.pone.0224400. 

Surur, A. S., Teni, F. S., Girmay, G., Moges, E., Tesfa, 

M. & Abraha, M. (2015). Satisfaction of Clients 

with the Services of an Outpatient Pharmacy at a 

University Hospital in Northwestern Ethiopia: A 

Cross-sectional Study Health Systems and 

Services in Low and Middle Income Settings. 

BMC Health Services Research; 15; 1-8. doi: 

10.1186/s12913-015-0900-6. 

 

 

 

 



 
 

Jurnal Farmasi dan Ilmu Kefarmasian Indonesia Vol. 10 No. 3 December 2023, 331-346 

DOI: 10.20473/jfiki.v10i32023.331-346 

Available online at https://e-journal.unair.ac.id/JFIKI/ 

 

P-ISSN: 2406-9388   ©2023 Jurnal Farmasi dan Ilmu Kefarmasian Indonesia 

E-ISSN: 2580-8303                                                                                                 Open access article under the CC BY-NC-SA license  

Formulation and Characterization of Instant Powder Combination of 

Ginger, Bangle, and Lemon Extract as an Antioxidant 
 

Nur Aji1,2*, Shandra Isasi Sutiswa1,2  
1Department of Pharmacy, Poltekkes Kemenkes Tasikmalaya, Tasikmalaya, Indonesia 
2Center of Excellent Health and Disaster Emergency (CoE HADE) Center Poltekkes Kemenkes Tasikmalaya, 

Tasikmalaya, Indonesia 

 

*Corresponding author: nuraji090689@gmail.com 

 

Submitted: 8 August 2023 

Revised: 24 October 2023 

Accepted: 31 October 2023  

 

 

Abstract 

Background: Degenerative disease is a  decreasing organ function; clinical manifestations can affect the whole 

body, which is caused by oxidative stress. Ginger, bangle, and lemon have antioxidant properties. The combination 

of the three is expected to increase antioxidant activity. Objective: This study aimed to determine the potential 

antioxidant activity of the mixture of the three samples formulated as instant powder. Methods: This research is 

an experimental laboratory. This study will examine the effect of variations in extract concentration and PEG-40 

HCO concentration on instant powder's characteristics and antioxidant activity. Results: Individually, ginger 

extract has extreme antioxidant activity (IC50 = 23.57 ± 0.13 µg/mL) and bangle strong (IC50 = 64.89 ± 0.15 

µg/mL), while lemon has weak antioxidant activity (IC50 >500 µg/mL). Combining ginger, bangle, and lemon with 

a simplex axial method obtained the combination of ginger: bangle: lemon with the ratio of 4/6: 1/6: 1/6. Adding 

a mixture of extracts affects the solubility and antioxidant activity of the extracts. The greater the amount of extract, 

the lower the solubility, and the antioxidant activity did not increase with addition. The addition of PEG-40 HCO 

increases the solubility of the extract in the instant powder. Antioxidant activity increased to the “medium” 

category (121.90 µg/mL) after adding PEG-40 HCO at a concentration of 2.70%. The unfavourable impact of 

PEG-40 HCO addition on instant powders is the angle of repose, flow time, and compressibility. Conclusion:  The 

ginger, bangle, and lemon can be combined and made into instant powder with potential antioxidant activity in 

the moderate category. 
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INTRODUCTION 

Degenerative disease decreases organ function, 

which generally affects the elderly. Clinical 

manifestations of degenerative can affect all organs of 

the body. Degenerative conditions in Indonesia, such as 

hypertension, diabetes mellitus, stroke, and chronic 

kidney failure, increased in 2018 from 2013. The 2018 

Basic Health Research results found that stroke 

prevalence was 7% in 2013 and 10.9% in 2018. The 

prevalence of chronic kidney disease was 2% in 2013 to 

4% in 2018. The prevalence of diabetes mellitus was 

1.8% in 2013 to 1.9% in 2018. The prevalence of 

diabetes mellitus is high in people with higher education 

and state civil servants (Fridalni et al., 2019). During the 

Covid 19 pandemic, people with degenerative diseases 

have a higher risk of being exposed and tend to 

experience worse complications from this disease (Sari 

& Widiharti, 2021). 

Degenerative diseases are caused by oxidative 

stress in the presence of free radicals in biochemical 

mechanisms that occur in the body. Free radicals are 

considered dangerous because they become very 

reactive in trying to get their electron pair (Odinga et al., 

2020). Antioxidants can slow down the oxidation 

process of free radicals, thereby protecting cells from 

damage caused by unstable molecules known as free 

radicals (Sadiq, 2023). The mechanism of the body's 

resistance to oxidative stress is through endogenous 

antioxidants. If the number of free radicals and reactive 

species in the body exceeds the ability of endogenous 

antioxidants, then the body requires the intake of 

exogenous antioxidants (Martemucci et al., 2022). 

Ginger rhizome has antioxidant activity. Ginger 

oleoresin, as an active substance, can ward off free 

radicals, such as 6-gingerol and 6-shogaol, which are 

known to have relatively high antioxidant activity, with 

a mechanism to stabilize free radicals by complementing 

the lack of electrons possessed by free radicals and 

inhibiting the occurrence of chain reactions from the 

formation of free radicals (Ahmed et al., 2022). Apart 

from the ginger plant, other plants such as Bangle and 

Lemon also have antioxidant activity due to the content 

of flavonoid compounds. In addition, the content of 

flavonoids in bangle plants also functions as an 

immunostimulant. In addition, the bangle is rich in 

curcuminoid compounds, which also have antioxidant 

potential (Nurkhasanah et al., 2019). 

The potential bangle, ginger, and lemon plants, 

which contain antioxidants, can be used to prevent 

degenerative diseases (Veurink et al., 2020). In addition, 

antioxidants are essential to maintain body immunity, 

especially during a pandemic. A combination of bangle, 

ginger, and lemon is formulated into an instant powder. 

The advantages of instant powder formulas are product 

quality that is more practical and hygienic (Çopur et al., 

2019). Based on this, researchers are interested in 

making an instant powder combination of ginger, 

bangle, and lemon extracts as an antioxidant. This study 

aims to see the effect of adding a mixture of extracts and 

PEG-40 HCO on the characteristics of instant powder: 

solubility, pH, antioxidant activity, angle of repose, flow 

rate, and powder density. PEG-40 HCO is a solubilizer 

agent of hydrogenated castor oil derivatives. The 

hydrogenated castor oil is obtained by hydrogenation of 

virgin castor oil (Rowe et al., 2009). PEG-40 HCO is 

known to have the advantages of having good solubility 

in a reasonably wide polarity range, is non-toxic, and 

can be used for oral dosage forms (Rachmawati et al., 

2017). 

 

MATERIALS AND METHODS 

The research was conducted in an experimental 

laboratory divided into four work stages. The first is the 

manufacture of extracts and testing of extract 

parameters. The second stage was optimizing the 

combination of extracts and instant powder fillers. The 

third stage is the formulation of ginger and lemon bangle 

instant powder. The fourth step is to test the 

characteristics of the extract and the antioxidant activity 

of the instant powder dosage form. 

Instruments and materials 

Making the extract involves a macerator and rotary 

evaporator (InScienPro). In the process of testing the 

antioxidant activity, total curcuminoids, total 

flavonoids, and total polyphenols using tools: 

microanalytical balance (Sartorius), UV-Vis 

spectrophotometer (Agilent Cary 60), and micropipette 

(Joanlab). Instant powder production involves a 

dehydrator (Athome), grinder, and other standard 

glassware (Pyrex). The powder characteristics test 

involved a pH meter (Dixon Tech), a slide micrometre 

(Srate), and a centrifuge (Health HC8). 

Phytochemical screening using reagents:Mayer 

(DPH), Dragendroff (DPH), sulfuric acid P (Emsure), 

acetic acid anhydrous (Isolab), FeCl3 (Sigma), gelatin 

(Fisher Saintific), NaCl (Merck), zinc dust (Emplura), 

HCl P (Emsure), chloroform (Merck) and ammonia 

(Emsure). Several standard reagents used in determining 

extract parameters were gallic acid (Merck), curcumin 

(Merck), DPPH/1,1-diphenyl-2-picrylhidrazil (Sigma), 

and Quercetin (Merck). In the manufacturing process, 

they have used excipients: maltodextrin DE 18-20 
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(Ambrosia), Sucralose (Anhui Jinhe), and PEG-40 HCO 

(Evonik).  

The research sample was ginger (Zingiber officinale 

L.) simplicia obtained from B2P2TOOT. Bangle 

extract, which was extracted using 96% ethanol (DPH) 

from the Zingiber montanum (J.Koenig) Link ex A 

simplicia, plant which had been determined at 

Herbarium Bandungense ITB with the Voucher code 

FIPIA-DEP29.  Lemon is a local fruit obtained from the 

CLemon, which is a local fruit obtained from the city of 

Tasikmalaya. 

Extraction 

The extract was prepared based on the 2nd 

Indonesian Herbal Pharmacopoeia, using 96% ethanol. 

Weighed 1 Kg of simplicia was crushed and sieved 

using mesh number 40. The simplicia powder was then 

considered, and 995 grams were obtained. The simplicia 

work was divided into five macerators; ginger simplicia 

powder was put into the macerator and added with 96% 

ethanol at a ratio of 1:10. Soak it for the first 6 hours 

while occasionally stirring and let stand for 18 hours. 

The solvent replacement was carried out once with the 

same type and amount, and the treatment was carried out 

the same way as the first day. All macerate was 

collected, filtered, and then concentrated in a vacuum 

rotary evaporator with a speed of 60 RPM, pressure -0.6 

mmHg, and a temperature of 60oC. The condensed 

extract is then calculated in yield using equation 1 

(Kemenkes RI, 2017). 

𝑌𝑒𝑙𝑑 (%) =
𝐸𝑥𝑡𝑟𝑎𝑐𝑡 𝑤𝑒𝑖𝑔ℎ𝑡 (𝑔𝑟𝑎𝑚)

𝑆𝑖𝑚𝑝𝑙𝑖𝑐𝑖𝑎 𝑤𝑒𝑖𝑔ℎ𝑡 (𝑔𝑟𝑎𝑚)
× 100%...........[1] 

Test the water content of the extract 

The distillation of toluene determines the water 

content. First, the toluene is saturated with water; the 

samples are weighed in 2 grams. The pieces are put into 

a round bottom flask and added toluene. The toluene 

distillation device is assembled, making sure the district 

and burette are clean and dry. The flask was heated for 

15 minutes; after the toluene started to boil, the 

distillation was set at two drops/second. After all the 

water is distilled, heating is continued for 5 minutes. 

Allow the receiving tube to cool to room temperature 

and the water to separate at the bottom of the burette. 

Moisture content is calculated based on volume percent 

per sample weight (DepKes RI, 2000). 

Phytochemical screening 

Phytochemical screening was performed according 

to Farnsworth (1966) and Hanani (2015) procedures. 

Phytochemical screening includes compounds: 

alkaloids, tannins, polyphenols, flavonoids, saponins, 

triterpenoids, and steroids. The procedure in the 

following description: 

a. For the alkaloids test, the extract is put into a test tube 

with 28% ammonia, and then 10 mL of chloroform is 

added. The chloroform phase was separated and 

acidified with 2 N hydrochloric acid. The acid layer 

was separated and used for alkaloid testing: with 

Mayer reagent (Potassium mercuri-iodide solution), 

the addition of a few drops of Mayer reagent raises a 

white precipitate, indicating the presence of alkaloids. 

Dragendorff (Iodobismutat solution): The addition of 

this reagent raises a brownish-red precipitate, 

indicating the presence of alkaloids. 

b. In the tannin test, the extract is put into a test tube, 

diluted with 2 mL of water and then divided into two 

tubes. In the 1st tube, add 2-3 drops of FeCl3 1%. The 

presence of a blue precipitate or blue-black colour 

indicates the presence of galanin and ellagitannin, 

while the green or turquoise colour indicates the 

presence of condensed tannins. In the 2nd tube, added 

1% gelatin (in 10% NaCl) formed a precipitate 

indicating the presence of tannins. 

c. In the polyphenol test, the extract is put into a test 

tube, diluted with water, and then a few drops of 

FeCl3 1% are added. The presence of a blue 

precipitate, and blue-black, green and turquoise 

colours indicate the presence of polyphenolic 

compounds. 

d. In the flavonoid test, the extract was put into a test 

tube, added 2 mL of 80% ethanol, and then stirred and 

filtered. Filtrate added 3-4 spatulas of magnesium 

powder and 0.5 mL of  HCl P. The presence of 

flavonoids is indicated by the production of an orange-

to-red hue that can be drawn with amyl alcohol or 

octyl alcohol. 

e. For the saponin test, the extract is put into a test tube 

with 10 mL of water, then stirred and shaken 

vigorously vertically for 30 seconds. If the foam is 

formed with a height of more than 3 cm, which is 

persistent for 30 minutes, then the sample contains 

saponin. 

f. Testing for steroids and triterpenoids, the extract is put 

into a test tube, chloroform is added, and then the 

chloroform phase is separated and evaporated. Three 

drops of anhydrous acetic acid and one drop of 

concentrated sulfuric acid were added to the residue 

(Liebermann-Burchard). The magenta or violet colour 

formation indicates that the simplisia contains 

triterpenoid group compounds. The presence of a 

greenish-blue colour indicates the presence of 

steroids. 
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Determination of total curcuminoid levels of bangle 

extract 

Test for total curcuminoids using UV-Vis 

spectrophotometry (Kemenkes RI, 2017). Preparation of 

the test solution begins by carefully weighing 

approximately 100 mg of the extract, placing it in an 

Erlenmeyer flask, and adding 10 mL of ethanol P, 

sonicating until the extract is dissolved. Filter into a 10 

mL volumetric flask, rinse the filter paper with ethanol 

P, and add ethanol P up to volume. The sample solution 

was diluted ten times by taking 0.1 mL of input into a 10 

mL volumetric flask and adding ethanol P up to the 

mark. A reference solution was prepared by carefully 

weighing approximately 10 mg of curcumin, putting it 

into a 10 mL volumetric flask, and adding ethanol P up 

to the mark. Make a series of dilutions for the reference 

solution with levels 1, 2, 3, 4, 5, and 6 µg/mL, 

respectively. Blank solution using Ethanol P. 

Measurements were made by pipetting 3 mL of the test 

solution separately, each series of the Reference solution 

and the Blank solution into the appropriate containers, 

measuring the absorbance at the maximum absorption 

wavelength of approximately 420 nm. Create a 

calibration curve to determine the regression equation. 

The sample concentration is calculated in weight percent 

(% w/w) with equation 2 where k is the curcuminoid 

concentration in µg/mL, f is the dilution factor, v is the 

sample volume before dilution (mL), and w is the 

sample weight. 

𝐶𝑢𝑟𝑐𝑢𝑚𝑖𝑛𝑜𝑖𝑑 (%) =
𝑘×𝑣×𝑓

𝑤
× 100%.................[2] 

Determination of total polyphenol levels 

The reference solution was diluted ten times for a 

100 μg/mL concentration. The reference solutions were 

made in serial dilutions with successive concentrations 

of 1, 2, 3, 4, and 5 μg/mL, as seen in Table 1. 

A total of 1 mL of the test solution was taken, and 

each series of reference solutions was put into the 

appropriate container; at each concentration, 0.5 mL of 

F-C solution was added. The mixture was allowed to 

stand for 8 minutes, then 0.5 mL of saturated Na2CO3 

was added and incubated for 1 hour at room 

temperature, after which 10 mL of water was added. The 

wavelength absorption of each solution was measured at 

a wavelength of 740 nm. Blank measurements were 

carried out the same way, without adding the test 

solution. A calibration curve was created, and the gallic 

acid equivalent (GAE) sample concentration was 

calculated (Aji et al., 2023; Kemenkes RI, 2017). 

Determination of total flavonoid levels 

Weighed 0.1 gram of sample and put it into an 

Erlenmeyer, then 10 mL of ethanol P sonicated was 

added until the extract dissolved. Filter into a 10 mL 

volumetric flask, rinse the filter paper with ethanol P, 

and add up to the mark. The reference solution was 

prepared by carefully weighing 10 mg of quercetin, 

putting it into a 10 mL volumetric flask, dissolving it, 

and adding ethanol P up to the mark. Make serial 

dilutions of 20, 30, 40, 50, and 60 µg/mL solutions. The 

assay started by pipetting 0.5 mL of the test solution 

separately and each series of reference solutions into the 

appropriate container, adding 1.5 mL of ethanol P, 0.1 

mL of 10% aluminum chloride, 0.1 mL of 1 M sodium 

acetate, and 2.8 water (Table 2). Shake the solution for 

30 minutes at room temperature. Measure the 

absorbance at λmax. Create a calibration curve and 

calculate the levels in the presence of quercetin 

equivalent (QE) flavonoids (Islam et al., 2022; 

Kemenkes RI, 2017).

Table 1. Series of dilution tests for total polyphenol content by gallic acid equivalence method 

No. 
Gallic Ac. 

(mL) 

F-C 

(mL) 

Na2CO3 

(mL) 

Water 

(mL) 

Final Volumes 

(mL) 

Gallic Acid 

Concentration (μg/mL) 

1 0.00 0.50 0.50 9.00 10.00 0.00 

2 0.10 0.50 0.50 8.90 10.00 1.00 

3 0.20 0.50 0.50 8.80 10.00 2.00 

4 0.30 0.50 0.50 8.70 10.00 3.00 

5 0.40 0.50 0.50 8.60 10.00 4.00 

6 0.50 0.50 0.50 8.50 10.00 5.00 

Table 2. Determination of total flavonoids by quercetin equivalence method 

Quercetin 

(µg/mL) 

Vol. Quercetin 

(mL) 

AlCl3 

(mL) 

Na-Acetate 

(mL) 

Ethanol 

(mL) 

Water 

(mL) 

Quercetin Final 

Concentration (μg/mL) 

20.00 0.50 0.10 0.10 1.50 2.80 2.00 

30.00 0.50 0.10 0.10 1.50 2.80 3.00 

40.00 0.50 0.10 0.10 1.50 2.80 4.00 

50.00 0.50 0.10 0.10 1.50 2.80 5.00 

60.00 0.50 0.10 0.10 1.50 2.80 6.00 
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Table 3. Dilution series and addition of DPPH test reagents 

Sample 

Code 

Methanol 

(mL) 
Sample (mL) 

DPPH 

(mL) 

Sample Concentration 

(μg/mL) 

Control 4.00 0.00 1.00 0.00 

A1 3.75 0.25 1.00 5.00 

A2 3.50 0.50 1.00 10.00 

A3 3.00 1.00 1.00 20.00 

A4 2.00 2.00 1.00 40.00 

A5 0.00 4.00 1.00 80.00 

 

Antioxidant activity assay of ginger extract, bangle, 

and lemon juice 

Sample stock solutions and 1,1-difenil-2-

pikrilhidrazil (DPPH) were prepared at a concentration 

of 100 μg/mL, then the samples and DPPH were reacted 

as shown in Table 3, with a total volume of 5 mL to 

obtain sample concentrations of  5, 10, 20, 40, and 80 

μg/mL. The solution concentration series were 

incubated at 37°C for 30 minutes and protected from 

light. After that, the absorbance at a wavelength of 517 

nm was calculated using a UV-Vis spectrophotometer 

(Agilent Carry 60) and the percent inhibition (Pi) using 

equation 3. The value of Ab is the absorbance of the 

control, while As is the absorbance of the sample. The 

results of the calculation are entered in a linear 

regression equation with the extract concentration 

μg/mL) as the abscissa (x-axis) and the % inhibition 

activity value as the coordinate (y-axis). The IC50 value 

is calculated by the equation y = ax+b  (Aji et al., 2023; 

Sirivibulkovit et al., 2018). The IC50 category can be 

seen in Table 4. 

𝑃𝑖 =
𝐴𝑏−𝐴𝑠

𝐴𝑏
× 100%.................[3] 

 

Table 4. Category IC50 of antioxidant activity 

(Zamzani & Triadisti, 2021) 

Antioxidant Intensity Score IC50 (µg/mL) 

Very Strong <50 

Strong 50-100 

Currently 100-250 

Weak 250-500 

 

Antioxidant assay combination of ginger extract, 

bangle, and lemon juice 

The simple axial approach is used to determine 

combinations involving three samples simultaneously. 

This approach estimates the optimal mix of extracts, 

minimizing the amount used. (Cavalcanti et al., 2021).  

The combinations follow Figure 1 and Table 5. 

Combination 1, ginger, bangle and lemon extracts were 

1/3: 1/3: 1/3, combination 2 is 4/6: 1/6: 1/6, combination 

3 is 1/6: 1/6: 4/6, and combination 4 is 1/6: 4/6: 1/6 

(Cornell, 2011).  

 

Figure 1. A simple axial diagram of the ginger-bangle-

lemon combination (Cornell, 2011) 

 

Table 5. Combinations of ginger extract: bangle: 

lemon 

Combination X1 

(Ginger) 

X2 

(Bangle) 

X3 

(Lemon) 

1 1/3 1/3 1/3 

2 4/6 1/6 1/6 

3 1/6 1/6 4/6 

4 1/6 4/6 1/6 

 

All formula combinations were made into 100 

μg/mL stock concentrations and then made into five 

concentration variations and one blank. Each 

concentration was added with 100 μg/mL DPPH 

(Table.3); then, the absorbance was measured. The next 

step was calculating the percent inhibition and making a 

linear regression curve, which sought the IC50 value. The 

sample stock solution was diluted into five graded 

concentration variations. Add 1.0 mL of 150 mg/L 

DPPH solution until the total volume of the solution is 

5.0 mL (Julizan, 2019). 

Measure the absorbance of the solution using a 

spectrophotometer at a wavelength of 517 nm, calculate 

the inhibition ability of each sample concentration as a 

percent inhibition (equation 3), and Plot the sample's 

concentration value and % inhibition on the standard 

curve. The concentration of 50% inhibition (IC50) is 

determined using the linear regression. 
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Instant powder formulation with the added 

combination of extracts 

The formulation was based on a combination of 

extracts with the highest antioxidant activity. The 

selected extract combinations were then made into 

instant powder with increased concentrations of 100, 

200, 300, 400, and 500 times their IC50 values. The 

instant powder is formulated with the addition of fillers 

maltodextrin dextrose equivalent (DE) 18-20 and 

sucralose as a sweetener. Sucrose was used at a 

concentration of 0.24%. Maltodextrin is chosen with DE 

18-20, which is very soluble in water. The formula uses 

maltodextrin as a filler with an amount of 1-99% (Rowe 

et al., 2009). The instant powder formula can be seen in 

Table 8. After being formulated, the instant powder was 

tested for antioxidant activity, organoleptic observation, 

solubility, sedimentation, and clarity tests. Antioxidant 

activity test using a sample weight of 100 mg. 

Instant powder formulation with the addition of 

PEG-40 HCO 

PEG-40 Hydrogenated Castor Oil or PEG-40 HCO 

is a surfactant that can help dissolve instant powder in 

water (Kadian & Nanda, 2022). The addition of PEG-40 

HCO is expected to increase antioxidant activity by 

increasing the solubility of instant powder when 

dissolved in water. The instant powder formula with the 

successive addition of PEG-40 HCO from 0, 1, 3, 9, and 

27% can be seen in Table 9. After the formulation, the 

antioxidant activity was tested with a sample size of 100 

mg. Powder characteristic test includes parameters: 

organoleptic, dissolving time, clarity, sedimentation, 

angle of repose, flow time, bulk density, incompressible 

density, and Housner factor. In addition to the 

characteristics of the formula with the best antioxidant 

activity, a proximate test was also carried out. 

Instant powder characteristics test 

Instant powder organoleptic was carried out 

macroscopically and microscopically. Macroscopic 

observations include the form of aroma, colour, and 

taste. The microscopic observation of powder particle 

shape. Microscopic observation using a binocular 

microscope with a slide micrometre. The instant powder 

is put on the micrometre slide, dripped with liquid 

paraffin, and covered using a cover glass. 

The solubility test was performed by dissolving 

instant powder in water with a ratio of 1:10 up to 1:100 

at 10 mL volume intervals. They stirred the solution 

using a magnetic stirrer at a speed of 2400 rpm for 5 

minutes. Percent transmittance (%T) is used to measure 

the clarity of a solution or dispersion system 

quantitatively. A high %T value means that the particle 

size is getting smaller, and the level of transparency is 

increased (Abdassah, 2017). The turbidity of the 

solution was measured using UV-Vis photometer 

spectroscopy at a wavelength of 800 nm, and the %T 

value was calculated. The sedimentation test carried out 

the solubility test results by placing the sample in a 

centrifugation tube and rotating it at 4000 rpm for 5 

minutes. The centrifugation results were then seen for 

the presence or absence of sediment. 

The dissolution time test was carried out by 

weighing 1 gram of instant powder in a 100 mL glass, 

and then the dissolving time of the powder in water was 

recorded. The time needed to dissolve is less than 5 

minutes (Schorsch et al., 2001). 

The angle of repose is a fixed angle between the 

heap of conical particles and the horizontal plane when 

a certain amount of powder is poured into the measuring 

device. A good angle of silence between 25- 40o. The 

angle of repose is determined by the equation Tan α = 

h/r, where α is the angle of repose, h is the height of the 

cone, and r is the radius of the cone (Husni et al., 2020). 

The flow time is determined by weighing 25 grams 

of powder poured into the measuring funnel. The funnel 

lid is opened slowly; the granules are allowed to flow 

out. Time was recorded with a stopwatch until all the 

granules flowed out. A good flow time is ≤10 

grams/second or 100 grams ≤ 10 seconds (Hudha & 

Widyaningsih, 2015). 

The pH value is determined by weighing 1 gram of 

instant powder dissolved in 100 mL of distilled water. 

Take measurements using a calibrated pH meter in the 

test range using a standard buffer. 

The bulk density (ρ) test was carried out by 

weighing 30 grams of powder (Wo), then putting it into 

a 100 mL measuring cup and observing its volume (Vo). 

The formula calculates the bulk ρ value: Wo/Vo. The 

compress ρ test is carried out by weighing 30 grams of 

powder (Wo) input into a 100 mL measuring degree and 

measuring the volume (Vt). Then, place it on the tap 

density tester by tapping 1,250 times and recording the 

volume (Vt1). If the difference between Vt and Vt1 is 

not more than 2 mL, then Vt is used. The Wo/Vt formula 

calculates the compress ρ value. The incompressible ρ 

value is affected by the particle size (Abdullah & 

Imtihani, 2022). The Hausner factor is a method of 

determining the flow properties of powders by 

measuring ρ bulk and ρ compressed. A ratio of <1.25 

indicates good characteristics, and>1.50 means poor 

characteristics (Kusumo & Mita, 2018). In addition to 

the Hausner ratio, the percent (%) compressibility value 
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is also specified. The Hausner factor is calculated using 

equation 4, and % compressibility using equation 5. 

 Hausner Factor =  
𝜌 Compress

𝜌 𝐵𝑢𝑙𝑘
 ......................[4] 

 

% Compressibility =

 
𝜌 Compress−𝜌 𝐵𝑢𝑙𝑘

𝜌 𝐶𝑜𝑚𝑝𝑟𝑒𝑠𝑠
 ...................[5] 

Data analysis 

Descriptive analysis was done for the parameter 

data of extract and powder characteristics. In 

comparison, regression analysis determines total 

curcuminoid levels, total polyphenols, total flavonoids, 

and antioxidant activity. 

 

RESULTS AND DISCUSSION 

Extraction results and extract parameters test 

Bangle is an extract obtained by the maceration 

method using 96% methanol. Bangle extract was 

brought based on previous research by Aji et al. (2023). 

Ginger extract is made using the maceration method 

with 96% ethanol solvent. The result of ginger 

extraction yielded 8.74%. In contrast, in lemon fruit 

juice, from 500 grams of fresh fruit, 120 mL of liquid is 

obtained. Water level testing was done on ginger and 

bangle extracts. The water content obtained was as much 

as 5.64±1.63% for ginger extract and 9.09±0.61% for 

bangle extract. The water content of both extracts meets 

the Indonesian Herbal Pharmacopoeia requirements 

(Kemenkes RI, 2017). 

Phytochemical screening aims to identify the 

content of secondary metabolite compounds of a natural 

material. The results of phytochemical screening can be 

seen in Table 6. Plants are an essential source of 

bioactive compounds for developing new therapeutic 

agents. Some of them have antioxidant activity. Based 

on Table 6, concentrated extracts of ginger and bangle 

were identified as having the same group of compounds: 

alkaloids, polyphenols, flavonoids, and triterpenoids. 

While lemon identified only polyphenols. Several 

secondary metabolite compounds, such as polyphenols 

and flavonoids, are known to have antioxidant activity 

(Nhu-Trang et al., 2023). 

Total curcuminoid level testing was done on the 

bangle, associated with the yellow pigment content 

caused by complex curcuminoid content such as 

cassumunin A, B, and C (Kabkrathok et al., 2022). The 

total curcuminoid level testing result from the bangle is 

1.82±0.01%. This value is much lower than the previous 

research conducted by Aji et al. (2023), which amounted 

to 3.84%. The low level of total curcuminoid can be 

caused by several factors in the extract storage process, 

such as temperature, water content, and pH. 

Curcuminoids will be stable at acidic pH (<7) in aqueous 

solution and very unstable at neutral and alkali pH (>7). 

In contrast, high temperature is a catalyst for 

accelerating curcuminoid degradation (Kharat et al., 

2017). 

 

Table 6. Results of phytochemical screening 

No. Group of 

Compounds 

Ext. 

EtOH 

96% 

Ginger 

Ext. 

EtOH 

96% 

Bangle 

Lemon 

Juice 

1 Alkaloids + + - 

2 Polyphenol + + + 

3 Tannin - - - 

4 Flavonoids + + - 

5 Saponins - - - 

6 Steroids - - - 

7 Triterpenoids + + - 

(+) present, (-) absent 

 

Total polyphenol (Figure 2a) and total flavonoid 

(Figure 2b) levels were tested on all three samples. The 

test results can be seen in Figures 2a and 2b. The highest 

level of phenols is found in the ginger extract, followed 

by bangle and lemon, with the lowest concentration.  In 

this study, the total polyphenol content of ginger was 

1.22 mgGAE/g compared to previous research by 

Ghafoor et al. (2020), where the total polyphenol 

content was much higher at 9.32 mgGAE/g. The low 

polyphenol content may occur due to the simplified 

heating-drying process. In previous studies, the drying 

method of simplicia used freeze-dried so that the 

oxidation of polyphenolic compounds could be 

minimized with low temperatures. Similarly, the total 

polyphenol content in this study obtained 0.64 

mgGAE/g in previous research by  (2022), which 

amounted to 3.81 mgGAE/g. Both used the same 

extraction method and solvent. The main content of 

ginger rhizome is oleoresin in the form of gingerol and 

shogaol derivatives (Van et al., 2023). The gingerol and 

shogaol compounds (Figures 3a and 3b) are 

polyphenolic compounds that can react with the F-C 

reagent and be read in the test (Nikolaeva et al., 2022). 

In the bangle, the main compound is curcuminoid 

(Figure 3c), which has a polyphenol functional group 

and can react with the F-C reagent. The lowest content 

is lemon juice; unlike ginger and bangle extract, lemon 

is not concentrated, so it has the lowest range. 
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                                       (a)                                                                                     (b) 

Figure 2. (a) Total polyphenol level as gallic acid equivalent (GAE), and (b) total flavonoid level as quercetin 

equivalent (QE) 

 

 

Figure 3. Phenol functional group in compounds (a) 6-gingerol, (b) 6-shogaol, and (c) curcumin 

 

 

Figure 4. Antioxidant activity of the combination of ginger extract, bangle, and lemon juice 

 

Different from the total polyphenol content test in 

the total flavonoid test, the bangle has the highest 

flavonoid content compared to the other two samples. 

For total flavonoid levels in this study, it was 2.01 

mgQE/g, based on previous research by  (2022), with 

levels of 1.69 mgQE/g. In this study, flavonoid levels 

were slightly higher than in the previous study. This 

study and the previous one were ginger rhizomes 

sourced from the same harvest site. One of the reasons 

for the difference is the different harvest times. As for 

bangle in, this study has a level of 17.04 mgQE/g, while 

in the previous research it was 21.93 mgQE/g. This and 

previous studies used the same extraction method and 

solvent but different sources. Based on this, the drying 

method, harvest time and harvest location significantly 

affect the levels of total polyphenol content and total 

flavonoids. Based on the research of  Hassan et al. 

(2019) besides curcuminoid bangle is known to contain 

five flavonoid derivatives, namely kaempferol 3-O-

rhamnopyranoside, kaempferol 3-O-(3 "-O-acetyl) 

rhamnopyranoside, kaempferol 3-O-methyl ether, 

kaempferol 3-O-(4 "-O -acetyl) rhamnopyranoside, and 

kaempferol 3-O-(3,4”-di-O-acetyl) rhamnopyranoside. 

Antioxidant test results of ginger extract, bangle, and 

lemon juice individually and in combination 

The results of the antioxidant activity test of the 

three samples can be seen in Table 7. The antioxidant 

activity is correlated with the total polyphenol level; the 

higher the total polyphenol level in the extract, the 

higher the antioxidant activity (Muflihah et al., 2021). 

The IC50 value is the concentration of the sample 

solution needed to inhibit 50% of DPPH free radicals. 

The lower the IC50 value, the higher the activity 

(Ramadhan et al., 2022). Ginger extract has very strong 

antioxidant activity (<50 μg/mL), the bangle has strong 

activity (50-100 μg/mL), and lemon has weak activity 

(> 500 μg/mL) (Zamzani & Triadisti, 2021). 
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Table 7. Antioxidant activity of ginger, bangle, and 

lemon 

Sample IC50 (μg/mL) SD 

Ext. EtOH 96% Ginger 23.57  0.13 

Ext. EtOH 96% Bangle  64.89  0.15 

Lemon Juice 4,268.02  0.11 

  SD : Standard deviation 

 

Based on the results (Figure 4), the antioxidant 

activity of combination number two with the 

composition of ginger (4/6), bangle (1/6): and lemon 

(1/6) is the composition that has the highest activity with 

the category of "medium” potential. The combination is 

done using a simple axial. Although lemon juice has 

weak antioxidant activity, it contains organic acids that 

can stabilize curcuminoids (Asencio et al., 2018; Zheng 

et al., 2017). Curcuminoid compounds are stable in 

aqueous solutions at acidic pH (<7) (Manju & 

Sreenivasan, 2011). The content of organic acids such 

as citric acid and malic acid in the lemon will create 

acidity in the extract combination (Sánchez-Bravo et al., 

2022). The combination of extracts has lower 

antioxidant activity than single extracts (ginger and 

bangle). The decrease may occur due to dilution from 

the effect of mixing extracts that have intense 

antioxidant activity with weak ones (Harun & 

Rahmawati, 2022). In addition to antioxidant activity, 

the working mechanism of the characteristic 

components in the extract can be used as a target in 

combination design. For example, 6-gingerol regulates 

lipogenesis, fatty acid oxidation, mitochondrial 

dysfunction, and oxidative stress (Cerdá et al., 2022). 

Curcumin affects the treatment of diabetes by improving 

β-cell function, preventing β-cell death, and reducing 

insulin resistance (Quispe et al., 2022). 

Instant powder formulation results with the addition 

of extract combinations 

Based on the optimization results, combination 

number two was selected to proceed to the formulation 

stage. The IC50 value of combination extract number two 

is 121.90 μg/mL or 0.0122%. At this stage, the effect of 

adding extracts on instant powder's characteristics and 

antioxidant activity will be seen. The extracts were 

increased to 100, 200, 300, 400, and 500 times from the 

IC50 value. The formula can be seen in Table 8. 

The result of organoleptic observation (Figure 5) 

macroscopically shows that the dosage form is pale 

yellow to yellow. The yellow colour's intensity increases 

as the added extract's concentration increases. Similarly, 

the aroma will increase with the addition of extracts. All 

instant powders have a powder form with a smooth 

texture. The instant powder has a sweet, sour, and spicy 

taste. The sour and spicy flavour will increase with the 

addition of extract. The results of microscopic (Figure 

6) observation of all formulas (F1 to F5) have a crystal 

shape with a heterogeneous structure and size. 

 

Table 8. Formulation of instant powder with the 

addition of combination extract number 2 

No. Materials 
Concentration % (w/w) 

F1 F2 F3 F4 F5 

1 Combination 

of Extracts 2 

1.22 2.44 3.66 4.88 6.10 

2 Sucralose 0.24 0.24 0.24 0.24 0.24 

3 Maltodextrin 

DE 18-20 

98.54 97.32 96.1

0 

94.8

8 

93.6

6 

 

 

Figure 5. The appearance of instant powder 

 

Figure 6. Microscopic appearance of instant powder on a micrometre slide (1 Division = 0.01 mm) 
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Figure 7.  Effect of adding Extract Combination No. 2 on Antioxidant Activity 

 

The effect of adding extract combination on the 

antioxidant activity can be seen in Figure 7. The instant 

powder antioxidant activity from formula F1 to formula 

F3 shows an increase in antioxidant activity marked by 

a decrease in the IC50 value. However, in formulas F3, 

F4, and F5, the increase in concentration is not directly 

proportional to the increase in antioxidant activity, 

which is shown by a graph that slopes toward the 

average. The saturation of the solution causes the 

phenomenon; the higher the concentration of the extract, 

the more precipitates are formed. In line with the theory, 

it is supported by the results of testing the clarity of the 

instant powder solution shown in Figure 8. The results 

of the clarity test show that the higher the extract 

concentration, the lower the percentage of transmittance 

(%T) will be. The decreasing value of %T shows the 

increasing value of turbidity. In addition, the result of 

qualitative sedimentation testing in Figure 9 shows that 

the higher the extract is added, the more sediment is 

formed. One of the efforts to increase the solubility of 

the extract in the instant powder is by adding surfactants 

such as PEG-40 HCO, a polyoxyethylene derivative of 

castor oil with an HLB value of 15. 

Instant powder formulation with PEG-40 HCO 

addition 

Based on optimization, adding extracts affects 

antioxidant activity and powder instant characteristics. 

Instant powder formula F5 produces the highest activity 

but low solubility. The decrease in solubility is caused 

by the high concentration of the extract so that saturation 

occurs. The solubility of formula F5 can be improved by 

adding surfactants, one of which is PEG-40 HCO. The 

addition of surfactant is expected to increase instant 

powder's solubility and antioxidant activity. The instant 

powder formula with the addition of PEG-40 HCO can 

be seen in Table 9. 

 

 

Figure 8. The effect of adding combination extract No. 2 on the clarity of the instant powder solution 

 

Table 9. Instant powder formula with the addition of PEG-40 HCO 

No. Materials 
Concentration % (w/w) 

F5a F5b F5c F5d F5e 

1 Extract Combination 2 6.10 6.10 6.10 6.10 6.10 

2 PEG 40 HCO 0.00 0.10 0.30 0.90 2.70 

3 Sucralose 0.24 0.24 0.24 0.24 0.24 

4 Maltodextrin DE 18-20 93.66 93.56 93.36 92.76 90.96 
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Figure 9. Instant powder solution sedimentation test results 

 

 

Figure 10. The appearance of instant powder with the addition of PEG-40 HCO 

 

 

Figure 11. Microscopic appearance of instant powder with the addition of PEG-40 HCO 

 

 

Figure 12. The loci of active compound (-) on surfactant micelle structure (Rangel-Yagui et al., 2005) 

 

The results of organoleptic observation (Figure 10) 

of the five formulas do not have any characteristic 

differences. The five formulas have a yellow colour, a 

typical bangle aroma, a sour, spicy, sweet taste, a 

powder form, and a smooth texture. Likewise, from the 

microscopic observation (Figure 11), the powder from 

formula F5a to formula F5e did not experience any 

change in morphology. Microscopically, instant powder 

has a crystal shape. 

The bias of the effect of adding excipients on 

antioxidant activity, all excipients were tested for 

antioxidant activity. The results were that PEG-40 HCO, 

maltodextrin DE 18-20, and sucralose did not have 

antioxidant activity. Clarity test results (Figure 13b) 

show that the higher the addition of PEG-40 HCO, the 

higher the %T, which means the more transparent the 

solution. The results of the sedimentation test can be 

seen in Figure 14. The higher the addition of PEG-40 

HCO, the less sediment formed, and the intensity of the 

yellow colour increases. The solubility test results show 

that all formulas (F5a to F5e) dissolve in less than 5 

minutes. The test results prove that adding PEG-40 HCO 

increases the solubility of the extract from the instant 

powder, which impacts the increase in antioxidant 

activity (Figure 13a). 

One of the reasons for using PEG-40 HCO is the 

ability to solubilize well ginger and bangle extracts 

containing water-insoluble oleoresin and curcumin, 

which PEG-40 HCO can enhance with a relatively small 

concentration of 2.70%. The phenomenon of increased 

solubility by surfactants is due to micellar solubilization. 

An important property of micelles that has a special 

meaning in pharmaceuticals is their ability to increase 

solubility, the spontaneous dissolution of a substance 

through a reversible interaction with surfactant micelles 

in water to form a thermodynamically stable isotropic 

solution (Sari & Nurihardiyanti, 2023). The extract is a 

multi-component that has hydrophilic to hydrophobic 

compounds. There are several possible solubility loci for 

active substances in micelles, as shown in Figure 12. 
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(a)                                                               (b) 

Figure 13. Effect of adding PEG-40 HCO to (a) antioxidant activity, and (b) clarity of solution instant powder 

 

 

      Figure 14. Effect of PEG-40 HCO addition on sediment formation 

 

 

Figure 15. Effect of adding PEG-40 HCO against the repose angle of the powder 

 

Hydrophilic compounds can be adsorbed on the 

surface of micelles (1); drugs with intermediate 

solubility should be placed in the middle position in 

micelles, such as between the hydrophilic head groups 

of micelles (2) and in the palisade layer between the 

hydrophilic group and the first few carbon atoms of the 

hydrophobic group, which is the outer core (3), and 

hydrophobic drugs that are not soluble at all can be 

placed in the micelle core (4) (Rangel-Yagui et al., 

2005). 

The angle of rest is one of the parameters of powder 

flow properties. Based on Figure 15, the higher the 

addition of PEG-40 HCO, the higher the angle of repose. 

An excellent quiet angle is 25-40o. So, in the formula 

F5c-F5e, the powder has a wrong angle of repose. The 

shape and size of the particles influence the angle of 

repose. The finer the particle size of a mass or material, 

the more difficult it is to flow and form an angle with a 

high slope. The larger the angle produced, the worse the 

powder flow quality is (Mehrabi et al., 2023). According 

to the theory, the addition of PEG-40 HCO (Figure 16) 

affects the flow rate; the higher the PEG-40 HCO is 

added, the more the powder flow rate decreases. The 

five formulas do not meet the requirements where the 

good powder has a flow speed of more than 10 

grams/second (Sarabandi et al., 2019). In addition, PEG-

40 HCO is a liquid substance that cannot be dried at the 

temperature of drying powder it can increase the 

cohesion and adhesion of particles. This is likely to be 
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one of the factors in the deterioration of the powder 

flow. 

The formulas of F5a-F5e have a pH in the range of 

4.16-4.20 (Figure 17); in this value degree, the formulas 

have an acidic nature due to the addition of lemon juice. 

The acidic pH value of the instant powder aims to 

increase the stability of the curcuminoids in the powder 

instant. Curcuminoids will decompose at neutral to 

alkaline pH (Zheng & McClements, 2020). Curcumin is 

more stable in oily or acidic pH environments 

(Martínez-Guerra et al., 2019; Zheng et al., 2017). 

The results of the powder density test can be seen in 

Figure 18. The Hausner ratio (Figure 18a) of all 

formulas (F5a to F5e) shows good characteristics 

(<1.25). The compressibility values (Figure 18b) of F5a, 

F5b, and F5c are in a poor category (26 to 31%), while 

the formulas F5d and F5e are in a reasonably good 

category (20 to 25%) (Kusumo & Mita, 2018). 

The proximate test was carried out on the formula 

with the highest antioxidant activity, the F5e formula. 

They were testing carried out in the Laboratory UNPAD 

Central. The test results can be seen in Table 10. 

 

Table 10. Proximate value of instant powder with the 

addition of PEG-40 HCO 

No. Parameters Concentration 

(%) 

Method 

1 Water content 5.58 Gravimetry 

2 Ash Content 0.10 Gravimetry 

3 Fat level 5.90 Soxhlet 

4 Protein 

Content 

0.21 Kjeldahl 

5 Carbohydrate 

Content 

88.21 By 

Difference 

6 Total Sugar 

Content 

18.09 Anthrone 

 

CONCLUSION 

Ginger and bangle have robust (IC50 = 23.57 ± 0.13 

µg/mL) and strong (IC50 = 64.89 ± 0.15 µg/mL) 

antioxidant activities, while lemon has weak activity 

(IC50 > 500 µg/mL). The combination of bangle ginger 

and lemon using the simple Axial method obtained 

combination No.2 with the composition ginger (4/6): 

bangle (1/6): lemon (1/6). This combination has 

moderate activity (121.90 µg/mL). Combination No. 2 

extracts can be formulated in instant powder. The 

formula with the highest antioxidant activity is the F5 

formula, with a concentration increase of 500 times the 

IC50 value. Adding PEG-40 HCO to the F5 formula aims 

to improve the solubility of the extract in instant powder. 

Results The addition of PEG-40 HCO affected the 

solubility of the extract and antioxidant activity. After 

adding PEG-40 HCO, the solubility and antioxidant 

activity increased. However, with the addition of PEG-

40 HCO, some of the characteristics of the instant 

powder experienced a decrease in quality, such as angle 

of repose, flow time, and compressibility. 
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Abstract 

Background: Using natural ingredients as antivirals can be considered a treatment for SARS-CoV-2. One of the 

potential plants, mahogany (Swietenia macrophylla King), is widely used in various countries as an antiviral 

treatment. Paparin-like protease (PLpro) is an essential cysteine protease that regulates viral replication and 

interferes with the regulation of immune sensing. Objective: This study aims to predict which compounds in the 

mahogany plant have good affinity, patterns, and stability interaction against the target protein of SARS-CoV-2. 

Methods: The drug-likeness parameter using SwissADME was used to screen compounds that will be docked 

against PLpro using the Autodock program. The parameters observed in molecular docking analysis are the value 

of bond energy and interaction model to amino acid residues. The compounds in mahogany plants that have the 

best interactions were then analyzed using molecular dynamics simulation methods to determine the stability of 

their bonds based on the values of Root Mean Square Deviation (RMSD) and Root Mean Square Fluctuation 

(RMSF). Results: Twenty-two compounds met the drug-likeness requirements. Molecular docking analysis showed 

that the compounds predicted to have the best binding affinity and have an interaction pattern similar to natural 

ligands towards the molecular target of PLpro are 7-deacetoxy-7-oxogedunin and 3β-hydroxy-stigmast-5-en-7-

one. The molecular dynamics simulation results revealed that based on the RMSD and RMSF values, the compound 

3β-hydroxy-stigmast-5-en-7-one showed higher stability than 7-deacetoxy-7-oxogedunin. Conclusion: 3β-

hydroxy-stigmast-5-en-7-one and 7-deacetoxy-7-oxogedunin were predicted to have good interaction with PLPro; 

however, 3β-hydroxy-stigmast-5-en-7-one showed the higher interaction stability. 
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INTRODUCTION 

Coronavirus disease 2019 (Covid-19) is caused by 

Severe Acute Respiratory Syndrome Coronavirus 2 

(SARS-CoV-2). This disease emerged in Hubei 

Province, China (Yu et al., 2020). SARS-CoV-2 causes 

respiratory problems similar to those caused by the 

Severe Acute Respiratory Syndrome Coronavirus 

(SARS-CoV) in 2003 and the Middle East Respiratory 

Syndrome Coronavirus (MERS-CoV) in 2012. All three 

come from the Coronaviridae, a family of viruses that 

have an RNA genome with a single positive sense strand 

(Tu et al., 2020). Globally, the weekly number of 

COVID-19 cases was from October 31 to November 6, 

2022, with more than 2.1 million new cases reported. 

Weekly death toll, with around 9400 deaths reported. As 

of November 6, 2022, 629 million confirmed cases and 

6.5 million deaths have been reported globally (WHO, 

2022). According to data from the COVID-19 Handling 

Task Force, as of November 16, 2022, there were 6 

million positive cases and 159 thousand deaths (Satgas 

Penanganan Covid-19, 2022). 

Several treatment approaches have been made to 

inhibit SARS-CoV-2. Remdesivir can inhibit SARS-

CoV-2 infection, as can nafamostat, which is a MERS-

CoV inhibitor, which can prevent membrane fusion and 

inhibit SARS-CoV-2 infection (Wang et al., 2020). The 

re-use of drugs, including antiviral agents (ivermectin, 

nitazoxanide, lopinavir, remdesivir, tocilizumab), 

supporting agents (azithromycin, corticosteroids, 

vitamin C, vitamin D), and vaccines, is being tried to 

meet the urgent demand against the COVID-19 

pandemic (Chen et al., 2022). 

Apart from using synthetic antivirals, the use of 

natural ingredients as antivirals can also be considered 

as a treatment for SARS-CoV-2. A number of active 

compounds from natural products have shown potential 

antiviral activity (Septiana, 2020). One of them worthy 

of research is the mahogany plant (Swietenia 

macrophylla King). Mahogany belongs to the Meliaceae 

family. Mahogany is widely used in various countries as 

a treatment for antivirals. Toona sinensis leaves, which 

are also included in the Meliaceae family, have antiviral 

effects against SARS-CoV (Petrera, 2015). There are 

various compounds in mahogany, such as polyphenols, 

fatty acid esters, essential oils, steroids, lignans and 

limonoids (Moghadamtousi et al., 2013). In general, 

polyphenols are believed to have various uses, such as 

antioxidants, anti-inflammatories, antivirals, and 

antibacterials (Mulu et al., 2021). Limonoids, as 

triterpenoid derivatives, have activity as antiviral, 

antifungal, antibacterial, anticancer, and antimalarial 

(Vardhan & Sahoo, 2020). As an antiviral, 3-hydroxy 

caruilignan C (3-HCL-C) isolated from S. macrophylla 

stems causes a decrease in protein and RNA levels, 

thereby interfering with hepatitis C virus replication 

(Musarra-Pizzo et al., 2021). From various databases 

and references, 22 compounds contained in the 

mahogany plant have been collected. However, it is not 

yet known how the antiviral mechanism action of the 

mahogany plant. Studies are needed to determine which 

of these compounds play a role in antiviral activity and 

the target proteins of these compounds. 

Drug development efforts can be carried out by 

molecular modelling or in silico tests, which play a role 

in designing, discovering, and optimizing bioactive 

compounds in the drug development process. The in 

silico test can be carried out by means of molecular 

docking, which functions to predict the activity of a 

compound in target cells. The docking will align the 

ligand into the target cell and produce a bond energy 

value indicating the amount of energy required to form 

the bond between the ligand and the receptor. The lower 

the bond energy, the stronger the bond. The stronger the 

link between the ligand and the receptor, the more active 

it is. (Kesuma et al., 2018). It is now known that there 

are many potential targets for anti-SARS-CoV-2 work, 

one of which is PLpro (paparin-like protease), which 

functions to split polyprotein replication into non-

structural proteins (Chen et al., 2022). After carrying out 

molecular docking, proceed with Molecular Dynamics 

(MD) Simulations. The MD simulation aims to 

determine the stability of the ligand-receptor interaction; 

this is done because molecular docking has not been able 

to provide information regarding the stability of the 

ligand-receptor interaction in space and time (Dewi et 

al., 2022). 

This study will carry out an analysis of the 

molecular docking of compounds in mahogany plants 

that have been screened for drug-likeness as test ligands 

for the protein PLpro of the SARS-CoV-2 virus. 

Molecular docking was carried out using Autodock 4 

software, the MGL tool, and Biovia Discovery Studio as 

visualization tools. Ligand-protein interactions and the 

best pattern of amino acid residues will be followed by 

MD simulation testing using Yasara software so that the 

stability value of the ligand-protein bond is obtained. 

 

MATERIALS AND METHODS 

Materials 

The material used in this study was the SMILES 

code of the test ligand obtained from PubChem, which 

was made in a three-dimensional structure using the 
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VEGA ZZ application. The three-dimensional structure 

of the macromolecule, namely PLpro (PDB ID: 7QCG), 

was downloaded from the Protein Data Bank (RCSB 

PDB). 

Tools 

The tools used in this study were a set of TOSHIBA 

Dynabook B35/Y with Intel(R) Core(TM) i5-5200U 

Processor specifications, 8.0 Giga Byte RAM, 500 Giga 

Byte SSD hard disk, Intel(R) HD Graphics Graphics 

Card 5500, AutoDock 4.0, AutoDockTool, Biovia 

Discovery Studio, VEGA ZZ, Notepad++, SwissADME 

(http://www.swissadme.ch/), and YASARA Dynamics. 

Method 

Test ligand screening 

The drug-likeness parameter of the mahogany plant 

compound was conducted using the SwissADME 

webserver (http://www.swissadme.ch/) to screen the 

compounds before the molecular docking analysis 

process. Canonical SMILES of mahogany plant 

compounds were obtained from PubChem. The 

Canonical SMILES code was copied and pasted into the 

"Enter a list of SMILES here" box, and the "Run!"  

button was clicked. The drug-likeness profile of the 

compound was carried out to determine whether a 

compound meets the requirements as an oral drug 

candidate or not (Daina et al., 2017). 

Preparation of the three-dimensional structure of the 

test ligand 

The three-dimensional structure of the test ligands 

was created using the VEGA ZZ application. The first 

step was to copy the Canonical SMILES test ligand from 

PubChem and then paste it into Vega ZZ by selecting 

the Edit > Build > SMILES menu. The SMILES code 

obtained from PubChem was then pasted into the 

dialogue box that appears, then clicked Build. After that, 

select the Calculate > Charge & Potential menu, and a 

dialogue box will appear. In the Force Field section, 

select "AUTODOCK", and in the Charges section, 

select "Gasteiger", then click "Fix". Then, minimize it 

by choosing the Calculate > Ammp > Minimization 

menu. In the Minimization Steps box, enter 10,000 and 

then run. The three-dimensional structure obtained is 

then saved in the.pdb format for molecular anchoring; if 

it is still in the form of a two-dimensional structure, it 

must first be converted into a three-dimensional 

structure by clicking Edit > Coordinates > Convert to 

3D. 

Test ligand preparation 

The preparation of the test ligand structures was 

carried out using AutoDockTools to add hydrogen 

atoms and charges to the ligands. First, open the three-

dimensional structure of the test ligand by selecting the 

File menu > Read molecule, then selecting Edit > 

Hydrogens > Add menu. After that, select "All 

Hydrogens", "noBondOrder", and "Yes" in the Add 

Hydrogens dialogue box that will appear. Then select 

the Edit menu again > Charges > Compute Gasteiger. 

The next step is to create a ligand file in the pdbqt format 

by selecting the Ligand > Input > Choose menu, 

selecting the prepared ligand file, and then selecting 

"Select Molecule for AutoDock4". Then select the 

Ligand menu > Torsion tree > Detect root to identify the 

ligand root. After that, select the Ligand > Torsion tree > 

Choose Root menu, then select the Ligand > Torsion 

tree > Choose Torsions > Done menu to identify the 

number of the torque. Then select Ligand > Torsion 

tree > Set Number of Torsions > Dismiss. Then select 

the Ligand menu > Output > Save as file with the pdbqt 

format. 

Macromolecules download 

The 3D structure of the receptor used, the PLpro 

protein (PDB ID: 7QCG) was downloaded from the 

RCSB PDB website (https://www.rcsb.org/). The 3D 

structure of the protein is downloaded in ".pdb" file 

format. The file is then saved in the work folder. 

Macromolecular preparation 

Macromolecule preparation was carried out using 

Biovia Discovery Studio. First of all, open the 

macromolecule file by selecting File > Open from the 

menu. Then pressed CTRL+H simultaneously so that 

the protein molecules appeared. Clicked Water > Delete 

to remove the water molecules. The next step is to 

separate the macromolecular complex into individual 

protein (receptor) and ligand files by clicking on Ligand 

Groups > selecting native ligand > Copy > Paste in the 

new Molecule Window, and then saving as (ligand 

name).pdb, the resulting ligand file is obtained. 

separated from the protein. After that, return to the initial 

molecule window and select Ligand Group > Delete, to 

remove natural ligands. Then select Hetatm > Delete to 

remove other residues (if any). 

Then, the protein files that have been separated 

from their natural ligands are added hydrogen and cargo 

using AutoDockTools by selecting the menu File > Read 

Molecule > Edit > Hydrogens > Add. After that, select 

"Polar Only", "noBondOrder", and "Yes" in the Add 

Hydrogens dialogue box that will appear. Then select 

the Edit menu again > Charges > Add Kollman Charges. 

The next step is to create a protein file with the .pdbqt 

format, which will be used to determine the grid 

parameters, by selecting the Grid > Macromolecule > 

Choose menu, selecting the protein file that has been 
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prepared, then selecting "Ok" and save the file with the 

format name .pdbqt. 

Furthermore, the preparation of the native ligand 

structure first opens the three-dimensional structure file 

of the native ligand, which has been separated from the 

protein by selecting the File > Read molecule menu, 

then selecting Edit > Hydrogens > Add menu. After that, 

select "All Hydrogens", "noBondOrder", and "Yes" in 

the Add Hydrogens dialogue box that will appear. Then 

select the Edit menu again > Charges > Compute 

Gasteiger. The next step is to create a ligand file in 

the .pdbqt format by selecting the Ligand > Input > 

Choose menu, selecting the prepared ligand file, and 

then selecting "Select Molecule for AutoDock4". Then 

select the Ligand menu > Torsion tree > Detect root to 

identify the ligand root. After that, select the Ligand > 

Torsion tree > Choose Root menu, then select the 

Ligand > Torsion tree > Choose Torsions > Done menu 

to identify the number of the torque. Then select 

Ligand > Torsion tree > Set Number of Torsions > 

Dismiss. Then select the Ligand menu > Output > Save 

as file with the .pdbqt format. The .pdbqt files of 

macromolecules and ligands, the autodock4.exe and 

autogrid4.exe application files, and the 

AD4.1_bound.dat files (obtained from 

https://autodocksuite.scripps.edu/force-fields/) are 

placed in the same folder. 

Molecular tethering method validation 

In this validation process, we will compare the 

conformation of the natural ligand to the receptor in the 

experimental crystallographic structure with the 

conformation of the natural ligand that is redocked to the 

receptor using AutoDockTools by setting the Grid box 

x, y, z, centre x, y, z, spacing by default. The results of 

this comparison are expressed by the root mean square 

deviation (RMSD) value. The docking method is said to 

be valid if the RMSD value is ≤ 2Å. If the RMSD value 

obtained is greater than 2 Å, then the procedure used is 

invalid, so the Grid box x, y, z, and centre x, y, z spacing 

values are adjusted manually until RMSD ≤ 2Å is 

obtained. 

Molecular docking process 

The molecular docking process was carried out 

using AutoDock4.0 (AD4.0) and AutoDockTools 

(ADT). Protein and ligand structures that have been 

optimized separately are stored in the same folder. 

Before carrying out the docking process, a grid 

parameter file is first prepared with the following steps: 

select Grid > Macromolecule > Open: protein file 

format .pdbqt. Then select the menu Grid > Set Map 

Types > Open: ligand file (native ligand during the 

Validation process) format .pdbqt. Then select the 

Grid > Grid box menu, then select the Center > Center 

on ligand menu (for Default validation) and set the size 

x, y, z, centre x, y, z, and spacing in the Grid Options 

dialogue box that will appear (Following the Grid value 

Validation box for test ligands). Then select the File 

menu > Close saving current, then select the Grid > 

Output > Save GPF menu and save it in the .gpf format. 

You need to pay attention to naming the file because 

wrong naming will not make docking work. The next 

step is to run Autogrid by clicking the Run menu > Run 

AutoGrid, then on "Program Pathname" select the file 

"autogrid4.exe" while on "Parameter Filename" select 

the file with the ".gpf" format earlier, then click 

"Launch" and wait for the process walk to finish. After 

the autogrid process is complete, the next step is to 

prepare a docking parameter file with the following 

steps, selecting the Docking > Macromolecule > Set 

Rigid Filename menu and selecting a protein file with 

the .pdbqt format. Then select the Docking menu > 

Ligand > Choose > Select the ligand > Select Ligand > 

Accept. Next, determine the docking parameters by 

selecting the Docking menu > Search Parameters > 

Genetic Algorithm, setting the Number of GA Runs to 

100, and setting the Population Size to 150 in the 

dialogue box that will appear, then clicking Accept. 

After that, select the Docking menu > Docking 

Parameters > Accept. Then select the Docking menu > 

Other Options > AutoDock4.2 Parameters > a Set 

Autodock4.2 Options box will appear > in the Include 

Parameter_file in dpf click "Yes" > in the Enter 

Parameter_File section, it is written 

"AD4.1_bound.dat". Then select the Docking > 

Output > Lamarckian GA menu and save it in the .dpf 

format. The next step is to run Autodock by clicking the 

Run menu > Run AutoDock, then on "Program 

Pathname" select the file "autodock4.exe" while on 

"Parameter Filename" select the file with the ".dpf" 

format earlier, then click Launch and wait for the 

process to run until finished. The docking results 

obtained were then analyzed and visualized using the 

Biovia Discovery Studio. 

Molecular dynamics simulation process 

The two best test ligands that have the smallest 

bond-free energy values and amino acid residues that are 

similar to the native ligands (If a compound has the best 

or smallest bond-free energy values but does not interact 

with amino acid residues that are similar to the native 

ligand, then the compound has the best interaction 

pattern and cannot be said to have the same activity as 



Jurnal Farmasi dan Ilmu Kefarmasian Indonesia Vol. 10 No. 3 December 2023      351 

 

 
P-ISSN: 2406-9388   ©2023 Jurnal Farmasi dan Ilmu Kefarmasian Indonesia 

E-ISSN: 2580-8303  Open access article under the CC BY-NC-SA license 

natural ligands) are followed by MD simulation tests. 

The MD simulation process is carried out using 

YASARA Dynamics. The structures of the test-protein 

ligand complex and the native-protein ligand complex 

are placed in the same folder. Before running the 

program, set the script to "md_run.mcr" with 0.9% 

NaCl, pH 7.4, at a temperature of 298K, and the 

simulation duration is 20 ns and uses ForceField 

AMBER14 (Parihar et al., 2022; Shree et al., 2022). 

After that, proceed with running the YASARA program. 

Then select the menu Options > Macro & Movie > Set 

Target (select the target you want to analyze in .pdb 

format). Next, re-select the menu Options > Macro & 

Movie > Play Macro > md_run.mcr > OK (pre-set 

script) and wait for the process to run until it finishes 

automatically. After the process is complete, an analysis 

of the ligand-protein is carried out by selecting the 

Options menu > Macro & Movie > Set Target (selecting 

the target to be analyzed in .pdb format). Then select 

Option > Macro & Movie > Play Macro > 

md_analyze.mcr > OK, wait for the process to run until 

it's finished. The data obtained were analyzed for RMSD 

and RMSF values. 

 

RESULTS AND DISCUSSION 

Test ligand screening 

Drug-likeness screening qualitatively assesses the 

possibility of a molecule becoming an oral drug in terms 

of bioavailability using the SwissADME website. At 

SwissADME, there are five Drug-likeness filters, 

namely Lipinski, Ghose, Veber, Egan, and Muegge. In 

this study, the Lipinski filter was chosen because 

Lipinski analyzed 2,245 drugs from the World Drugs 

Index database, and this filter is known as Lipinski's 

rule-of-five (Lipinski et al., 1997). 

Based on Table 1, it can be seen that there were 22 

compounds tested for drug-likeness that were predicted 

to have the opportunity to become oral drugs, although 

of the 22 compounds, there were some that violated or 

did not meet the requirements. However, this is tolerable 

because each compound only violates one rule. 

According to Lipinski's rules, in general, a drug can be 

administered in oral if it does not violate more than one 

criterion (Lipinski et al., 1997). Drug-likeness is based 

on oral drugs because oral administration of drugs is one 

of the most commonly used methods in clinical practice. 

Oral medications can be taken easily by patients, do not 

require special medical assistance, and usually provide 

greater convenience compared to other routes of 

administration (Santos et al., 2016). 

Preparation of three-dimensional structures and 

preparation of test ligands and macromolecules 

The canonical SMILES code of 22 compounds in 

mahogany obtained from Pubchem was then made into 

a three-dimensional structure using the VegaZZ 

application. The three-dimensional structure of the 

target protein was obtained from the Protein Data Bank 

with a PDB code and 7QCG 1.75 Å (PLpro) resolution. 

This macromolecule meets the criteria, namely having a 

three-dimensional structure obtained from 

crystallographic X-ray results with a resolution of < 3 Å 

(Mukherjee et al., 2010; Sándor et al., 2010). The 

macromolecule used is already complex with its natural 

ligands, so it is easy to determine the active side of the 

macromolecule. 

Molecular docking method validation 

Method validation was carried out to determine 

whether the molecular docking method used was 

reliable or valid by comparing the crystallographic 

conformation of the natural ligand and the natural ligand 

that was reddocked against the target protein using 

AutodockTools. The validation process needs to 

determine the grid box or central coordinates, where the 

interaction of the ligand and protein is known as the 

active site of the protein. The centre of the grid box is 

generally determined based on the centre of mass of the 

naturally occurring ligand, while the dimensions of the 

grid box are based on the size of the ligand and the 

binding site on the protein that contains the essential 

amino acids for the protein's activity. The centre and 

gridbox dimensions of the macromolecules used in this 

study can be seen in Table 2. Parameters observed in the 

validation process were RMSD values and interactions 

that occurred between the crystallographic ligands and 

the redocked ligands with residues of target protein 

amino acids. The smaller the RMSD value, the closer 

the ligand position is to the natural ligand conformation. 

An RMSD value < 2 Å indicates that the error of the 

calculation results is smaller, so that the calculation can 

be said to be more accurate, whereas an RMSD value > 

2 Å indicates that the deviation from the calculation 

results is more remarkable so that the docking results 

obtained cannot be used as a reference (Mukherjee et al., 

2010; Sándor et al., 2010). 
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Table 1.  Drug-likeness prediction results (Moghadamtousi et al., 2013) & (http://ijah.apps.cs.ipb.ac.id/) 

Compound 

Lipinski Rules Parameter 

Molecular 

weight ≤ 500 

MLOGP ≤ 

4,15 

N or O ≤ 

10 

NH or OH 

≤ 5 
Results 

Secomahoganin     Yes 

12α-Acetoxyswietephragmin D     No 

12α-Acetoxyswietephragmin C     No 

Swietenialide D     No 

7-deacetoxy-7-oxogedunin     Yes 

6-O-Acetylswietephragmin E     No 

Swietenitin A     No 

Swietenitin B     No 

Swietenitin C     No 

Swietenitin D     No 

Swietenitin E     No 

Swietenitin F     No 

Swietenitin G     No 

Swietenitin H     No 

Swietenitin I     No 

Swietenitin J     No 

Swietenitin K     No 

Swietenitin L     No 

Swietenitin M     No 

Swietenolide     Yes 

Swietenine     Yes 

Swietenolide diacetate     Yes 

3β,6-Dihydroxydihydrocarapin     Yes 

Augustineolide     No 

Andirobin     Yes 

Proceranolide     Yes 

3,6-O,O-diacetylswietenolide     Yes 

Swietenolide monohydrate     Yes 

Swietemacrophine     No 

1-O-Acetylkhayanolide B     No 

Epoxyfebrinin B     No 

Roxburghiadiol A     Yes 

β-Sitostenone     Yes 

3β-hydroxy-stigmast-5-en-7-one     Yes 

β-Sitosterol     Yes 

Stigmasterol     Yes 

γ-Himachalene     Yes 

Cadina-1,4-diene     Yes 

Swietemacrophyllanin     Yes 

Catechin     Yes 

Epicatechin     Yes 

Scopoletin     Yes 

3-Hydroxy Caruilignan C     Yes 

Information: Yes = Meets the requirements (violated 1 rule), No = Does not meet the requirements (violated > 

1 rule),  = complies with Lipinski’s rule,  = does not comply with Lipinski's rule 

 

Table 2. Gridbox parameters 

Macromolecular 

Code 

Gridbox 

Center Dimensions (Å) 

X Y Z X Y Z 

7QCG 69,93 28,744 -29,08 40 40 40 
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Table 3.  Redocking result from RMSD value 

Target Protein 

Name 
Natural ligands PDB code RMSD (Å) Condition 

PLpro AKOS003853619 7QCG 1.391 < 2 Å 

 

 
Figure 1.  Crystallographic (red) and Redocked (yellow) ligand overlay results 

 

Table 4.  Redocking result from RMSD value 

Compound 

Bond 

Energy 

(kcal/mol) 

           

Amino Acid Residues 

Hydrogen Bonds 

Involved in Interactions 

Besides Hydrogen Bonds 

AKOS003853619 

(native ligand) 

-4,32 Met206, Ser170, Arg166 Gln174, Met208, Tyr207, Arg183, 

Leu199, Glu203, Val202 

7-Deacetoxy-7-

oxogedunin 

-7,55 Arg166, Lys232 Val202, Gln174, Ser170, Met208, 

Phe216, Leu185, Tyr207, Leu199, 

Arg183, Met206, Glu203 

3β-hydroxy-

stigmast-5-en-7-

one 

-7,36 - Tyr171, Gln174, Glu203, Leu185, 

Lys232, Leu199, Tyr207, Met208, 

Met206, Val202, Arg166, Ser170, 

Glu167 

Bold: similarity of amino acids interacting with natural ligands. 

 

Based on the RMSD values and the overlay of the 

redocking results of the four natural ligands on their 

target proteins in Table 3 and Figure 1, it can be seen 

that the positions of the redocked ligands are close to 

those of the crystallographic ligands and occupy the 

same active sites because they interact with amino acids, 

which also interact with the crystallographic ligands. 

The redocking process is important because it helps 

validate the docking method and assess its accuracy. In 

molecular docking, the process of redocking occurs 

when the ligand (molecule under test) is placed back into 

the active site of the target protein after calculating its 

initial energy and placement. If the redocking ligand 

approaches the crystallographic ligand position, 

occupies the same active position, and interacts with 

amino acids that also interact with crystallographic 

ligands, this indicates consistency between the docking 

results and the crystallographic structure (de Oliveira et 

al., 2022; Venkatesh, 2022). These results suggest that 

the docking method used is valid and that the protein and 

ligand docking processes can be carried out using 

AutodockTools. 

Analysis of molecular docking results 

Based on this study, 22 compounds in the 

mahogany plant were tethered to the target protein using 

the molecular docking method, namely AutodockTools. 

Molecular docking aims to predict the binding mode and 

affinity of a small molecule for the active site of a 

particular target protein, and the result is a value that 

describes the bond-free energy, i.e., the amount of 

energy required by the ligand to form a bond with the 

receptor (Guedes et al., 2013). Evaluation of the test 

ligand in molecular docking involves assessing a 

number of factors, including the free bond energy and 

the similarity of the amino acid residue to the natural 

ligand. These two factors play a role in the selection of 

ligands that have the potential to bind specifically and 

effectively to the target protein. Bond energy is one of 

the most critical factors in determining the stability of 

the ligand-receptor complex (de Oliveira et al., 2022). 

Lower free bond energy values tend to be better at 

molecular docking. The lower the free bond energy 

value between the target molecule and the ligand, the 

more stable the bond complex is (Kurczab, 2017). The 

similarity of the amino acid residues of the test ligands 

with the natural ligands in the target protein can increase 

the chances of producing, suitable binding complexes. 

This is because the binding of natural ligands to the 

target protein is determined by specific interactions 

between the ligand and amino acid residues in the active 

site of the protein (Wu & Huang, 2023). 
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Figure 2. Interaction diagram of the test ligand compared to the natural ligand; (A) AKOS003853619 (natural ligand), 

(B) 7-Deacetoxy-7-oxogedunin, and (C) 3β-hydroxy-stigmast-5-en-7-one 

 

Based on Table 4, two compounds have lower bond 

energies and interact with amino acid residues that are 

similar to natural ligands. AKOS003853619, which is a 

natural inhibitor and ligand of 7QCG, interacts with 

amino acid residues present on the active side through 

hydrogen bonds, van der Waals bonds, π-alkyl bonds, 

and salt bridges (Figure 2). According to Ewert et al. 

(2022), natural ligands in 7QCG form hydrogen bonds 

with Arg166, Ser170, and Met206 and form additional 

side chains with Gln174. n. The interaction of the 

Glu203 side chain achieves further stabilization. In the 

context of protein structure, the number associated with 

an amino acid, such as "Glu203", refers to the position 

of that amino acid in the protein sequence. This number 

is used to identify and refer to specific amino acids in 

protein structures, especially when discussing their 

functional properties or locations (Pulido et al., 2014). 

Compound 7-deacetoxy-7-oxogedunin has the 

lowest bond-free energy value in PLpro protein, 

followed by 3β-hydroxy-stigmast-5-en-7-one. The 

values of the two test ligands were smaller when 

compared to AKOS003853619 (Table 4) because there 

were more amino acid residues that interacted with the 

two test ligands than with the natural ligands. 

Compound 7-deacetoxy-7-oxogedunin has a smaller 

free bond energy value compared to 3β-hydroxy-

stigmast-5-en-7-one because 7-deacetoxy-7-

oxogedunin has the same amino acid residue as the 

natural ligand, while 3β -hydroxy-stigmast-5-en-7-one 

lacks one residue similar to that of the natural ligand 

(Table 4). 

Based on the results of molecular docking, the two 

best test ligands on the target protein have the potential 

as anti-SARS-CoV-2 candidates because these test 

ligands interact with the identical amino acid residues as 

the natural ligands of the target protein. The results of 

molecular docking indicated that several compounds 

from the mahogany plant had interactions with the tested 

molecular targets. Some of them have better free bond 

energy values than natural ligands. A compound can be 

known to have activity against a target protein by 

observing two parameters, namely bond energy and 

interaction pattern. If a compound has the best bond 

energy value but does not interact with amino acid 

residues that are similar to natural ligands, then the 

compound does not have the best interaction pattern and 

cannot be said to have the same activity as natural 

ligands (Salem et al., 2023). Next, the two best test 

ligands will be subjected to MD simulation tests to find 
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out whether the tested ligands have good bond stability 

with macromolecules compared to natural ligands. 

Analysis of molecular dynamics simulation results 

Based on this study, two compounds in the 

mahogany plant were tethered to the target protein using 

the MD simulation method, namely YASARA 

Dynamics. MD simulation aims to study the movement 

and interaction of atoms in a molecular system. These 

simulations provide a deeper understanding of the 

physical and chemical properties of molecules, 

including their structure, stability, dynamics, and 

reactivity. The stability of the ligand-protein bond can 

be determined by calculating the RMSD and RMSF 

values (Patel et al., 2021). Prior to the start of the 

analysis, the simulation conditions were set with 0.9% 

NaCl, pH 7.4, at a temperature of 298K, and the duration 

of the simulation was 20 ns. Setting 0.9% NaCl, pH 7.4, 

at 298K is often used in laboratory practice to try to 

replicate environmental conditions similar to those of 

the human body. A simulation time of 20 ns can provide 

initial insight into the stability of the RMSD and RMSF 

(Parihar et al., 2022; Shree et al., 2022). 

RMSD analysis involves a comparison of the 

conformational change of the simulated system with the 

initial or experimental structure. Monitoring RMSD 

over time makes it possible to assess system stability and 

identify periods of equilibrium and fluctuation. Higher 

RMSD values indicate more significant structural 

deviation from the reference structure, indicating 

increased flexibility or conformational changes. RMSF 

measures the flexibility or local mobility of individual 

atoms or residues in a biomolecular system during an 

MD simulation. It provides information about regions 

that undergo significant conformational changes or 

exhibit high flexibility. Atoms with a low RMSF show 

stability and a lack of fluctuation, while atoms with a 

high RMSF show greater flexibility or movement (Wu 

et al., 2022). 

 

 

Figure 3.  Comparison of RMSD values between native ligand (red), 7-deacetoxy-7-oxogedunin (black), and 3β-

hydroxy-stigmast-5-en-7-one (blue) 

 

 

Figure 4.  Comparison of RMSF values between AKOS003853619 (red), 7-Deacetoxy-7-oxogedunin (black), and 3β-

hydroxy-stigmast-5-en-7-one (blue). (amino acid residue number = Met206, Ser170, Arg166, Gln174, Met208, Tyr207, 

Arg183, Leu199, Glu203, and Val202) 
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Table 5.  Redocking result RMSD 

 
Average (Å) 

Native Ligand 7-deacetoxy-7-oxogedunin 3β-hydroxy-stigmast-5-en-7-one 

RMSD (Å) 3.423 ± 0.833 4.902 ± 1.697 4.250 ± 0.684 

RMSF (Å) 1.182 ± 0.668 1.230 ± 0.727 1.247 ± 0.678 

 

CONCLUSION 

Based on Figure 3, the natural protein-ligand 

complex is more stable than 7-deacetoxy-7-oxogedunin 

and 3β-hydroxy-stigmast-5-en-7-one. This result can 

also be proven by the RMSD average value of the 

natural ligand, which is smaller than 7-deacetoxy-7-

oxogedunin and 3β-hydroxy-stigmast-5-en-7-one 

(Table 5). Based on the results of the graphs and 

averages, it can be seen that the stability of the 3β-

hydroxy-stigmast-5-en-7-one ligand with the PLpro 

protein is close to the stability of the bond of the natural 

protein-ligand complex. Meanwhile, the graph of 7-

deacetoxy-7-oxogedunin began to increase at 11 ns, 

which means that the stability of the bond decreased. If 

the RMSD value is below 5 Å (Angstrom), it can be said 

to be a relatively stable value in molecular dynamics 

simulations. In contrast, if it is above 5 Å, it indicates 

significant conformational changes and large structural 

changes and means low stability (Rudnev et al., 2022). 

The flexibility of the structure of each compound can 

influence conformational changes over time. 

Compounds with stable and well-defined structures 

throughout the simulation are likely to have better 

stability. The presence of intermolecular forces 

involved, such as hydrogen bonds, van der Waals 

interactions, and electrostatic interactions, can also 

influence the stability and bond energy values. High 

RMSD values can be affected by various conditions, 

such as temperature and pH, and also by interactions 

between the ligand-protein; this can change the 

structural conformation of the ligand-protein bond so 

that the stability becomes poor (Kordzadeh & 

Saadatabadi, 2022; Oliwa & Shen, 2015). The lower the 

RMSD value, the more stable the bond between the 

ligand and the protein, and it shows that the two 

structures (natural ligand and 3β-hydroxy-stigmast-5-

en-7-one) are more similar to each other (Guterres & Im, 

2020). 

Based on Figure 4, the test ligands 7-deacetoxy-7-

oxogedunin and 3β-hydroxy-stigmast-5-en-7-one have 

RMSF graphs that are almost similar to the test ligands. 

The natural protein-ligand complexes were more stable 

than the tested ligands, as indicated by the lower RMSF 

values of natural ligands than 7-deacetoxy-7-

oxogedunin and 3β-hydroxy-stigmast-5-en-7-one 

(Table 5). The RMSF value will outline the 

conformational shifts of each amino acid residue, which 

gives an idea of its flexibility. The lower the RMSF 

value, the more stable the positions of the ligands and 

amino acids are (Elfita et al., 2022). Based on the RMSF 

results, the amino acid residues of natural ligands such 

as Met206, Ser170, Arg166, Gln174, Met208, Tyr207, 

Arg183, Leu199, Glu203, and Val202 did not change 

and remained stable. Likewise, the amino acid residues 

in the test ligands 7-deacetoxy-7-oxogedunin and 3β-

hydroxy-stigmast-5-en-7-one were similar to the natural 

ligands, did not change and remained stable. Docking 

and MD results may differ because docking only 

evaluates binding energy or binding affinity. MD, on the 

other hand, stresses the ligand-protein complex's long-

term stability (Chen, 2014). 
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Abstract 

Background: Access, Watch, and Reserve (AWaRe) antibiotics classification was released in 2019 by the World 

Health Organization (WHO) to enhance antimicrobial stewardship programs in all healthcare facilities. As a 

result, WHO advises global action to increase the availability of antibiotics from the Access group by more than 

60%.Objective: to determine antibiotics consumption for outpatients at a public tertiary hospital in Bengkulu, 

Sumatera-Indonesia, from 2018 to 2022, focusing on antibiotics from Access class according to the AWaRe 

classification from WHO and Ministry of Health Republic of Indonesia (MoHRI). Methods: This is a cross-

sectional survey analyzing aggregate data on antibiotics use for outpatients at the hospital during the study period. 

Data on antibiotics were collected from the hospital pharmacy department, while data on patient visits were 

collected from the medical records department.  The quantity of antibiotics used was calculated using the 

ATC/DDD method and expressed in DDD/1000 patient-day (PD), which was then converted into a percentage. 

Results: During the study period, 50-60% and 65-73% out of 14-19 antibiotic agents are from Access class 

according to WHO and MoHRI AWaRe classification, respectively. Quantitatively, according to the WHO and 

MoHRI AWaRe classification, the consumption of antibiotics from the Access class was 25-50% and 33-71% of 

total consumption, respectively. In addition, the segment of drug utilization 90% (DU90%) of antibiotics was 

dominated by antibiotics from Watch class. Conclusion: The hospital has not yet met the WHO target for antibiotic 

consumption from the Access class, highlighting the need for some effective efforts from Watch class to limit the 

usage of antibiotics. 
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INTRODUCTION 

The prevalence of antimicrobial resistance (AMR) 

has become a significant threat to global public health 

(Nwobodo et al., 2022; Xiao, 2023), and it was 

estimated that the number of AMR-related fatalities in 

2019 was 4.95 million globally (Daneman et al., 2023; 

Wilson et al., 2022). Ranjbar et al. (2022) listed 

Escherichia coli, Staphylococcus aureus, Klebsiella 

pneumoniae, Streptococcus pneumoniae, and 

Acinetobacter baumannii as the six most lethal 

pathogens associated with antibiotic resistance. The 

overuse of antibiotics and high prescription of broad-

spectrum antibiotics have been known to be  the 

development of AMR (Dadgostar, 2019). Nationally, in 

Indonesia, high empirical use of broad-spectrum 

antibiotics and inadequate adherence to 

recommendations have been reported from a survey 

investigating antibiotics in six hospitals (Limato et al., 

2021).  

Responding to the threat of AMR requires 

regulations to control antibiotic use; in 2021 The 

Ministry of Health Republic of Indonesia (MoHRI) 

released a National Guideline on antibiotic use to 

strengthen and emphasize the implementation of 

antibiotics stewardship strategy. This guideline aims to 

improve patient outcomes through a coordinated 

program related to antibiotic use one important 

recommended strategy is to categorize antibiotics into 

AWaRe (Access, Watch, Reserve) classification 

(MoHRI, 2021). This categorization was determined 

following the same categorization previously released 

by the World Health Organization (WHO) as a tool for 

evaluating antibiotic consumption to optimize antibiotic 

use and further slow down the progress of AMR. As part 

of the worldwide plan to prevent AMR, WHO has set a 

target of at least 60% availability and usage of 

antibiotics in the Access class from total antibiotic 

consumption.(WHO, 2020). 

Reports on the evaluation of antibiotics use in 

Indonesia that have been published until 2022 indicate 

that the consumption of antibiotics from the Watch 

group continues to dominate in health facilities, up to 

more than 60% (Azyenela et al., 2022). Another study 

also reported that 30% of antibiotic use was irrational, 

and ceftriaxone was found to be the most used antibiotic 

(Diah, 2022). Similar findings have also been reported 

from an evaluation of antibiotic use conducted in 

Vietnam revealing a high proportion of antibiotic 

prescriptions for acute respiratory infections (ARI) in 

primary health care and high use of antibiotics from 

Watch class in children (Nguyen et al., 2023). These 

indicate that monitoring and evaluation of antibiotics 

use to achieve the prudent use of antibiotics should be 

continuously conducted. 

To achieve the target of rational use of antibiotics, 

continuous studies to evaluate the profile and quality of 

antibiotics use are required both quantitatively and 

qualitatively (WHO, 2015). For quantitative evaluation, 

the Anatomical Therapeutic Chemical/Defined Daily 

Dose (ATC/DDD) method is recommended as one 

important key of the antibiotics stewardship program 

(WHO, 2022). The quantity of antibiotics used 

expressed in the DDD unit can provide a picture of the 

overall consumption of antibiotics and trends in their use 

for assessing the achievement of antibiotic control goals 

(Hollingworth & Kairuz, 2021). The purpose of this 

study was to capture the profile of antibiotic use for 

outpatients at a public tertiary teaching hospital in 

Bengkulu, Sumatera – Indonesia, specifically in 

accordance with the AWaRe classification by following 

the AWaRe categorization released by WHO and 

MoHRI.  

 

MATERIALS AND METHODS 

Study design 

This study is a cross-sectional survey using 

aggregate data on antibiotics use for outpatients at a 

public tertiary teaching hospital in Bengkulu, Sumatera, 

Indonesia. Retrospective data of antibiotics use for five 

years during 2018-2022 were used for this study, 

including all systemic antibiotics coded as J01 in the 

ATC classification. The hospital has granted permission 

to conduct this study through the permission letter 

number 074/35/BID-DIK/II/2023.  

Method of collecting data 

Data were collected from the Hospital Pharmacy 

Department (HPD) using the Hospital Information 

System (SIMRS). Antibiotic use-related data were 

collected, including the name of antibiotic agents, 

dosage form and dosage strength, as well as the monthly 

quantity of antibiotics used during the study period 

(2018-2022). Data on the number of patient visits per 

year were collected from the medical record department. 

Data analysis 

The quantity of each antibiotic was calculated in 

DDD units by dividing the consumption of each 

antibiotic in grams by the DDD value as determined by 

WHO (WHO, 2022). The final unit used to express the 

quantity of antibiotic use in this study is DDD/1000 

patient-days (DDD/1000PD), which is the unit widely 

used and globally accepted to quantify drug use for 

outpatients. The calculation of DDD/1000PD was 
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conducted by combining the data on antibiotics use and 

the data on the number of outpatient visits. This is 

accomplished by multiplying the quantity of antibiotic 

use per month expressed in DDD by 1000, and then the 

result is divided by the number of outpatient visits per 

month accordingly (Apriyanti & Saepudin, 2023). The 

antibiotics found in this study were then categorized as 

‘Access’, ‘Watch’, and ‘Reserve’ by following the 2019 

WHO AWaRe classification as well as the 2021 MoHRI 

AWaRe classification. Antibiotics not listed in those 

classifications were categorized as ‘Unclassified’. The 

proportion of the consumption of antibiotics from each 

Access, Watch, and Reserve class was then determined 

by calculating the quantity of antibiotics in each class, 

expressed in DDD/1000PD, relative to the total 

antibiotic consumption. Finally, the proportion of 

antibiotic use from each class during the study period 

was calculated. 

 

RESULTS AND DISCUSSION 

Based on the generic names, this study identified 19 

antibiotic agents that were used for the outpatient at the 

hospital during the study period. Table 1 displays all 

antibiotic agents used at the hospital categorized by 

following the AWaRe categorization released by WHO 

and MoHRI. Fourteen antibiotic agents were used 

consistently during the study period, and the highest 

number of antibiotic agents was found in 2018, in which 

19 antibiotic agents were used. Meanwhile, the lowest 

number of antibiotic agents was found in 2022, with 

only 14 antibiotic agents used this year. 

Ten and thirteen antibiotic agents used for 

outpatients at the hospital are from the Access class 

according to WHO and MoHRI AWaRe categorization, 

respectively. In the meantime, 9 and 5 antibiotic agents 

used for outpatients at the hospital are from Access class 

according to WHO and MoHRI AWaRe categorization, 

respectively. There are some differences in term of 

AWaRe categorization released by WHO and MoHRI, 

as the categorization released by MoHRI was 

determined by accommodating some circumstances 

related to antibiotics use nationally in Indonesia. For 

instance, erythromycin, spiramycin, and ciprofloxacin 

are categorized in the Access class by MoHRI, while 

WHO categorized those antibiotic agents in the Watch 

class. Meanwhile, pipemidic acid is listed in Watch class 

according to the WHO AWaRe categorization, and it is 

not listed in the MoHRI categorization. As the results of 

different categorizations, this study found that 50-60% 

and 65-73% of the 14-19 antibiotics used for outpatients 

at the hospital are from the Access class following WHO 

and MoHRI AWaRe classification, respectively. 

In terms of the quantity, the consumption of 

antibiotics for outpatients at the hospital tends to 

fluctuate during the study period. On average, 

antibiotics consumption for outpatients at the hospital 

per year during the study period is 140.9 DDD/1000PD, 

with the highest and the lowest quantities of antibiotics 

were found in 2021 and 2022, with 155.1 DDD/1000PD 

and 106.1 DDD/1000PD, respectively. In contrast with 

the quantity of antibiotics consumption, the highest and 

the lowest number of outpatient visits were found in 

2018 and 2021, with 105,142 and 58,226 visits, 

respectively. The quantity of antibiotics used was 

expressed in DDD/1000PD to eliminate the influence of 

the number of outpatient visits so that the quantity can 

be compared adequately. In comparison with the 

previously reported findings, the quantity of antibiotics 

used in this study is significantly lower compared to 

antibiotics consumption in Sao Paulo, Brazil, with 

889.11 DDD/1000PD (Assis et al., 2022). 

The selection of antibiotic agents used in hospitals 

could be influenced by the pattern of infectious diseases, 

as well as the policies on antibiotic use. Figure 1 shows 

that antibiotic agents from the quinolone subgroup, 

including ciprofloxacin, levofloxacin, ofloxacin, and 

other quinolones such as pipemidic acid, were the most 

commonly used antibiotics, especially from 2018 to 

2020. Among the quinolone subgroup, ciprofloxacin 

was the most used antibiotic (19.35 DDD/1000PD). 

Other studies have reported that ciprofloxacin and other 

quinolone antibiotics are commonly prescribed in 

hospitals (Feroche & Alemu, 2021; Rehman et al., 

2019).  However, the use of fluoroquinolone antibiotics 

needs to be evaluated continuously, as their use is 

frequently inappropriate, and there is a significant 

increase in bacterial resistance to ciprofloxacin and 

other fluoroquinolone groups (Dobbyn et al., 2022). The 

ATC J01 M group and other quinolone groups, such as 

pipemidic acid, are also extensively used for outpatients 

at the hospital with an average quantity of 21.66 

DDD/1000PD. Due to its effective antibacterial activity 

against gram-negative and some gram-positive (Alves et 

al., 2020), pipemidic acid is extensively used as a 

therapeutic agent to treat urinary tract infections. 

In addition to the use of the quinolone subgroup, 

Figure 1 also shows that the other beta-lactam 

antibiotics were commonly used with relatively 

consistent in terms of quantity during the study period. 

First and third-generation of cephalosporins were used 

for outpatients at the hospital, and interestingly, the 
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consumption of cefixime, which is categorized within 

Watch class, was higher (24.14 DDD/1000 PD) than 

cefadroxil (11.14 DDD/1000PD) which is categorized 

within Access class in both categorizations released by 

WHO and MoHRI.

 

Table 1. Antibiotic Consumption for outpatients at the hospital following ATC Classification and AWaRe 

Categorization from WHO and MoHRI during 2018-2022 

ATC Code 
AWaRe 

Categorization 
Quantity of Antibiotic Use (DDD/1000PD) 

  WHO MoHRI 2018 2019 2020 2021 2022 

J01A TETRACYCLINES   1.08 0.87 0.81 0.51 0.85 

J01AA02 Doxycycline ACCESS ACCESS 1.08 0.87 0.81 0.51 0.85 

JO1B  AMPHENICOLS   0.95 1.44 0.73 0.24 0.88 

J01BA01 Chloramphenicol ACCESS ACCESS 0.06 0.08 0.18 0.15 0.06 

J01BA02 Thiamphenicol ACCESS ACCESS 0.89 1.36 0.54 0.09 0.82 

J01C 
BETA-LACTAM ANTIBACTERIALS, 

PENICILLINS 45.16 44.89 25.91 22.02 20.76 

J01CA01  Ampicillin ACCESS ACCESS 0.00     

J01CA04 Amoxicillin ACCESS ACCESS 41.35 43.49 25.07 21.40 20.76 

J01CR02 
Amoxicillin/clavulani

c-acid ACCESS ACCESS 3.81 1.40 0.84 0.62  

J01D 
OTHER BETA-LACTAM 

ANTIBACTERIALS 31.38 34.04 38.16 40.30 32.51 

J01DB05 Cefadroxil ACCESS ACCESS 13.57 15.37 11.38 6.64 8.73 

J01DD08 Cefixime WATCH WATCH 17.81 18.67 26.78 33.67 23.78 

J01E SULFONAMIDES AND TRIMETHOPRIM 10.65 8.82 6.60 4.72 2.24 

J01EE01 
Sulfamethoxazole/tri

methoprim ACCESS ACCESS 10.65 8.82 6.60 4.72 2.24 

J01F 
MACROLIDES, LINCOSAMIDES, AND 

STREPTOGRAMINS 6.09 7.04 20.75 49.06 8.17 

J01FA01 Erythromycin WATCH ACCESS 2.08 1.82 3.33 1.74 0.15 

J01FA02 Spiramycin WATCH ACCESS 0.02 0.01    

J01FA09 Clarithromycin  WATCH WATCH 0.57 2.69 1.88   

J01FA10 Azithromycin WATCH WATCH 2.52 1.73 15.13 46.90 5.03 

J01FF01 Clindamycin ACCESS ACCESS 0.90 0.79 0.41 0.43 2.98 

J01M QUINOLONE ANTIBACTERIALS 51.39 51.52 46.93 35.99 35.37 

J01MA01 Ofloxacin WATCH WATCH 1.55 0.27 0.13   

J01MA02 Ciprofloxacin WATCH ACCESS 29.40 24.60 17.75 12.78 12.22 

J01MA12 Levofloxacin WATCH WATCH 2.56 2.60 3.78 1.47 3.80 

J01MB04 Pipemidic-acid 
WATCH 

Uncategoriz

ed 17.88 24.05 25.28 21.74 19.36 

J01X OTHER ANTIBACTERIALS 2.40 2.62 3.13 2.24 5.29 

J01XD00 Metronidazole ACCESS ACCESS 2.40 2.62 3,13 2,24 5.29 

    
  149.10 151.24 143.02 155.09 

106.0

8 
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Figure 1. Quantity of antibiotic use at the hospital expressed in DDD/1000PD during the period 2018-2022 based 

on pharmacological group according to the ATC classification system 

 

 

Figure 2. DU90% profiles of antibiotics used for outpatients at the hospital each year  

during the period of 2018-2022 

 

Compared to other antibiotics in the beta-lactam 

class, beta-lactams were the second most commonly 

used in 2018 and 2019, but their usage declined in 2020 

(Figure 1). Amoxicillin, which is Access class from both 

categories, was the most commonly used antibiotic in 

the beta-lactam class, with an average utilization of 

30,41 DDD/1000 PD. The macrolide class of antibiotics, 

which includes azithromycin, clindamycin, 

erythromycin, spiramycin, and clarithromycin, was used 

more frequently in 2020 and 2021 as a result of the beta-

lactam group's decline, with an average utilization of 

18,22 DDD/1000 PD.  In this investigation, antibiotics 

belonging to the trimethoprim and sulfonamide classes 

were found to have an average usage of 6.61 

DDD/1000PD. Other antibacterial groups included 

metronidazole, with an average use of 3.13 

DDD/1000PD. This study indicated that the average 

annual use of antibiotics from the amphenicol and 

tetracycline classes was less than 2 DDD/1000PD. 
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Figure 2 depicts the DU profile of 90% annual use 

of antibiotics during the study period, which reveals 

that, despite the fact that 19 varieties of antibiotics were 

used in the hospital, only 6/7 of the 19 types had quantity 

use in the 90% usage area. These results indicate that 

approximately 60% of the antibiotic is utilized in the 

remaining 10%. In addition to being an exceptional 

clinical review, this profile can also be evaluated from 

an administration and management perspective to 

determine the efficiency and efficacy of drug 

management. Figure 2 also demonstrates that 

amoxicillin, ciprofloxacin, pipemidic acid, cefixime, 

and cefadroxil are the five most frequently prescribed 

antibiotics annually from 2018 to 2022. 

Amoxicillin was the most used antibiotic for 

outpatients at the hospital during the study period, with 

an average consumption of 22%. Following amoxicillin, 

cefixime was the second most used antibiotic, with an 

average consumption of 17.5% during the study period. 

In contrast with the antibiotic consumption during 2018-

2019, azithromycin is included in the segment of 

DU90% during 2020-2022 and became the most used 

antibiotic in 2021. Unsurprisingly, the use of 

azithromycin increased during 2021-2022 as this 

antibiotic was recommended for the treatment of 

COVID-19 patients (Oldenburg & Doan, 2020). 

Infection with the SARS-2 coronavirus has become a 

focal point of attention throughout 2020, which has 

influenced the selection of antibiotic therapy by medical 

professionals (Sinto, 2020). However, subsequent 

studies did not support the routine use of azithromycin 

for outpatient SARS, as a single dose of azithromycin 

compared to placebo did not increase the likelihood of 

being symptom-free by day 14 (Oldenburg et al., 2021). 

Overall, the segment of drug utilization 90% (DU90%) 

of antibiotics for outpatients at the hospital during the 

study period was dominated by antibiotics from Watch 

class according to WHO AWaRe classification. 

Azithromycin, cefixime, ciprofloxacin, and pipemidic 

acid, all of which are in the Watch category according 

to the WHO AWaRe classification, were included in 

DU90%. 

The main aim of this study is to determine the 

proportion of antibiotic use from the Access class, so the 

quantity of antibiotic use was then grouped based on the 

classes defined by WHO and the MoHRI. The usage of 

each antibiotic is converted into percent and then 

grouped based on Access, Watch, Reserve and 

Unclassified classes, and the results are presented in 

Figures 3 and 4. The primary objective of implementing 

the AWaRe classification is to mitigate the utilization of 

antibiotics within the Watch and Reserve categories and, 

subsequently, enable an increase in the accessibility and 

utilization of antibiotics from the Access class to surpass 

60% of the overall antibiotic consumption (WHO, 

2020). 

During the study period, consumption of antibiotics 

from the Access class comprises only 24-50% and 33-

71% of total antibiotics consumption for outpatients 

following WHO and MoHRI AWaRe classification, 

respectively, as presented in Figure 3. Overall, the 

utilization of antibiotics from the Access class is lower 

than the target set by WHO.  Consistent with prior 

research findings (Tomas et al., 2021; Zhussupova et al., 

2021), it has been shown that a decline in the utilization 

of antibiotics from Access class according to WHO 

AWaRe Classification is subsequently accompanied by 

a corresponding rise in the consumption of antibiotics 

from Watch, and even Reserve, class. 

 

 

Figure 3. Proportion of the consumption of antibiotics from Access and Watch class for outpatients at the hospital 

during the period of 2018-2022 according to MoHRI AWaRe Classification 
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Figure 4. Proportion of the consumption of antibiotics from Access and Watch class for outpatients at the hospital 

during the period of 2018-2022 according to WHO AWaRe Classification

 

This study has some limitations, especially 

regarding the adjustment of antibiotics use with the 

epidemiological profile of infectious diseases at the 

hospital. Therefore, results from this study require 

further follow-up from both the clinical and 

management aspects. Further clinical research is needed 

to ensure that the consumption of antibiotics from 

Watch follows the national guidelines in order to 

achieve better outcomes without increasing the risk of 

adverse effects and, importantly, not significantly 

increasing the risk of developing bacterial resistance. 

 

CONCLUSION 

In term of antibiotics agents, antibiotics used for 

outpatients at the hospital were mostly from Access 

class. However, in term of quantity, the consumption of 

antibiotics from Access class still below the target of 

WHO. This indicates that the implementation of some 

effective strategies is still needed to achieve the target 

regarding antibiotics use. 
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Abstract 

Background: Type 2 diabetes mellitus (DMT2) is a metabolic disease due to abnormalities in insulin secretion. 

Insulin is one of DMT2 therapy. Objective: This study aimed to validate a modified the insulin adherence influence 

factor questionnaire based on the health belief model (HBM) among Indonesian patients with DMT2. Methods: 

The Indonesian insulin adherence influence factor questionnaire (IIAIFQ) was developed based on modified some 

literature reviews and internal expert discussions. The study included 30 participants aged ≥ 17 y.o years old who 

had been taking insulin in the previous two months. The questionnaire consists of seven dimensions to measure 

HBM : perceived susceptibility, perceived severity, perceived benefits, perceived barriers, self-efficacy, cues to 

action and insulin adherence. Results: The construct validity test showed that of the 34 question items in the 

questionnaire, 10 items were invalid, 24 others were demonstrated valid based on the Pearson Correlation (>r 

table 0.361; p<0.05; loading factor > 0.5). Furthermore, 24 valid items were tested for reliability at a significance 

level of 0.05, and the results showed that each size had a  Cronbach's Alpa > 0.6 with an overall score was 0.858, 

indicating that all domains in the questionnaire were reliable. Conclusion: IIAIFQ  based The HBM theory is a 

valid and reliable instrument for assessing insulin adherence in diabetes mellitus patients. 

 

Keywords: adherence, health belief model, insulin, reliability, validity 
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INTRODUCTION 

Diabetes mellitus (DM) is a non-communicable 

disease that is a top 10 (ten) cause of death globally. In 

2021, DM disease in Indonesia ranked fifth highest 

globally after China, India, Pakistan, and the United 

States (International Diabetes Federation, 2021). The 

results of Basic Health Research show that the 

prevalence of people aged  ≥15 years with DM has 

increased from 6.9% in 2013 to 8.5% in 2018 

(Kemenkes RI, 2018). 

The International Diabetes Federation estimates 

that more than 537 million people worldwide suffer 

from DM, and around 150-200 million are treated with 

insulin (Masierek et al., 2022). Insulin therapy is needed 

when oral antidiabetics in optimal doses cannot improve 

blood glucose levels and HbA1C values > 9% with 

metabolic decompensation conditions (Perkumpulan 

Endokrinologi Indonesia, 2021a).  

In Indonesia, several types of insulin are 

categorized based on their origin, namely insulin 

analogues and human insulin. The use of insulin 

analogues is higher than human insulin (Kehlenbrink et 

al., 2018). Based on its duration of action, insulin 

therapy consists of fast-acting, short-acting, 

intermediate-acting, long-acting, and fixed insulin mix 

(premixed insulin) (Perkumpulan Endokrinologi 

Indonesia, 2021b). Adherence to oral drug therapy and 

insulin therapy influences therapeutic outcomes in 

diabetic patients. According to the treatment 

recommendation, good insulin adherence is critical in 

managing DM therapy. Adherence to insulin therapy is 

linked to better glycemic control, which lowers the risk 

of developing microvascular and macrovascular 

complications and all-cause mortality (Stolpe et al., 

2016). 

Patients' beliefs about using drugs and their health 

conditions influence adherence to medication therapy. 

Individual beliefs include perceptions of susceptibility, 

severity, benefits, barriers, and self-efficacy. Cues to 

action also have an impact on compliance (Pakpahan et 

al., 2021). Adherence to medical regimens extends the 

health belief model (HBM) implementation (Irwan, 

2017).  

Based on the literature review, numerous 

questionnaires assess diabetes mellitus treatment 

adherence in general and the factors that influence it. 

The questionnaire about the adherence to insulin used 

was adapted from the Morisky Medication Adherence 

Scale (MMAS) (MIAS) (Osborn & Gonzalez, 2016). 

There was a questionnaire about factors determining 

insulin adherence like diabetes knowledge, such as the 

patient diabetes knowledge questionnaire (PDKQ) and 

diabetes knowledge questionnaire (DKQ) in the 

Taiwanese population; a questionnaire about quality of 

life, such as the Asian diabetes quality of life 

questionnaire and Indonesian version of the A the audit 

of diabetes dependent quality of life questionnaire 

(ADDQoL); and the questionnaire about diabetes 

mellitus patient behaviour in primary health care service 

(Hsieh et al., 2022; Lim et al., 2023; Oliveira et al., 

2022; Permana et al., 2021; Rooswita et al., 2021; 

Saputri et al., 2019).  

There are only a few questionnaires specific to 

Indonesian patients with DMT2 with insulin treatment 

therapy. Fitriani et al. (2019) developed an insulin 

adherence questionnaire based on the health belief 

model (HBM) only on individual belief or only 5 (five) 

dimensions. A study was done by compiling personal 

beliefs and cues to action became 6 (six) dimensions for 

measuring insulin adherence, and factors determining 

insulin adherence in Indonesian patients with DMT2 is 

still limited. This study aimed to develop and validate 

the insulin adherence influence factor questionnaire 

based on the health belief model (HBM) among 

Indonesian patients with DMT2. 

 

MATERIALS AND METHODS 

Tools 

The Indonesian insulin adherence influence factor 

questionnaire (IIAIFQ) was developed in the Indonesia 

language based on literature reviews (Cipolle et al., 

2012; Hepler & Strand, 1990; Perkumpulan Edukator 

Diabetes Indonesia, 2017; Rusmadi et al., 2021; 

Strachan & Frier, 2013; van der Ven et al., 2003) and 

expert discussion. This questionnaire consisted of seven 

dimensions (34 statement items), namely 3 statement 

items on perceived susceptibility (PSu), 3 statement 

items on perceived severity (PSv), 5 statement items on 

perceived benefits (PBe), 6 statement items on 

perceived barriers (PBa), 4 statement items on perceived 

self-efficacy (PSE), 3 statement items on cues to action 

(CA), and 10 statement items on insulin adherence (IA). 

Assessment of the six dimensions of individual belief 

used a Likert scale with a score of 5 for the answer 

"strongly agree", 4 for the answer "agree", 3 for the 

answer "neutral", 2 for the answer "disagree" and 1 for 

the answer "strongly disagree". While one dimension of 

insulin adherence used a Likert scale with ratings of 5 

for the answer "always", 4 "often", 3 for the answer 

"sometimes", 2 for the answer rarely, and 1 for the 

answer "never."  
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Method 

Study design 

This cross-sectional survey was conducted in 

Banjarbaru City, South Borneo, Indonesia, from March 

to April 2023. Convenient sampling was employed to 

select respondents for construct validity and reliability. 

Ethical approval for this research was received from the 

Health Research Ethics Committee of Idaman Hospital 

Banjarbaru City with reference No.RS00122/KEPK-

RSDI/02/2023.  

The face and content validity test of IIAIFQ was 

established by an internal research team consisting of 

pharmacists based on their expertise and credibility in 

pharmaceutical care. The construct validity test of 

IIAIFQ was conducted on 30 respondents who visited 

Nirwana Hospital and Syifa Medika Hospital, 

Banjarbaru City (Yurdugül, 2008; Yusoff et al., 2021).  

Those hospitals were selected by considering the 

highest number of DMT2 patients who use insulin. The 

population of the construct validity test in this study 

were DMT patients who use insulin. The sample were 

all type 2 diabetes mellitus patients who met the 

following criteria: aged ≥ 17 years, taking insulin at least 

in the last 2 two months, able to read and hear, and 

willing to contribute to the study by approving and 

signing informed consent. 

Data collection  

Data were collected directly from the respondents 

via questionnaires when the patients took the medication 

in the outpatient department at the pharmacy. Data 

collection techniques include asking respondents a 

series of questions or writing them down after they were 

informed about the purpose of the study and consented 

to participate by signing an informed consent form. 

Data analysis 

Analysis of the construct validity and reliability 

results used Jeffrey's Amazing Statistics Program 

(JASP) application. The construct validity of each 

statement item can be seen from the Pearson Correlation 

value using the distribution (table r) at a significance 

level of 0.05 for a two-way test with r table = 0.361 

because of degrees of freedom (df=N-2=30-2=28). If the 

correlation coefficient value equals or exceeds the r 

table value, then the statement item is considered valid. 

Then, it was continued with convergent validity; if the 

loading factor > 0.5, then the statement is considered 

valid (Hair et al., 2010). Furthermore, reliability tested 

each dimension at a significance level of 0.05 by looking 

at Cronbach's alpha value. The statement is deemed 

reliable if Cronbach's alpha value is ≥ 0.6 (Sani, 2018).  

 

RESULTS AND DISCUSSION 

The demographic characteristics of the respondents 

can be seen in Table 1. The majority of respondents, or 

23 people (76.7%), were patients aged 45-65 years. This 

aligns with research conducted by Gamayanti et al. 

(2018) at the Internal Medicine Polyclinic of the State 

General Hospital and Vonna et al. (2021) at Dr Zainoel 

Abidin Hospital in Banda Aceh, who stated that diabetes 

mellitus patients who use insulin at the most are aged 

46-65 years (Gamayanti et al., 2018; Vonna et al., 

2021). Another study on people with DMT2 at the 

Outpatient Pharmacy Installation at ST Elisabeth 

Hospital in Semarang found that most patients who use 

insulin were over 45 years (Rukminingsih & Nova, 

2021). Based on gender, it can be seen that the majority 

of respondents in this study (17 people) were male 

(56.7 %). According to a review, women have a higher 

prevalence of DMT2 in their youth than men, while men 

have a higher prevalence in their middle years 

(Huebschmann et al., 2019). Women patients with DM 

aged 56-65 years are more susceptible to depression 

than women patients with DM aged 46-55 years 

(Fatmawati et al., 2023).  

According to Table 1, all respondents used insulin 

analogue, and the majority of respondents used rapid-

acting insulin in the form of Novorapid 100U/mL; as 

many as 7 seven people (23.3 %) and a combination of 

long-acting and rapid-acting insulin with the trade name 

Levemir 100U/ mL + Novorapid 100U/ mL; as many as 

7 seven people (23.3 %). This aligns with the findings 

of Anggraini et al. (2020) and Zaim et al. (2021), who 

discovered that the use of insulin analogues is greater 

than that of human insulin (Anggriani, Rianti, Pratiwi, 

& Puspitasari, 2020). This is because the risk of 

hypoglycemia of insulin analogues is lower than human 

insulin and can be given immediately without paying 

attention to mealtimes (Fibriani, 2014). The use of a 

rapid-acting and long-acting insulin combination is in 

line with research conducted by Adinda et al. (2023), 

which stated that a long-acting and rapid-acting 

combination is also the most extensively used insulin in 

Dr Soetomo Hospital, Surabaya (Ayu et al., 2023). The 

combination of insulin glargine (long-acting insulin) 

with insulin aspart (rapid-acting insulin) resembles the 

human body's normal insulin profile because it provides 

a faster onset of action with a longer duration of action 

(Kartika et al., 2013).
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Table 1. Demographic characteristics of the participants (n = 30) 

Demographic Category n (%) 

Age < 45 years 4 (13.3) 

45-65 years 23 (76.7) 

> 65 years 3 (10.0) 

Sex Men 17 (56.7) 

Women 13 (43.3) 

Education None 0 (0.0) 

Primary school 1 (3.3) 

Junior high school 4 (13.3) 

Senior high school 13 (43.3) 

D3 2 (6.7) 

D4 0 (0.0) 

Bachelor degree 8 (26.7) 

Master degree 2 (6.7) 

Doctoral 0 (0.0) 

Occupation Unemployment 6 (20.0) 

Retired 4 (13.3) 

Government employees 11 (36.7) 

Self-employed 9 (30.0) 

Monthly family income 

 

< IDR 1000000 2 (6.7) 

> IDR 1000000- IDR 2000000 3 (10.0) 

> IDR 2000000- IDR 3000000 6 (20.0) 

> IDR 3000000- IDR 4000000 6 (20.0) 

> IDR 4000000- IDR 5000000 6 (20.0) 

> IDR 5000000 7 (23.3) 

Sources of funding for treatment BPJS/JKN KIS 27 (90.0) 

Private insurance 1 (3.3) 

Self-pay 2 (6.7) 

Duration of diabetes mellitus  (years, mean ± sd) 4.23  ±  4.5 

Comorbidity None 6 (20.0) 

Allergy 1 (3.3) 

CHF 2 (6.7) 

Dyslipidemia 6 (20.0) 

Hypertension 2 (6.7) 

Maag 1 (3.3) 

CHF + Osteoporosis 1 (3.3) 

Dyslipidaemia + CHF 1 (3.3) 

Dyslipidaemia + Maag 1 (3.3) 

Hypertension + CHF 1 (3.3) 

Hypertension + Dyslipidaemia 1 (3.3) 

Hypertension + Gout 2 (6.7) 

Hypertension + Maag 1 (3.3) 

Hypertension + Sirosis hati 1 (3.3) 

Hypertension + Stroke 1 (3.3) 

Maag + Asthma 1 (3.3) 

Hypertension + Dyslipidemia + Gout 1 (3.3) 

Duration of use insulin (months, mean ± sd) 12.5 ± 22.1 

Other diabetes medications 

currently in use 

 

None 17 (56.7) 

Acarbose 100 mg 1 (3.3) 

Glimepiride 2 mg 1 (3.3) 

Glimepiride 3 mg 1 (3.3) 

Metformin 500 mg 5 (16.7) 

Metformin 850 mg 1 (3.3) 

Gliclazide 80 mg 1 (3.3) 

Metformin 500 mg + Glimepiride 2 mg 1 (3.3) 

Metformin 500 mg + Glibenclamide 2.5 mg 1 (3.3) 

Metformin 500 mg + Acarbose 100 mg 1 (3.3) 
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Table 2. Construct validity for the 34 statements of the IIAIFQ 

No Dimension Statements 
Pearson 

correlation 
r table Explanation 

1 Perceived 

susceptibility 

(PSu) 

1. I am vulnerable to the risk of blood sugar deficiency when 

using excessive doses of insulin 

0.789 0.361 Valid 

2 2. I am vulnerable to infection when using insulin with a 

syringe that is not replaced 

0.853 0.361 Valid 

3 3. I am vulnerable to experiencing the risk of swelling of the 

skin that is injected at the same place continuously 

0.790 0.361 Valid 

4 Perceived 

severity 

(PSe) 

1. I feel worried about the condition of my sugar level if I 

don't adhere to using insulin properly 

0.860 

 

0.361 Valid 

5 2. I am worried that my health condition will get worse if I 

don't adhere to using insulin properly 

0.922 0.361 Valid 

6 3. I am worried about the dangerous condition of the 

complications of diabetes mellitus 

0.831 0.361 Valid 

7 Perceived 

benefits 

(PBe) 

1. I feel the benefit of being obedient to using the correct 

insulin is that my blood sugar levels are controlled 

0.769 0.361 Valid 

8 2. I feel that the benefit of adhering to using the correct insulin 

is that it can prevent complications of blindness 

0.946 0.361 Valid 

9 3. I feel the benefit of sticking to using the correct insulin is 

that it can prevent complications of kidney failure 

0.915 0.361 Valid 

10 4. I feel that the benefit of adhering to using the correct insulin 

is that it can prevent complications of heart disease 

0.938 0.361 Valid 

11 5. I feel the benefit of sticking to using the correct insulin is 

that it can prevent complications of paralysis 

0.869 0.361 Valid 

12 Perceived 

barrier 

(PBa) 

1. I feel the fear that insulin will cause pain when injected is 

an obstacle in sticking to using insulin properly 

0.562 

 

0.361 Valid 

13 2. I have trouble remembering the schedule for injecting 

insulin 

0.509 0.361 Valid 

14 3. I need someone else's help to be able to inject insulin 

properly 

0.488 0.361 Valid 

15 4. I find it challenging to buy a refrigerator to store insulin 0.523 0.361 Valid 

16 5. I find it challenging to buy insulin because it's expensive 0.789 0.361 Valid 

17 6. I feel uncomfortable with the side effects of insulin 0.605 0.361 Valid 

18 Perceived 

self-efficacy 

(PSv) 

1. I feel able to inject insulin properly 0.876 0.361 Valid 

19 2. I feel able to inject insulin according to the recommended 

dose every day 

0.895 0.361 Valid 

20 3. I feel able to inject insulin when I'm at home even though 

I'm sick 

0.713 0.361 Valid 

21 4. I feel able to inject insulin even when I'm outside the 

house/travelling 

0.578 0.361 Valid 

22 Cues to 

action (CA) 

1. Information and education from the doctor will be critical to 

help me take insulin treatment properly 

0.319 0.361 Invalid 

23 2. Information and education from the pharmacist will be 

critical to help me take insulin medication correctly 

0.940 0.361 Valid 

24 3. The support from my family encouraged me to adhere to 

insulin treatment properly 

0.851 0.361 Valid 

25 Insulin 

adherence 

(IA) 

1. I inject insulin according to the dosage recommended by a 

doctor or health worker 

0.361 0.361 Valid 

26 2. I inject insulin before eating as directed by a doctor or 

health worker 

0.621 0.361 Valid 

27 3. I checked the expiration date of the insulin 0.542 0.361 Valid 

28 4. I clean my hands before using insulin 0.744 0.361 Valid 

29 5. I removed the protective seal on the needle without 

touching the needle 

-0.044 0.361 Invalid 

30 6. I do priming (gas bubble removal) before taking insulin 0.606 0.361 Valid 

31 7. I did a cleanup on the location to be injected 0.775 0.361 Valid 

32 8. I poked the needle into the skin quickly at a 90-degree angle 0.214 0.361 Invalid 

33 9. I store used insulin at room temperature 0.417 0.361 Valid 

34 10. I store unused insulin in the refrigerator 0.161 0.361 Invalid 
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Table 3. Loading factor of convergent validity for IIAIFQ  

Dimension Indicator Loading Factor 

Perceived Susceptibility PSu1 0,822 

PSu2 0,883 

PSu3 0,729 

Perceived Severity PSv1 0,852 

PSv2 0,922 

PSv3 0,838 

Perceived Benefit PBe1 0,796 

PBe2 0,944 

PBe3 0,910 

PBe4 0,935 

PBe5 0,859 

Perceived Barrier PBa4 0,748 

PBa5 0,798 

PBa6 0,852 

Perceived Self Efficacy PSE1 0,918 

PSE2 0,937 

PSE3 0,665 

PSE4 0,526 

Cues to Action CA2 0,931 

CA3 0,931 

Insulin Adherence IA1 0,870 

IA2 0,901 

IA4 0,553 

IA9 0,797 

The construct validity test of the IIAIFQ listed in 

Table 2 showed that four of the 34 statement items were 

invalid because the correlation value was less than 

0.361, resulting in only 30 statement items being 

declared valid. The four invalid items were 1) 

Information and education from a doctor would be 

critical to help me take insulin medication properly, 2) I 

removed the protective seal of the needle without 

touching the needle, 3) I inserted the needle rapidly into 

the skin at an angle of 90 degrees, and 4) I store unused 

insulin in the refrigerator. 

Providing information to DMT2 patients about the 

benefits and importance of compliance and the risks of 

non-adherence is one way to improve adherence to 

insulin use (Mathew et al., 2022). Item statement no.1 

comes from the dimension of cues to action. Item 1 was 

invalid, which may be due to the results where the 

majority of 21 people (70%) gave agreed answers. 

While item statements number 2-4 come from the 

dimensions of adherence to insulin use. Statements 2-4 

are invalid perhaps because the majority of respondents, 

as many as 29 people (96.7%), answered "always" on 

item 2, the majority of as many as 27 people (90.0%) 

answered "always" on statement item 3, and most as 

many as 13 people (43.3%) answered "always" on the 

5th statement item. 

There were 30 items of valid statements in IIAIFQ 

by Pearson's validity analysis, it was then tested for 

convergent validity, as shown in Table 3. For 24 items 

of valid statements in IIAIFQ by convergent validity 

analysis, each dimension was tested for reliability, as 

shown in Table 4. The reliability test showed that each 

dimension had a Cronbach's Alpha value greater than 

0.6 with an overall score of 0.858 with details for 

perceived susceptibility of 0.729, perceived severity of 

0.841, perceived benefits of 0.927, perceived barriers of 

0.711, perceived confidence of 0.757, cues to action by 

0.844, and adherence to insulin use by 0.645. This 

means that all dimensions in the questionnaire are 

declared reliable. 

Several studies on medication therapy adherence 

have been carried out using the Health Belief Model 

(HBM) theoretical approach. Fitriani (2019) conducted 

insulin treatment adherence research using a 

questionnaire that measures adherence to insulin 

treatment therapy from the five dimensions of HBM 

theory: perceived vulnerability, perceived severity, 

perceived benefits, perceived barriers, and perceived 

self-efficacy (Fitriani, 2019). This aligns with research 

conducted by Hidayati et al. (2020), which only 

included these five dimensions to analyze behavioural 

factors that affect adherence to medication therapy in 

gout patients (Hidayati et al., 2020).  
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Table 4. Reliability for IIAIFQ 

Dimension Cronbach's alpha coefficient Standard coefficient Explanation 

Perceived susceptibility (PSu) 0.729 0.60 Reliable 

Perceived severity (PSv) 0.841 0.60 Reliable 

Perceived benefits (PBe) 0.927 0.60 Reliable 

Perceived barrier (PBa) 0.711 0.60 Reliable 

Perceived self-efficacy (PSE) 0.757 0.60 Reliable 

Cues to action (CA) 0.844 0.60 Reliable 

Insulin adherence (IA) 0.645 0.60 Reliable 

All dimension 0.858 0.60 Reliable 

 

Research conducted by Fithri et al. (2021) also 

included these five dimensions with an additional 

dimension, namely perceived threat, in a questionnaire 

to asses factors that affect medication adherence in 

elderly patients with hypertension (Fithri et al., 2021). 

In this study, the questionnaire was made to measure six 

dimensions of the HBM theory: perceived vulnerability, 

perceived severity, perceived benefits, perceived 

barriers, perceived self-efficacy, and cues to action. This 

aligns with previous research conducted by Rusmadi et 

al. (2021), which also included the six dimensions of the 

HBM theory in the medication adherence questionnaire 

in elderly patients with hypertension (Rusmadi et al., 

2021). The six dimensions of the HBM theory also 

measure self-care practices and associated factors 

among diabetic patients in Gondar City (Melkamu et al., 

2021). 

Another perspective studies on diabetes mellitus 

medication adherence have been carried out using the 

Theory of Planned Behavior (TPB) approach. Oliveira 

et al. (2022) verified the content validity of questions of 

an insulin adherence questionnaire in outpatients DMT2 

from the four dimensions of TPB: intention, attitude, 

perceived norm, and perceived control (Oliveira et al., 

2022). This aligns with previous research that included 

these four dimensions that affect antidiabetic medication 

adherence (Wu & Liu, 2016; Zomahoun et al., 2016).  

The instrument or questionnaire designed for 

Indonesian DMT2 patients and specific to analyzing 

diabetes treatment by insulin pen based on health 

behaviour theory distinguishes this study from others. 

This questionnaire measures the six dimensions of the 

HBM theory: perceived vulnerability, perceived 

severity, perceived benefits, perceived barriers, 

perceived self-efficacy and cues to action. Previous 

research did not include cues to action dimensions 

(Fitriani, 2019). The limitations of this study were due 

to the distribution of questionnaires carried out in two 

private hospitals in Banjarbaru City, so each respondent 

had different health service experiences. It affected the 

respondent's experience regarding cues to action related 

to the role of health workers in the treatment of DM, 

especially the use of insulin. This questionnaire is less 

suitable when applied to research conducted at only one 

health facility. More research may be needed to test this 

questionnaire in a larger, more representative sample 

and only at one health facility to appropriately depict 

insulin adherence behaviour in that area. In order to 

create a comprehensive questionnaire, other approaches 

such as factor analysis for concept validity, known 

group validity, split half or test-retest reliability must be 

incorporated into the validity and reliability study. 

 

CONCLUSION 

IIAIFQ is a valid and reliable tool for assessing the 

factors that influence insulin adherence in Indonesian 

patients with DMT2 based on the HBM. 
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Abstract 

Background: Indonesia is an equatorial country that is rich in sunlight all year. UV light is divided into three 

wavelength groups: UV-A (320-400nm), UV-B (280-320nm), and UV-C (100-290nm). Intracell chromophores in 

skin cell membranes such as riboflavin, porphyrin, nicotinamide, and enzymes will absorb the UV-A light. The 

UV-B light penetrates the dermis layer and causes DNA structure changes, which lead to wrinkles and a rising 

risk of skin cancer. Premature skin aging and skin cancer can be prevented with sunscreen preparation containing 

compounds that can protect the skin from UV radiation. Flavonoid is one of the purslane (Portulaca grandiflora) 

active metabolites that have the potency to be developed as sunscreen. Objective: This research aimed to determine 

the ability of purslane (Portulaca grandiflora) magenta flower variety herbs extract cream as a sunscreen as 

indicated by the %Te, %Tp, and Sun Protective Factor value. Methods: This research was an experimental study 

with various purslane magenta flower variety herbs extract cream formulas that were tested for their %Te, %Tp, 

and SPF value with a UV-Vis spectrophotometer. Results: The sunscreen cream preparation with 2.5% of purslane 

(Portulaca grandiflora) magenta flower variety herb extract had %Te, %Tp, and SPF values of 25.86 ± 2.41%, 

36.05 ± 2.82%, and 3.97 ± 0.35 respectively. At the same time, preparations with 5% concentration of extract had 

%Te, %Tp, and SPF values of 8.23 ± 0.86%, 16.65 ± 0.92%, and 8.03 ± 0.38, respectively. Conclusion: The 

sunscreen activity of all extract concentration creams was significantly different compared to the negative control 

(cream base) in all parameters. Flavonoids are the compounds responsible for the sunscreen activity of purslane 

extract. 
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INTRODUCTION 

One of the energy sources needed by living 

creatures is sunlight because of its involvement in every 

stage of the living process. For example, it is vitamin D 

generation. Otherwise, sunlight overexposure also has a 

negative effect. 

Sunlight radiation consists of infrared light 

(wavelength > 760 nm), visible light (400-760 nm), and 

UV (ultraviolet) light consisting of UV-A (320-400 nm), 

UV-B (290-320 nm), as well as UV-C (200-290 nm) 

(Limpiangkanan & Limpiangkanan, 2010). UV-A and 

UV-B rays are radiation from sunlight that reaches the 

earth's surfaces and has an impact on the skin (Wang et 

al., 2008). The UV-A light that reaches the skin surface 

will be absorbed by intracellular chromophores in cell 

membranes such as riboflavin, porphyrin, nicotinamide, 

and enzymes. This causes oxidative stress, whereas 

Reactive Oxygen Species (ROS) production 

overwhelms the natural skin antioxidant mechanism, 

leading to a decrease in collagen production and wrinkle 

appearance (Gragnani et al., 2014). The UV-B light that 

reaches the skin will penetrate the dermis layer and 

cause DNA structure changes, which lead to wrinkles 

and rising skin cancer risk (Matsuda et al., 2013). 

Indonesia is a country in the equatorial area with an 

abundance of sunlight, which leads to high premature 

skin aging and skin cancer risk. Premature skin aging 

and skin cancer can be prevented with sunscreen 

preparation containing compounds that can protect the 

skin from UV radiation. The ability to protect skin from 

sunlight exposure is shown by erythema transmission 

percentage (%Te), pigmentation transmission 

percentage (%Tp), and Sun Protective Factor (SPF). 

Commonly, plants rich in flavonoids have a high SPF 

value because of their chromophore chemical structure 

capable of absorbing UV light radiation energy (Saewan 

& Jimtaisong, 2013). Besides that, flavonoids also have 

antioxidant activity to prevent oxidative stress so that 

premature skin aging and cancer risk can be prevented 

(Chen et al., 2012). 

Purslane is a plant that has been studied for its 

health benefits because of its various secondary 

metabolites. Flavonoid is one of the purslane active 

metabolites that have the potency to develop as 

sunscreen. Purslane Portulaca grandiflora magenta 

flower variety has higher levels of flavonoids compared 

to other varieties, making it suitable to be developed as 

a sunscreen (Budiawan et al., 2023). 

Cream is a topical preparation with a semi-solid 

emulsion system. This preparation is easy to use and 

gives a comfortable feeling in its application. In 

addition, with the right cream consistency, the extracts 

in sunscreen can stick long enough and provide 

sufficient time for the flavonoid compounds to be 

absorbed by the skin, providing a maximum sun 

protection effect. 

 

MATERIALS AND METHODS 

Materials 

Fresh purslane (Portulaca grandiflora) magenta 

flower variety herb was obtained from Madiun regency, 

East Java, Indonesia. Ethanol 96% was used the 

extraction process. Ceto stearyl alcohol, stearic acid, 

cetyl alcohol, methylparaben, propylparaben, tween 80, 

and aqua destilata were used to make cream base 

preparation. Magnesium powder, HCl 2N, C2H5OH, 

NH3, CHCl3, Dragendorff, Mayer, Bouchardat, FeCl3, 

H2SO4 concentrate, and methanol pro analysis were 

used as reagents. 

Tools 

Tools used in this experiment were 

Spectrophotometer UV-Vis (JaSCO V-730), rotary 

evaporator, water bath, analytical balance, and 

glassware (pyrex). 

Method 

Extract preparation 

Two hundred grams of dried purslane (Portulaca 

grandiflora) magenta flower variety herb was extracted 

with maceration method using 500 mL ethanol 96% for 

five days. The dregs were re-macerated using the same 

solvent for another five days. The first and second 

filtrates were then mixed and thickened with a rotary 

evaporator at 40°C until one-third of the volume was 

remaining. The thickened filtrates were then dried in the 

oven at 50°C for 24 hours until thick extract was 

obtained. 

Phytochemical screening 

1.  Flavonoids Identification 

Half a gram of purslane (Portulaca grandiflora) 

magenta flower variety extract was dissolved into water 

and transferred into a test tube. Magnesium metal and 

five drops of HCl 2N were added into the tube, and then 

the mixture was heated for 5-10 minutes. After filtration, 

the filtrate waited until it cooled down and was added 

with amil alcohol and then shaken hard. The reaction 

was positive if a red color formed in the amil alcohol 

layer (Harbone, 1987; Hanani, 2017). 

2. Alkaloid Identification 

Half a gram of purslane (Portulaca grandiflora) 

magenta flower variety extract was basified with 1 mL 

of ammonia, then chloroform was added and crushed 

vigorously. The chloroform liquid was filtered, the 
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filtrate was placed in a test tube, 2 N HCl was added, the 

mixture was shaken, and then left to separate. In a 

separate test tube: Filtrate 1: As much as one drop of 

Dragendorff reagent solution is dropped into the filtrate, 

the presence of alkaloids is indicated by the formation 

of precipitate or turbidity that is coloured brown. Filtrate 

2: As much as one drop of Mayer's reagent solution is 

dripped into the filtrate, the presence of alkaloids is 

indicated by the formation of a white precipitate or 

turbidity. Filtrate 3: As a blank or negative control 

(Harbone, 1987; Hanani, 2017). 

3. Saponin Identification 

Half a gram of purslane (Portulaca grandiflora) 

magenta flower variety extract was put in a test tube, 

added hot water and cooled, then shaken for 10 seconds, 

a stable foam will form in less than 10 minutes, 1-10 cm 

high, and with the addition of 1 drop of HCl The 2N 

foam was persistence which indicated the presence of 

saponins (Harbone, 1987; Hanani, 2017). 

4. Tannin Identification 

Half a gram of purslane (Portulaca grandiflora) 

magenta flower variety extract was put into a test tube 

and reacted with FeCl3 1% solution. The extract 

contains tannins if a green-black or dark-blue color was 

formed (Harbone, 1987; Hanani, 2017). 

5. Terpenoid Identification 

Half a gram of purslane (Portulaca grandiflora) 

magenta flower variety extract was put into a test tube 

and added with chloroform and H2SO4 concentrated. 

The extract would contain terpenoids if a brown colour 

was formed (Harbone, 1987; Hanani, 2017). 

Cream preparation 

The preparation of this research cream was based 

on the Arisca (2018) with minor modifications. Each 

material was measured and the oil phase (ceto stearyl 

alcohol, cetyl alcohol, stearic acid, and propylparaben) 

was mixed. The water phase (tween 80 and 

methylparaben) was mixed. Both phases were heated at 

80°C with a water bath until dissolved. Cream 

preparation was done by adding the hot water phase to 

the hot oil phase and the mixture stirred at 12500 rpm 

until a cold cream base formed. The purslane (Portulaca 

grandiflora) magenta flower variety herb extract was 

added to the cream base and stirred at 20 rpm until a 

homogeneous cream was formed (Table 1). 

Sunscreen activity test 

The sunscreen activity test was carried out by 

determining the SPF value in vitro using the UV-Vis 

spectrophotometry method. The purslane magenta 

flower variety herbs extract cream was dissolved into 

methanol pro analysis to obtain a 1000 ppm 

concentration of test solution. After that, the test 

solution transmission was read at 292.5–372.5 nm 

wavelength (every 5 nm interval).   The amount of 

erythema flux that was transmitted by the sunscreen 

agent (Ee) is calculated by the formula: Ee = ΣT.Fe 

while the pigmentation flux is calculated by the formula: 

Ep = ΣT.Fe. %Te and %Tp value calculated by 

formula %Te = Ee/ΣEe and %Tp = Ep/Σep, where T= 

Transmition value, Fe= a constant of flux erythema, Fp= 

a constant of flux pigmentation (Cumpelick, 1927). SPF 

value measurement was done by reading the test 

solution absorbance at 290-320 nm wavelength with 5 

nm interval (Mansur et al., 1986; Mishra et al., 2012) 

(Table 2). SPF was obtained using the formula: 

𝑆𝑃𝐹 = 𝐶𝐹 ×∑𝐸𝐸 × 𝐼 × 𝐴𝑏𝑠

320

290

 

Where: CF: correction factor, EE: erythema effect 

spectrum, I: light intensity spectrum, Abs: sample 

absorbance. 

Table 2. Value of EE x I 

λ (nm) EE x I 

290 0.015 

295 0.0817 

300 0.2874 

305 0.03278 

310 0.1864 

315 0.0839 

320 0.018 

 

Table 1. Purslane magenta flower variety herb extract cream formula 

Ingredients 
Negative Control 

Formula (%) 

2,5% Extract 

Formula (%) 

5% Extract 

Formula (%) 

Ceto stearyl alcohol 7 7 7 

Stearic acid 7 7 7 

Cetyl alcohol 6 6 6 

Nipagin 0.15 0.15 0.15 

Nipasol 0.05 0.05 0.05 

Purslane extract - 2.5 5 

Tween 80 0.5 0.5 0.5 

Aqua destilata ad 100 100 100 
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Table 5. %Te value of cream preparation 

Replication 
Negative Control 

(Cream Base) 

Value of %Te (%) 

2.5% Extract 5% Extract 

I 97,56 27,36 8,97 

II 90,28 23,08 8,44 

III 93,06 27,14 7,29 

Mean 93,64 ± 3,67 25,86 ± 2,41 8,23 ± 0,86 

 

Data analysis 

The %Te, %Tp, and SPF values were analyzed 

statistically using a one-way ANOVA analytical method 

with α = 0.05 and followed by a post hoc test. 

 

RESULTS AND DISCUSSION 

Fresh purslane (Portulaca grandiflora) magenta 

flower variety herb dried and extracted using maceration 

method until 5.51 gram thick extract was obtained with 

10.64% yield (Table 3). 

The next step was qualitative phytochemical 

identification of the obtained extract. The 

phytochemical screening result is explained in Table 4. 

 

Table 3. Purslane (P. grandiflora) magenta flower 

variety herb extract yield 

Simplicia 
Powder 

weight (g) 

Extract 

weight (g) 
Yield 

(%) 

Purslane magenta 
flower variety 
herb 

51.78 5.51 10.64 

 

Table 4. Purslane (P. grandiflora) magenta flower 

variety herb extract phytochemical screening 

Test Reagent Result 

Flavonoid Mg powder + HCl 2N + 
C2H5OH 

+ 

Alkaloid NH3+CHCl3+HCl 2N+ 
Dragendorff/ 
Mayer/Bouchardat 

 

+ 

Saponin Foam test + 

Tannin FeCl3 + 

Terpenoid H2SO4 concentrate + CHCl3 + 

 

The purslane extract was used as an active 

ingredient in cream preparation with 2.5% and 5% 

concentration variations. Cream preparation was chosen 

because it has benefits such as being easy to use, 

comfortable, and easy to wash with water. The cream 

also has various functions as a drug carrier, skin 

emollient, and protection from different interferences, 

including sunlight. 

Sunscreen preparation could contain active 

ingredients in an inorganic compound (reflect UV 

radiation) and an organic compound (absorb UV 

radiation). The purpose of sunscreen application is not 

only to protect the skin from UV rays exposure, which 

can trigger negative effects, but also it’s expected to 

inhibit ROS formation, which triggers gene mutations, 

premature aging, and carcinogenic effects in the long 

term. Therefore, active antioxidant compounds that can 

help increase the physical activity of sunscreen are 

needed in sunscreen preparations. Purslane (Portulaca 

grandiflora) magenta flower variety herb extract 

contains various secondary metabolites and has 

antioxidant activity (Addor et al., 2022). 

The cream sunscreen activity is determined from 

the percentage of erythema transmission (% Te), the 

percentage of penetration transmission (% Tp), and the 

Sun Protective Factor (SPF) value (Table 5). 

The percent erythema transmission value (%Te) 

describes the amount of UV rays exposure from the sun 

that hits the skin after using sunscreen, which causes 

erythema (redness) on the skin (Chen et al., 2012). The 

lower the % Te value, the better the sunscreen protection 

to prevent erythema. Based on Table 5, the highest %. 

Te was in the negative control (preparation basis), 

which was 93.64 ± 3.67%, followed by preparations 

containing 2.5% extract, which was 25.86 ± 2.41%, and 

the lowest was the preparation with 5% extract, which 

was 8.23 ± 0.86%. Based on the statistical test results, it 

showed that there was a significant difference in the % 

Te value both in the negative control preparations with 

2.5% and 5% extract. This indicates that the extract 

concentration determines the erythema transmission 

value of sunscreen preparations. 

The percentage value of pigmentation transmission 

(% Tp) describes the amount of exposure to UV rays 

from the sun that hits the skin after using sunscreen, 

which causes pigmentation of the skin. As with % Te, 

the lower % Tp value indicates better protection of 

sunscreen against pigmentation on the skin.  
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Table 6. %Tp value of cream preparation 

 Negative Control 

(Cream Base) 

Value of %Tp (%) 

2.5% Ekstrak 5% Extract 
Replication 

I 98.29 36.69 17.46 

II 91.49 32.96 16.83 

III 95.66 38.49 15.65 

Mean 95.15 ± 3.43 36.05 ± 2.82 16.65 ± 0.92 

 

Table 7. SPF value of cream preparation 

Replication Negative Control 

(Cream Base) 

Value of SPF 

2.5% Ekstrak 5% Extract 

I 0.18 3.84 7.83 

II 0.16 3.71 8.47 

III 0.19 4.37 7.79 

Mean 0.18 ± 0.02 3.97 ± 0.35 8.03 ± 0.38 

 

Based on Table 6, shows that the highest % Tp was 

in the negative control (preparation basis), which was 

95.15 ± 3.43, followed by preparations containing 2.5% 

extract, which was 36.05 ± 2.82, and the lowest is a 

preparation with 5% extract, namely 16.65 ± 0.92. 

Based on the results of statistical tests, there was a 

significant difference in % Tp value in the negative 

control, preparations with 2.5%, and 5% extract with a 

p>0.05. This shows that the extract concentration in 

preparation determines the pigmentation transmission 

value of the sunscreen preparation. 

The SPF value states how many times the skin's 

natural resistance is multiplied so that it is safe in the sun 

without experiencing sunburn16. Based on the test 

result, the SPF value also shows an increasing trend with 

increasing extract concentration in the preparation. 

Based on Table 7, it can be seen that the lowest SPF 

value was in the negative control (preparation base), 

which was 0.18 ± 0.02, followed by preparations 

containing 2.5% extract, which was 3.97 ± 0.35, and 

those having the highest was the preparation with 5% 

extract, namely 8.03 ± 0.38. Based on the results of 

statistical tests, it showed that there was a significant 

difference in the SPF value in the negative control, 

preparations with extracts of 2.5%, and 5% with p>0.05. 

This shows that the extract concentration determines the 

SPF value of the sunscreen preparation. 

Based on these results, a cream preparation 

containing 5% purslane herb extract had a higher % Te 

and % Tp value compared to preparations containing 

2.5% purslane herb extract. At the % Tp value, both 

preparations showed the maximum protection, which 

was in the sunblock category, while based on % Te, the 

protection was still in the tanning and suntan categories 

(Kasitowati et al., 2021). To obtain better protection 

based on the % Te value, a higher extract content is 

needed in the preparation. 

 

 

Figure 1. Absorbance spectra at 290-400 nm 

wavelength of cream preparation 

The potential for sunscreen activity can be 

expressed through the value of the Sun Protective Factor 

(SPF). The SPF value is determined from the absorption 

results of the preparation at UV wavelengths between 

290 – 400 nm (Figure 1). Based on the research results, 

it was obtained that the SPF values of cream 

preparations containing 2.5% and 5% purslane herb 

extract were 3.97 ± 0.35 and 8.03 ± 0.38, respectively. 

Both of these SPF values are less than 12, which is in 

the minimal protection category. This SPF value is not 

optimal for providing protection because, with an SPF 

value of less than 15, protection is only given for 1.5 

hours (Buso et al., 2017). 

Statistical tests were carried out to determine 

whether there were differences in sunscreen activity in 

each preparation. Based on statistical tests using one-

way ANOVA, a significance value of <0.05 was 

obtained for both the %Te, %Tp, and SPF values. This 

means that the purslane herb extract concentration in 

preparation determines the sunscreen activity. The 
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higher the extract concentration in the preparation, the 

better the sunscreen protection will be. 

 

Figure 2. Structure of flavonoid A: rutin, B: quercetin 

(Ganeshpurkar et al., 2017; El-Saber Batiha et al., 

2020) 

 

Flavonoids are compounds contained in purslane 

herb extracts that are thought to have sunscreen activity 

(Cahyani et al., 2022). Flavonoids can absorb energy at 

UV light wavelengths because they have covalent bonds 

in their structure. Flavonoids can absorb energy at a 

wavelength of 240-290 nm, and flavonoids that have 

conjugated covalent bonds can absorb at a wavelength 

of up to 550 nm (He et al., 2021). The Magenta flower 

variety purslane herb contains the and most significant 

amount of flavonoids compared to other variants. 

Therefore, this study used extracts from the purslane 

herb with the magenta flower variant. Flavonoids 

contained in purslane (Portulaca grandiflora) herb are 

rutin, quercetin, and isoquercetin compounds (Husein et 

al., 2021). Flavonoids have at least two aromatic rings 

with a basic carbon skeleton consisting of 15 C atoms 

forming C6-C3-C6 (Figure 2) (Julianto, 2019). 

 

CONCLUSION 

The sunscreen cream preparation with 2.5% of 

purslane (Portulaca grandiflora) magenta flower 

variety herb extract had %Te, %Tp, and SPF values of 

25.86 ± 2.41%, 36.05 ± 2.82%, and 3.97 ± 0.35 

respectively. In comparison, preparations with 5% 

concentration of extract had %Te, %Tp, and SPF values 

of 8.23 ± 0.86%, 16.65 ± 0.92%, and 8.03 ± 0.38, 

respectively. The sunscreen activity of all extract 

concentration creams was significantly different 

compared to the negative control (cream base) in all 

parameters. Flavonoids are the compounds responsible 

for the sunscreen activity of purslane (Portulaca 

grandiflora) magenta flower variety herb extract. 
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Abstract 

Background: Acne is a prevalent skin health problem experienced by teenagers and adults. Green tea is one of 

the plants that can be used to treat acne. Green tea dregs contain catechins, which have antibacterial activity that 

causes acne. Objective: This study aims to determine the antibacterial activity of green tea dregs extract against 

Cutibacterium acnes bacteria. Methods: This study used two brewing time variations and three green tea dregs 

with maceration variations. The obtained extract was then analyzed for its catechin content using the total phenolic 

test. Section, which has a high phenolic content, was then tested for its activity against Cutibacterium acnes 

bacteria using the microdilution method to obtain the MIC50 value. The extract with a brewing time of 2 minutes 

and the ultrasonic-assisted extraction maceration method had the highest MIC50 value of 8.586 mg/mL. The MIC50 

value references extract concentrations used in acne spot cream formulations. The cream obtained after the 

stability test is semisolid, brown, and smells like tea. Spot cream is also homogeneous and meets the pH range in 

cosmetic preparations of 5.5. However, the viscosity of spot cream decreased significantly after storage to 4546 

cPoise from 8106 cPoise. The decrease in the viscosity of the cream was caused by the catechin content in green 

tea dregs extract, which is acidic, thus reducing the effectiveness of the emulator in the form of triethanolamine, 

which is alkaline. The decrease in viscosity of the cream also caused the spreadability of the cream to increase 

and the stickiness of the cream to decrease. 

 

Keywords: acne spot cream, brewing time, catechin, Cutibacterium acnes, green tea dregs 
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INTRODUCTION 

Acne is a common condition in which there is an 

overproduction of oil in the skin that leads to clogging 

the hair follicles. Clogged hair follicles lead to 

inflammation of skin pores, which is characterized by 

red discolouration of the skin as well as small pus-filled 

bumps that are known as pimples (Aslam et al., 2015). 

Cutibacterium acnes is present in the fatty acids of 

sebum secreted by sebaceous glands in skin follicles and 

produces lipases that facilitate the breakdown of sebum-

free short-chain fatty acids that are pro-inflammatory 

(McLaughlin et al., 2019).  

Because of this reason, C. acnes is a common 

bacteria that is chosen in the case of antiacne activity 

analysis of a drug. Clinical and laboratory studies in the 

last 20 years reported that many natural ingredients are 

potent antiacne agents.  

One of the natural ingredients that is widely used in 

the treatment of acne is green tea. According to research 

from Peluso & Serafini (2017), green tea has more 

substantial antioxidant potential than black tea and 

oolong tea. These antioxidant properties are attributed to 

the catechin content in green tea. Catechins are likely 

and efficacious in treating acne as they have apoptotic, 

sebo-suppressive, anti-inflammatory, and antibacterial 

effects against C. acnes (Yoon et al., 2013). 

Indonesians have long used green tea dregs as a 

facial beauty treatment. According to Soetjipto et al. 

(2012), green tea dregs still have antioxidant and 

polyphenol activity. Green tea dregs help brighten the 

skin, overcome acne, remove panda eyes, and soothe the 

skin. Green tea waste as an antiacne is commonly used 

as a mask. The green tea dregs mask is left to dry and 

rinse with water.  

Based on this phenomenon, researchers are 

interested in knowing the potential of green tea dregs as 

an antiacne agent. Two variables will be tested in this 

study: tea brewing time and the extraction method of 

brewed tea dregs. Brewing time will significantly affect 

the content of dissolved chemicals, colour intensity, and 

aroma of the tea to be consumed.  

The extraction method used in this study is 

maceration with several modifications, that are 

maceration at room temperature, maceration at 60oC 

(digestion), and maceration with ultrasonic-assisted 

extraction. Acne patch cream preparation was chosen to 

treat acne to obtain local effects in drug delivery to the 

skin layer, especially on problem skin (Rai et al., 2019). 

 

 

MATERIALS AND METHODS 

Materials 

Green tea (Brand A), technical ethanol (Bratako), 

distilled water, Na2CO3 (Merck), Folin reagent (Merck), 

Brain Heart Infusion media (Merck), Cutibacterium 

acnes bacteria, 96 well microplates (Iwaki), blue tip 

(Socorex), yellow tip (Socorex), white tip (Socorex), 

stearic acid, glycerin, propylparaben, methylparaben, 

triethanolamine, cetyl alcohol, and pH stick (Merck). 

Tools 

Analytical scales (Mettler Toledo AL204), flannel 

cloth, oven (Memmert), hot plate, autoclave (Hirayama 

Hiclave HVE-50), incubator (Sakura, Japan), laminar 

airflow (Nuaire Airegard NU-126-400E), Bunsen 

burner, micropipette (Socorex), microplate reader 

(AMR-100-Allsheng), vortex (Thermo Scientific), 

mortar, stamper, overhead stirrer (IKA) and Brookfield 

viscometer (Lamy Rheology B One Plus). 

Method 

Determination of green tea leaf 

Determination of green tea leaf (Camellia sinensis 

(L.) O. Kuntze) used in this study was carried out at the 

Cell Biology-Microbiology Laboratory, Department of 

Pharmaceutical Biology, Gadjah Mada University. 

Brewing and preparation of dry dregs 

Green tea leaves were weighed as much as 300 g 

and then brewed using 1000 mL of distilled water at 

100˚C for 2 minutes and 5 minutes. The brewed green 

tea was then filtered by a flannel cloth until the water 

was drained. The green tea dregs were then dried in an 

oven at 50˚C for 1x24 hours until completely dry. The 

dried material was then pulverized by a mortar and 

stamper. 

Extraction 

Extraction optimization was carried out on tea 

grounds in three extraction methods, namely cold 

maceration for 3x24 at room temperature, maceration 

with digestion for 6 hours at 60oC using a water bath, 

and maceration with ultrasonic-assisted extraction 

(UAE) for 30 minutes at room temperature by an 

ultrasonic chamber. The weight of dry tea leaf dregs for 

one maceration was 75 grams. Ethanol with 70% 

concentration is used as a solvent because it is polar and 

can attract polyphenolic compounds in green tea pulp, 

which are opposite in nature. In addition, ethanol has a 

low boiling point, which is 79oC, so it requires less heat 

for the concentration process. The ratio of the weight of 

the dry tea leaf dregs to the volume of the liquid was 1:7 

b/v. Filtration was carried out to separate the filtrates and 
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residue. The filtrates were then evaporated in a water 

bath at 60oC until a slightly thick extract was obtained 

and then dried by the freeze-drying method. 

Total phenolic test with folin-ciocalteau colorimetric 

method 

The Folin-Ciocalteau colourimetric method is 

based on the chemical reduction of the reagent, a 

mixture of tungsten and molybdenum oxide based on the 

method (Singleton et al., 1999). The content of total 

phenolic compounds in the extract was expressed as 

gallic acid equivalents (mg/g extract) based on the 

regression equation of the gallic acid calibration curve. 

Sample solution (150 uL) and gallic acid standard 

solution (0, 25, 50, 75, 100, 150, 175, and 200 uL) were 

pipetted into test tubes. Distilled water was added to 4 

mL and 250 uL Folin-Ciocalteau. The mixture was then 

shaken until homogeneous. After standing for 8 minutes, 

750 ul of 20% Na2CO3 was added and homogenized. 

The mixture was then allowed to stand for 2 hours at 

room temperature. The absorbance was measured at a 

wavelength of 749 nm. The measurement was repeated 

in triplicate to obtain the phenol content as gallic acid 

equivalent (mg GAE/g sample). 

Antibacterial activity test by microdilution method 

C. acnes from glycerol stock was streaked on sterile 

Brain Heart Infusion (BHI) medium in a petri dish and 

incubated at 37oC for 24 hours under anaerobic 

conditions in a jar incubator. To prepare the starter, one 

tip of the C. acnes culture was inoculated in 5 mL of 

Brain Heart Infusion Broth (BHIB) media in a test tube 

aseptically, then vortexed and incubated at 37oC for 2 

hours. The bacterial suspension was standardized using 

a spectrophotometer at a wavelength of 600 nm to obtain 

an OD of 0,08 – 0,13, which is equivalent to 1,5 x 108 

CFU/mL (CSLI, 2017). The antibacterial activity test 

was carried out by microdilution method in BHI media 

with varying concentrations of green tea dregs extract of 

3 mg/mL, 5 mg/mL, and 10 mg/mL in 1% DMSO 

solution. A mixture of 5 µL of C. acnes bacteria 

suspension, 50 µL of extract, and 145 µL of BHI media 

were pipetted into the wells as treatments and replicated 

three times. The negative control consisted of 145 µL of 

BHI media, 5 µL of bacterial suspension, and 50 µL of 

1% DMSO. The inhibition calculation used the 

following formula (CLSI, 2017). 

%𝐼𝑛ℎ𝑖𝑏𝑡𝑖𝑜𝑛

=
(𝑁𝑒𝑔𝑎𝑡𝑖𝑣𝑒 𝑐𝑜𝑛𝑡𝑟𝑜𝑙 𝑎𝑏𝑠𝑜𝑟𝑏𝑎𝑛𝑐𝑒 − 𝑇𝑟𝑒𝑎𝑡𝑚𝑒𝑛𝑡 𝑎𝑏𝑠𝑜𝑟𝑏𝑎𝑛𝑐𝑒)

𝑁𝑒𝑔𝑎𝑡𝑖𝑣𝑒 𝑐𝑜𝑛𝑡𝑟𝑜𝑙 𝑎𝑏𝑠𝑜𝑟𝑏𝑎𝑛𝑐𝑒

× 100% 

Acne spot cream formulation 

The formulation of green tea dregs extract spot 

cream preparation refers to the formula optimization 

results of Karmilah & Musdalipah (2018), with minor 

modifications, which can be seen in Table 1 (Arief, 

2023).  

Physical stability test of cream preparation 

The stability test conducted in this study was an 

accelerated stability test by a climatic chamber for one 

month with a temperature of 40oC ± 2oC and RH 75% ± 

5% and testing intervals every one week (CSLI, 2012). 

Tests that are conducted every week include 

organoleptic, homogeneity, viscosity, pH, spreadability, 

and adhesion tests, as seen in Table 2. 

 

Table 1. The formula of green tea dregs extract spot cream (Karmilah & Musdalipah (2018)). The amount of extract 

was performed based on the MIC50 value of microdilution analysis 

Composition 
Cream Formula (%) 

Usability 
Control Extract 

Stearic acid 10 10 Oil base 

Glycerin 10 10 Humectants 

Cetyl alcohol 3 3 Oil base 

Liquid paraffin 2 2 Emollients 

Triethanolamine 1 1 Emulgator 

Green tea dregs extract - 0,9 Active substance 

Methylparaben 0,2 0,2 Preservatives 

Propylparaben 0,05 0,05 Preservatives 

Distilled water ad 100 ad 100 Solvents 
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Table 2. Test methods are conducted every week in the physical stability test of cream preparation.  

Each test was performed in triplicate 

Tests Test methods 

Organoleptic test The organoleptic test was carried out by observing the physical appearance of the preparation 

consisting of shape, colour, and odour (Saryanti et al., 2019). 

Homogeneity test The homogeneity test was conducted by weighing 0.1 g of cream and then applying it evenly 

to the glass object. The cream preparation must be homogeneous, characterized by absence of 

coarse particles that appear in the preparation (Saryanti et al., 2019). 

Viscosity test Viscosity measurements were carried out at 25oC using a Brookfield viscometer, namely by 

installing spindle No. 6 on the device and then dipping it into the preparation to a specific 

limit and setting a speed of 100 rpm for 15 seconds (Saryanti et al., 2019). 

pH test The pH measurement was carried out using a Merck brand pH stick. The pH tolerance range 

of the cream ranges from 4.0-7.5 (Saryanti et al., 2019). 

Spreadability test 

 

A 0.5 g of cream preparation was placed on a glass on a millimetre block of paper. The glass 

was then covered with another transparent glass and left for 1 minute to obtain the diameter 

of the spread. Next, a load of 50 g to 250 g was added to the glass every 1 minute, and the 

diameter of the spread formed was observed. The cream preparation is expected to spread 

readily and evenly. 

Adhesive test 

 

A 0.5 g of cream preparation is placed on a glass object marked 4 x 2 cm. Another object glass 

is placed on top of the preparation and given a load of 1 Kg for 5 minutes. The test glass was 

placed on the test device and given a load of 80 grams. The load that has been installed is 

dropped, and the time until the two glass objects are released after the load is dropped is 

recorded. 

 

Data analysis 

Data analysis was carried out using SPSS version 

20.0. The obtained data were then analyzed for 

normality. The normality test ensures that the research 

data comes from a population with a normal distribution. 

The normality test was conducted by Saphiro-Wilk with 

a confidence level of 95%. If the significance value of 

p-value > 0.05, it can be said that the data is normally 

distributed and vice versa (Rohman, 2014). Normally 

distributed data were tested for significance with One-

Way ANOVA with a 95% confidence level. 

 

RESULTS AND DISCUSSION 

Brewing brand A green tea for 2 and 5 minutes at 

100°C was chosen because it is the time and temperature 

commonly used by the public. In addition, 100˚C 

produces the highest catechin content compared to 70˚C 

and 85˚C (Chadijah & Qaddafi, 2021). After brewing, 

the green tea was drained by a flannel cloth, then 

arranged on a tray, and dried in an oven at 50˚C for 1x24 

hours. The temperature of 50˚C was chosen because 

catechins are not resistant to high heat and will degrade 

at 98˚C (Vuong et al., 2011). The code of variation of 

brewing time and extraction method can be seen in 

Table 3. 

Table 3. Brewing time variation code and extraction 

method 

Code Brewing 

time 

Extraction method 

2A 2 minutes Cold maceration 

2B 2 minutes Maceration with 

digestion 

2C 2 minutes Maceration with 

ultrasonic-assisted 

extraction (UAE) 

5A 5 minutes Cold maceration 

5B 5 minutes Maceration with 

digestion 

5C 5 minutes Maceration with 

ultrasonic-assisted 

extraction (UAE) 

 

The drying of green tea dregs macerate was carried 

out using the vacuum freeze-drying method. This 

method is drying materials by reducing the ambient 

temperature pressure to allow sublimation, transferring 

the solid phase to the gas phase without going through 

the liquid phase. This method is used because it can dry 

materials without heating, thereby reducing product 

damage due to high temperatures, and the dried product 

has an attractive physical shape. 
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Figure 1. Total phenolic content (mg GAE/g) in each treatment. Each sample was performed in triplicate 

 

Percent extract yield (Table 4) was obtained by 

calculating the ratio of the tea dregs extract produced’s 

dry weight to the raw material used multiplied by 100%. 

The extract obtained is brownish green, smells typical of 

tea, and tastes like chelate. The yield of green tea dregs 

extract ranges from 12.56 - 20.99%. Green tea dregs 

extract yield with a brewing time of 2 minutes is greater 

than 5 minutes, following the theory that the faster the 

brewing time, the more compounds are left in the dregs. 

 

Table 4. The yield of green tea dregs extracts of each 

treatment 

Brewing 

time 

Extraction 

method 

Mass of 

extract 

(gram) 

Extract 

yield 

(%) 

2 

minutes 

Cold 

maceration 

9.76 13.02 

Maceration 

with digestion 

15.74 20.99 

Maceration 

with UAE 

15.07 20.09 

5 

minutes 

Cold 

maceration 

9.42 12.56 

Maceration 

with digestion 

12.81 17.08 

Maceration 

with UAE 

11.95 15.93 

 

The extract was then tested for total phenolic 

content by a colourimetric method. The maximum 

wavelength of gallic acid was determined by measuring 

a gallic acid solution with a concentration of 150 ppm in 

the wavelength range of 400 - 800 nm with a UV-Vis 

spectrophotometer. The maximum wavelength obtained 

was 749 nm. The maximum wavelength is needed 

because it will provide optimal absorption of phenolic 

compounds with high sensitivity. Gallic acid reacts with 

the Folin-Ciocalteau reagent in an alkaline atmosphere 

to produce a blue colour, indicating the presence of 

phenolic compounds. The more intense the blue colour 

formed, the greater the concentration of phenolic ions 

formed. 

The absorbance of the gallic acid solution obtained 

is made in the form of a standard curve and the equation 

y = 0.0041x + 0.003 and R2 0.998, which can be 

concluded that the data obtained is linear. The eligibility 

requirements for acceptable analytical methods for the 

correlation coefficient (R) of the range 0.996 - 1 will be 

used to determine the total phenolic content of green tea 

dregs extract. Measurement of total phenolic 

compounds was made as many as three replicates for 

precision purposes with phenol content obtained as 

gallic acid equivalent (mg GAE/g sample) as attached in 

Figure 1. 

Based on Figure 1., the average total phenolic 

content of green tea dregs extract was 331,17 mg GAE/g 

in treatment 2A; 370,73 in treatment 5A; 573,98 in 

treatment 2B; 571,82 in treatment 5B; 678,59 in 

treatment 2C; and 589,16 in treatment 5C. The highest 

total phenolic test results were obtained in the 2C extract 

of 0,679 mg GAE/g, which means that every 1 gram of 

sample contained 0,679 mg gallic acid equivalent. 

Furthermore, data analysis carried out by SPSS 

indicated that the data is customarily distributed and 

homogeneous. However, the significance of 0,00 was 

obtained after the One-Way ANOVA test so it can be 

concluded that there is a significant difference between 

the average total phenolic content in each treatment 

code. The homogeneous subset posthoc test found that 

green tea dregs' average total phenolic content was 

grouped into three subsets. In subset 1, there are 

treatment codes 2A and 5A; in subset 2, there are 

treatment codes 2B, 5B, and 5C. In subset 3, there is 

only treatment code 2C.  

So, the highest average total phenolic is the sample 

with treatment code 2C of 0,679 mg GAE/g. The 

331.17 ± 5.71

573.98 ± 21.51

678.59 ± 33.18

370.73 ± 18.32
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average total phenolics of samples with treatment codes 

2B, 5B, and 5C were not significantly different. The 

insignificant difference between the average total 

phenolic content of samples brewed for 2 and 5 minutes 

in each maceration treatment was due to the narrow 

difference between the brewing times. The significant 

differences between the mean total phenolic content of 

cold macerated green tea dregs, maceration with 

digestion, and UAE maceration were due to temperature 

and ultrasonication. Maceration with digestion and UAE 

did not significantly differ in the average total phenolic 

content because both maceration processes can increase 

the solubility of the extracted active substances, whereas 

in the ultrasonication methods, there is an agitation that 

helps the diffusion process of active ingredients. 

Only the two subsets with the highest phenolic 

content were then tested for antibacterial activity using 

the microdilution method because they were considered 

to have better antibacterial activity against C. acnes 

bacteria. Therefore, the antibacterial activity test was 

conducted on samples with treatment codes 2B, 2C, 5B, 

and 5C. 

The bacterial suspension was standardized by a 

spectrophotometer at a wavelength of 600 nm to obtain 

an OD of 0,08 – 0,13. This OD was chosen because the 

bacteria are in the exponential phase in this range 

(Martins et al., 2011). The incubation time of 18 hours 

was determined because it follows CLSI (2012) 

guidelines, which are 18-24 hours. The incubation 

temperature of 37ºC was chosen because it corresponds 

to the optimum temperature for bacterial growth (Tellu 

et al., 2019). Meanwhile, concentrations of 3 mg/mL, 5 

mg/mL, and 10 mg/mL were selected based on 

preliminary tests that fall into the range required to 

obtain the MIC50 value. 

The amount of bacterial inhibition was obtained 

from turbidity readings using a microplate reader at OD 

600 nm. The wavelength of 600 nm was chosen because 

it only measures the level of light scattering caused by 

bacteria in a culture and does not absorb bacterial 

growth media, which impacts increasing absorbance 

(Martins et al., 2011). The absorbance obtained was then 

compared with the absorbance of the negative control to 

determine the inhibitory value of the extract against C. 

acnes bacteria, and the data attached in Table 5 was 

obtained. 

Based on Table 5, it is known that the highest 

antibacterial potential is 2C code with a MIC50 value of 

8,958 mg/mL. This value means that the extract 

concentration needed to inhibit 50% bacterial growth is 

8,958 mg/mL. The order of antibacterial activity in the 

four samples from the highest is 2C with an MIC50 value 

of 8,958 mg/mL; then 2B at 9,060 mg/mL; 5B at 9,091 

mg/mL, and the lowest 5C at 9,189 mg/mL. 

Table 5. Percent inhibition and MIC50 value of each 

treatment. Only samples with maceration treatment B 

and C were tested for their MIC because of high 

phenolic content 

Sample Concentration Percent 

inhibition 

MIC50 

value 

2B 3 mg/mL 30.304 

9.060 5 mg/mL 39.746 

10 mg/mL 52.294 

2C 3 mg/mL 32.086 

8.958 5 mg/mL 39.834 

10 mg/mL 52.683 

5B 3 mg/mL 28.221 

9.091 5 mg/mL 39.552 

10 mg/mL 51.518 

5C 3 mg/mL 29.827 

9.189 5 mg/mL 38.281 

10 mg/mL 52.171 

 

Furthermore, data analysis carried out by SPSS 

indicated that the data is homogeneous. However, the 

significance of 0.960 was obtained after the One-Way 

ANOVA analysis, so it can be concluded that there is no 

significant difference between the MIC50 values in each 

treatment code. 

The insignificant difference between the MIC50 

values in each treatment is associated with the average 

total phenolic content, which is also not significantly 

different. Not all phenolic compounds contained in the 

extract have activity against C. acnes. Green tea 

contains phenolic compounds in the form of catechins, 

epicatechins, epicatechin gallate, epigallocatechin 

gallate, gallic acid, teaflavin, and Gallocatechin (Khan 

& Mukhtar, 2019). In addition, the MIC50 value of green 

tea dregs extract against C. acnes obtained was not 

potent because it was more than 100 µg/mL. The low 

potency of the material in this investigation could be 

attributed to a brief maceration treatment lasting 

approximately 2-5 minutes.Another possibility is the 

usage of waste. Tea dreg means there is a previous 

process (maceration for drinking purposes) before 

maceration to get a sample for antibacterial purposes. In 

addition, low-quality green tea is used. According to 

research by Koch et al. (2018), the quality of green tea 

affects the catechin content contained in the extract, 

where the highest catechin content was obtained in 

green tea samples from Japan. 
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The stability of pharmaceutical preparations is 

defined as the ability of a preparation in a specific 

packaging system to maintain physical, chemical, 

microbiological, and pharmacological specifications 

during storage and application. The stability test used in 

this study was an accelerated stability test for one month 

in a climatic chamber with a temperature of 40oC ± 2oC 

and RH 75% ± 5% and a testing interval of one week. 

The cream preparation in each replication has a 

distinctive smell of tea and a brown colour derived from 

green tea dregs extract. It is homogeneous, which is 

characterized by the absence of coarse particles and 

even color visible in the preparation. The cream 

preparation in each replication also has the same pH of 

5.5. This value shows that the preparation is stable both 

before and after storage with an accelerated stability test. 

However, the cream preparation viscosity 

decreased after storage with accelerated stability (Figure 

2). This decrease in value probably can be caused by 

increasing storage temperature and absorption of water 

from the surrounding environment by moisture-

absorbing ingredients in the formula, such as glycerin. 

Furthermore, the acidic green tea dregs extract lowers 

the efficiency of the alkaline triethanolamine, making 

the preparation thinner.  

 

 

Figure 2. Results of cream viscosity test 

 

The significance of 0,00 was obtained after the 

homogeneity test so that the One-Way ANOVA analysis 

could not be carried out and replaced with the non-

parametric Kruskal-Wallis test and obtained the results 

of cream viscosity in week four was not significantly 

different from weeks 2 and 3, but significantly different 

from weeks 0 and 1. The cream viscosity of week 3 was 

not significantly different from week two but 

significantly different from weeks 0 and 1. On the other 

parameter, spreadability testing on cream preparations 

increased after storage with accelerated stability (Figure 

3). The increase in spreadability was due to the 

decreased viscosity of the cream after stability testing.  

 

 

Figure 3. Results of cream spreadability test 

 

A significance of 0,00 was obtained after the one-

way ANOVA analysis, so it can be concluded that there 

is a significant difference between the averages of each 

week. In the homogeneous subset posthoc test, it was 

found that the spreadability of the total cream was 

grouped into three subsets. In subset 1, there is only 

week 0. In subset 2, there are weeks 1, 2,  and 3 (not 

significantly different). So, the spreadability of green tea 

dregs extract cream in week 0 experienced a static 

increase in weeks 1, 2, and 3. Then, increase again in 

week 4. 

Testing the adhesion of the cream preparation 

showed a decrease after storage with accelerated 

stability (Figure 4) due to the viscosity of the cream, 

which decreased after stability testing. A significance of 

0,00 was obtained after po analysis, so it can be 

concluded that there is a significant difference between 

the means of each week. In the homogeneous subset 

post-hoc test, it was found that the stickiness of the patch 

cream was grouped into three subsets. In subset 1, there 

is only week 4. In subset 2, there are weeks 1, 2, and 3 

(not significantly different). So, the adhesion of green 

tea pulp extract cream in week 0 experienced a static 

decrease in weeks 1, 2, and 3. Then, it decreased again 

in week 4. 

 

 

Figure 4. Results of cream adhesion test 
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CONCLUSION 

Green tea dregs have activity against acne-causing 

Cutibacterium acnes bacteria. However, there was no 

significant difference between green tea brewing time 

for 2 and 5 minutes in obtaining catechin content in 

green tea dregs due to the narrow time difference. In 

addition, there is no significant difference between 

maceration with digestion and UAE in obtaining 

catechin content in green tea dregs. In the development 

of the spot cream dosage form, the cream had a stable 

characteristic during the accelerated stability test. 
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